GTX-4

GARMENT PRINTER
Instruction Manual

Please be sure to read this manual before using this product.
Keep this manual in a safe place for future use.




. When you dispose of the machine

Required Tools
Phillips screwdriver: M3 to M5

Disassembling

(1) Remove the Cover PANEL SIDE.

Note based on California law (USA) on the use and handling of Perchlorate

This product contains a CR Coin Lithium Battery which contains Perchlorate Material — special handling may

apply.
See http://lwww.dtsc.ca/gov/hazardouswaste.perchlorate.
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B saFeETY INSTRUCTIONS

Thank you very much for buying a BROTHER printer.
Before using your new printer, please read the "SAFETY INSTRUCTIONS" and handling instructions carefully.

1. Safety indications and their meanings

This instruction manual and the indications and symbols that are used on the printer itself are provided in order to ensure
safe operation of this printer and to prevent accidents and injury to yourself or other people.
The meanings of these indications and symbols are given below.

Indications

n D AN G E R The instructions which follow this term indicate situations where failure to follow the
instructions will result in death or serious injury.

g W ARN | N G The instructions which follow this term indicate situations where failure to follow the
instructions could result in death or serious injury.

g C AUTI ON The instructions which follow this term indicate situations where failure to follow the
instructions may result in minor or moderate injury.

The instructions which follow this term indicate situations where failure to follow the
1 )IMPORTANT . ) )
. instructions may result in damage to property.

(( ! ))NOTE The instructions which follow this term indicate precautions and restrictions for use.

Symbols

This symbol (/\ ) indicates something that you should be careful of.
é- N The picture inside the triangle indicates the nature of the caution that must be taken. (For
example, the symbol at left means "beware of injury".)

®- LR This symbol (®) indicates something that you must not do.

This symbol (.) indicates something that you must do.
9 CRE R The picture inside the circle indicates the nature of the thing that must be done. (For example,
the symbol at left means "you must make a ground connection".)

A DANGER

f Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5
minutes later.
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A WARNING

Basic precautions

To prevent accidents and problems, do not modify the machine yourself. Brother will not be held responsible
for any accidents or problems resulting from modifications made to the machine.

Do not handle the power cord with wet hands. Otherwise, it may cause electric shocks.

Installation

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric
shocks or problems with correct operation.

Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a
serious electric shock, and problems with correct operation may also occur.

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords.
Otherwise it may cause fire or electric shocks.

Printing
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If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and
contact the place of purchase or a qualified technician. If you continue to use the printer while there is a
foreign object inside, it may result in fire or electric shocks or problems with correct operation.

Do not allow the printer to come into contact with liquids. Otherwise it may cause fire or electric shocks or
problems with correct operation.

If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact
the place of purchase or a qualified technician.

Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise it may cause fire or
electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power
cord, and contact the place of purchase or a qualified technician.

Keep your finger or any body part away from the rotating fan. Otherwise it will be caught up, which results in
injuries.
Turn off the power when you approach the fan.
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A\.CAUTION

Environmental requirements

Use the printer in a place which is adequately ventilated. A slight odor is generated when the printed articles
are being fixed by heat.

Installation

Setting up and moving of the printer should only be carried out by a qualified technician.

The printer machine weighs 120 kg (265 Ib). Transporting and setting up of the printer should be held in the
proper way. Otherwise it may fall down and cause injury.

When the printer falls down, disconnect the power cord and contact the place of purchase or a qualified
technician. If you continue to use it, it may result in fire or electric shocks or poor printing quality.

Do not place the printer on a shaky table or high shelf or other unstable location. Otherwise it may tip over or
fall down and cause injury. Furthermore, the table that supports the printer should be at least 35.4 in. (90 cm)
in width and 23.6 in. (60 cm) in depth, and should be able to bear a weight of 150 kg (330 Ib) or more.

Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be
degraded or the printer may fall down, which causes injury or results in failure of the printer.

Do not connect the power cord until installation is complete. The printer may operate if the power is turned on
by mistake, which could result in injury.

Do not climb onto the printer or place heavy objects on top of it. Otherwise it may become unbalanced and tip
over or fall down and cause injury.

Be careful not to touch the claws of the mounting portion on the upper side of the rear cover. Otherwise you
may be injured.

Printing
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This printer should only be used by operators who are appropriately trained in its safe operation.

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand
may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may
touch against moving parts and this may result in injury.

When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator,
sprayed mist is generated. So wear a pair of plastic gloves, a mask and protective glasses (or goggles)
designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

When a problem occurs with the operation of the printer, contact the place of purchase or a qualified
technician.
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Maintenance
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Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your
fingers.

When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise you may
be injured.

Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation.
In case of contact with eyes, do not rub but immediately rinse the eyes with water.

Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They
may cause diarrhea or vomiting.

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution,
pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately
rinse the eyes with water.

Keep the liquids out of the reach of children.

Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.

It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting.

Keep the liquids out of the reach of children.

When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

(1)IMPORTANT

Printing

e

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
hit and damaged.
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(1)NOTE

Use the printer in an area which is free from sources of strong electrical noise such as electrical line noise or
static electric noise. Sources of strong electrical noise may cause problems with correct operation.

Any fluctuations in the power supply voltage should be within +10% of the rated voltage for the printer.
Voltage fluctuations which are greater than this may cause problems with correct operation.

The power supply capacity should be greater than the requirements for the printer's power consumption.
Insufficient power supply capacity may cause problems with correct operation.

In the event of an electrical storm, turn off the power and disconnect the power cord from the wall outlet.
Lightning may cause problems with correct operation.

L~ —




3. Warning labels

Cleaning solution
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Pretreatment
5kg (11 Ib) Pretreatment Ink pouch
20 kg (44 Ib) Maintenance solution pouch
X0125



This printer has the following warning labels displayed on it.

SAFETY INSTRUCTIONS

Follow the precautions given on each warning label for your work.
When the label is peeled off or illegible, contact the place of purchase.
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A CAUTION

Do not drink the liquids under any circumstances,
as they can cause vomiting and diarrhea.

Take care not to let the liquids come into contact
with your eyes or onto your skin,

otherwise inflammation can result.

A ACHTUNG

Bitte trinken Sie nicht die Flissigkeiten,

da die Gefahr von Erbrechen und

Durchfall besteht. Vermeiden Sie den Kontakt
der Fliissigkeiten mit Augen und Haut,

sonst kénnen diese gereizt werden.

A ATTENTION

Ne pas avaler les liquides d'aucune maniére,

car ceci pourrait entrainer vomissements et diarrhée.|
Veuillez a ne pas laisser ces liquides étre en contact
avec les yeux ou la peau,

car ceci pourrait entrainer une inflammation.

A ATENCION

No tome los liquidos en cualquier caso,

como pueden causar vomitar y diarrea.

Tome el cuidado para no permitir que los liquidos
toguen los ojos ni en la piel,

de otro modo inflamacion puede resultar.

A ATTENZIONE

Non bere per nessun motivo i liquidi poiché
possono causare vomito e diarrea.

Evitare il contatto di questi liquidi con gli occhi e con
la pelle poiché potrebbero creare infiammazioni.

A WARNING

Hazardous moving parts.

Keep fingers and
other body parts away.

Watch your fingers, or you
may be injured.
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A CAUTION
Moving platen, T-shirt tray and covers can cause bodily injury. Keep hands off platen while printing.
y'y ACHTUNG

Druckplatte, T-Shirt-Ablage und
Halten Sie die Hander von der Auflage and ags Druckvorganges fern.
A ATTENTION
Déplacement du plateau, chargeur T-shirt et couvercle peut blesser le corps.
Garder les mains éloignées lors de limpression.
A ATENCION
Moviendo Ia placa, la bandeja de camiseta y las cublertas pueden causar una herida personal.
Relire las manos de la placa duranle Ia impresion
A ATTENZIONE

Tavoletta mobile, il ripiano per la T-shirt ed il carter potrebbero causare infortuni.
Tenere le mani lontane dalla tavoletta durante la stampa.

A 5 B AE R

ADANGER

Hazardous voltage will

cause injury.Turn off main
switch and wait 5minutes
before opening this cover.

AGEFAHR

Hochspannung verletzungsgefahr!
Bitte schalten sie den hauptschalter
aus und warten sie 5 minuten,
bevor sie diese abdeckung 6ffnen.

A DANGER

Un voltage non adapte provoque
des blessures. Eteindre
I'interrupteur et attendre 5
minutes avantd'ouvrir le capot.

HAEERFISNT, KITHET L HB. MRS ERBS, R SBEE-
BRELY, 52> THDH N —ERFFTL, EERIRS DG BABEE.
A PELIGRO
Un voltaje inadecuado puede
provocar las heridas.Apagar el

interruptor principal y esperar 5
minutos antes de abrir esta cubierta.
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® A ACHTUNG

Niemals auf den Drucker steigen.

AERE A ATTENTION

AMEQLICRSIBEVI E, Ne montez pas sur I'imprimante.
AEE A ATENCION
BRIEEAR EE. No se suba encima de la impresora.

A CAUTION A ATTENZIONE

Do not climb onto the printer.

Non salire sulla stampante.

High temperature
warning display
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A CAUTION

Do not drink the liquids under any circumstances, as they can cause vomiting and diarrhea.
Take care not to let the liquids come into contact with your eyes or onto your skin,
otherwise inflammation can result. Keep the liquids out of the reach of children.

A ACHTUNG

Bitte trinken Sie nicht die Flussigkeiten, da die Gefahr von Erbrechen und Durchfall besteht.
Vermeiden Sie den Kontakt der Flussigkeiten mit Augen und Haut, sonst konnen diese gereizt werden.
Halten Sie die Flussigkeiten von Kindern fern.

A ATTENTION
Ne pas avaler les liquides d'aucune maniére, car ceci pourrait entrainer vomissements et diarrhée.
Veuillez & ne pas laisser ces liquides étre en contact avec les yeux ou la peau,
car ceci pourrait entrainer une inflammation. Maintenez les liquides hors de portée des enfants.

A ATENCION
No tome los liquidos en cualquier caso, como pueden causar vomitar y diarrea.
Tome el cuidado para no permitir que los liquidos toquen los ojos ni en la piel,
de otro modo inflamacién puede resultar. Mantenga los liquidos fuera del alcance de nifios.

A ATTENZIONE

Non bere per nessun motivo i liquidi poiché possono causare vomito e diarrea.
Evitare il contatto di questi liquidi con gli occhi e con la pelle poiché potrebbero creare infiammazioni.
Conservare i liquidi lontano dalla portata dei bambini.

WD ESICR->TERLTES L,

RHgRAMERET .

eposite in compliance with your local regulations.

W Gebrauchte es gemaf ortlichen Richtlinien entsorgen.

W Jetez conformément a la reglementation locale en vigueur.
W Deseche siguiendo la normativa local.

M Smaltire in conformita alle normative locali.

AZEE A CAUTION

R MBEGAEIZH L | Lubricating grease may cause Inflammation o eye and skin.

TU-Z el Wear protective glasses and gloves.
bl . 3 HRB AL e Swallowing grease can cause diarrhoea and vomiting.
GREASE s«mma Do not swallow.
A CAUTION 11 AT E
oo s e s P,
Take care. n to let the I\qwds come mtc ‘contact with your eyes 3 L
or ont therwise inflammation can resuft. WREELEEEMRNES.
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Vorretton Sl don ome sor Fissighaton it Augan und Haut

sonst kinnen diese gersiz! werden.
Halten Sie cie Flussigkeiten von Kindern fern.

A ATTENTION

Ne pas avaler les liquides daucuns maniérs,
Gar ceci pourrait enirainer vomissements et diarée.

cos liqudes
car coci pourrat entrainer une inflammation.
Maintenez les lquides hors de porlée des enfants.

A ATENCION

Notome os | caso, o .
o parmic i ena piel

6@ otra modo inflamacion puede resultar

Mantenga los liquidos luera del alcance de nifios.

A ATTENZIONE

n bere per i
Evitae | contatto i cusst i con gl occhi's con s pels oiché
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n Before Using Your Printer for the First Time

1-1. Be sure to read the following notes before using the printer

Keep in mind the following points before using the printer:

Precautions for proper use

o  Please keep the printer powered on the printer for 24 hours a day. Even when the printer is placed in standby
mode, it performs such maintenance as white ink circulation inside the main unit automatically to prevent
sedimentation of the white ink. (For details, refer to "4-2. Power supply of printer >>P.41".)

o Please use the printer within the scope covered by its warranty for the best print result (temperature: 18 to 30°C
(64.4 to 86°F) and humidity: 35 to 85%). Otherwise, the print heads may be clogged with ink and ink may splash.
(For details of the usage environment, refer to "10-1. Apparatus >>P.331".)

e  Adjust the height of the platen corresponding to the print medium before using it. You can use the platen height
adjustment lever to adjust the height of platen. As a rough indication, adjust the height so that it is lowered by
one step from the limit height detected by the obstacle sensor, and check that the platen is not detected by the
sensor. In the event that the platen's height is lowered excessively, ink mist will be scattered inside the printer,
which may result in staining of the printing surface, blurring of the printed image, and malfunction of the sensor
and the main unit. (For details, please refer to "6-4-2. Platen height adjustment >>P.131".)

e Never power off the printer while it is in operation. Otherwise, the printer may break down or a print job may end
up in failure. Also, as the power will be turned off if you open the front cover, avoid opening the cover while the
printer is operating.

e  Until the ink is firmly fixed on the surface of a T-shirt, handle the T-shirt with care. If a T-shirt is soiled with such
ink that has not been firmly fixed on its surface, such ink stain cannot be removed even by washing.

About ink cartridge

e Insert each of the cartridges into its correct position. Make certain that a seal color of the printer corresponds
with a corresponding color of cartridge to it.

e  The white ink precipitates downward when its cartridge is put in position. For this reason, shake it well once a
day immediately before use. (Shake each cartridge approximately 100 times.) For details, refer to "6-2-3. Daily
agitation of the white ink >>P.112".

e  Never pull out any cartridges while the printer is operating. Otherwise, the print quality may deteriorate or the
printer may break down.

e  Store consumable goods in a place where they are not exposed to direct sunlight. Use up the ink pouch,
pretreatment and maintenance solution before their shelf life. Also, use up each color ink within six months after
opening their sealed packages.

e No cartridges can be refilled with any ink. Do not disassemble the ink pouch. In order to use the printer for a
long period and to take full advantage of its capabilities, we recommend to use the ink pouches that are

specified by us.

e  Always keep on putting each ink cartridge in its correct position; do not leave a ink cartridge slot empty.
Otherwise, the inner needle may clog because ink dries up, or the printer may be damaged.

e Handle the ink pouch with care. It could be damaged when bent, snagged by sharp surfaces, or dropped.
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Before Using Your Printer for the First Time

About pretreatment

e [faT-shirt to which the pretreatment is applied is coated with only color inks, its stains tend to be wiped off by
washing. Avoid application of the pretreatment when no white ink is used.

e  When a white or light-colored T-shirt is coated with the pretreatment, the coated surface color may change, and
cannot be restored to the original color even if the T-shirt is washed. After a T-shirt is coated with the
pretreatment, store it in a place where it is not exposed to direct sunlight, and wash it with clean water at an
early stage after ink is applied to it.

e  Wash away any imprint of the pretreatment with water. Also, some T-shirts may be discolored by the
pretreatment and cannot be restored to the original color even if they are washed. When performing printing for
the first time, try it in an unnoticeable area.

o  Please ensure to inform the customer about the following precautions in regards to buying/selling printed
materials:

o [f a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer
may occur. Also, when a color-printed surface is rubbed strongly against a printed surface with only white ink,
color transfer may occur in the same fashion. When a color transfer occurs, wipe the color-transferred area
clean of dirt with a soft and clean cloth or a toothbrush that is moistened with a small amount of mild detergent
for home use or alcohol.

¢ Wash away any imprint of the pretreatment by washing (with water).

About maintenance

e Inorder to keep good printing quality, perform maintenance on a regular basis. For details, please refer to "7.
Precautions to keep good printing quality/use printer over the long term >>P.161".

e In order to take full advantage of the printer's intrinsic capabilities and use it for a long period, we recommend to
use the genuine cleaning solution that is specified by us when cleaning the head section, cap or wiper. Using
commercially available alcohol or cleaning solution could cause damage to the print heads.

e Never remove the print heads except when they are replaced with new ones, because they are precision
components. Otherwise, the print heads may be damaged.

What to do when not using printer

e  When not using the printer for a long period of time, please refer to "7-5. When Not Using for a Long Period of
Time >>P.219"

About waste handling

o Dispose of the residual wastes and waste ink properly as water-based waste fluid in accordance with applicable
laws and ordinances.
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Before Using Your Printer for the First Time

Others

e Inthe event that the printer is relocated elsewhere for layout change, etc., place a level gauge on the top
surface of the cover and the top surface of the platen to make such an adjustment that the printer will be placed
horizontally level.

. @ : Standby symbol

e  You cannot connect this product directly to the communications lines, including the public wireless LANs, of
telecommunication carriers like mobile communications companies, fixed communications companies, or
internet providers. Ensure that the product is connected through a router, if it is to be used over the internet.

<NOTE> Only for the use in the United States

. This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

About trademarks

The names of operating systems described in the main context of this manual are abbreviated. Product names used in
this manual are, in general, trademarks or registered trademarks of their respective developer or manufacture. However,
in this manual, the ® marks or TM marks are not used.

Brother logo is registered trademark of Brother Industries, Ltd.

Apple, Macintosh, Mac OS, iOS, OS X, macOS, Safari, iPad, iPhone, iPod and iPod touch are the trademarks or
registered trademarks of Apple Inc. in the United States and other countries.

The official name of Windows® 7 is Microsoft® Windows® 7 operating system. (represented as Windows 7 in this
manual) Also, the official name of Windows® 8.1 is Microsoft® Windows® 8.1 operating system. (represented as
Windows 8.1 in this manual) Also, the official name of Windows® 10 is Microsoft® Windows® 10 operating system.
(represented as Windows 10 in this manual)

Microsoft®, Windows® 7, Windows® 8.1 and Windows® 10 are trademarks and registered trademarks of Microsoft
Corporation in the United States of America and other countries.

Corel, Corel's logo and CoreIDRAW are trademarks and registered trademarks of Corel Corporation.

Adobe, Adobe's logo, Acrobat, Photoshop, lllustrator and Photoshop Elements are trademarks of Adobe Systems
Incorporated (Adobe Systems).

Other product and company names mentioned herein may be the trademarks or registered trademarks of their
respective owners.

Information in this document and the specifications of this product are subject to change without notice.
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About software

This printer uses its own software.

To use this printer, you are required to agree with the End-User License Agreement for Brother Software as mentioned
below.
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Before Using Your Printer for the First Time

End-User License Agreement for Brother Software
IMPORTANT-PLEASE READ CAREFULLY

This End-User License Agreement ("EULA") is a legal agreement between you and Brother Industries, Ltd. ("Brother"),
which governs your use of the Brother software that will be installed if you press the "Yes" button on this Dialog Box
("SOFTWARE"). By pressing "Yes", you agree to be legally bound by the terms of this EULA. If you do not agree to the
terms of this EULA, you obtain no license to the SOFTWARE. In such case, you may not use the SOFTWARE.

Terms and Conditions.

1. Ownership.

All rights, titles and interest in and to the SOFTWARE and the files associated therewith are owned by Brother or its
suppliers. The foregoing rights to the SOFTWARE are licensed to you on a limited basis as prescribed in the following
Article 2. In any event, this provision should not be construed in any way, as an expression to assign or sell any
copyrights of, or any other intellectual property rights to, the SOFTWARE from Brother to you.

2. Grant of License.

2.1 Brother grants you a non-exclusive, non-transferable license to install and use the SOFTWARE on your one or
more computer hardware(s).

2.2 Brother further grants you a license to make a copy of the SOFTWARE at all times, solely for archival purposes,
which such copy shall attach and stipulate all copyright and intellectual property rights notices.

2.3 Except for expressly stipulated in Sections 2.1 and 2.2 above, Brother does not grant you any license relating to
the SOFTWARE. Except to the extent expressly permitted by applicable law, you may not, (i) make any copies of the
SOFTWARE except as expressly permitted in accordance with Sections 2.1 and 2.2 of this EULA, (ii) modify the
SOFTWARE, (iii) reverse engineer, disassemble, decompile or use the SOFTWARE to create any derivative software,
(iv) rent or lease the SOFTWARE, (v) make available to download the SOFTWARE to the public, or (vi) transfer the
SOFTWARE to any third person or parties by wire or any other means.

3. WARRANTIES DISCLAIMER

TO THE EXTENT ALLOWED BY LAW, THIS SOFTWARE IS PROVIDED TO YOU "AS IS" WITHOUT WARRANTIES
OR CONDITIONS OF ANY KIND, WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED. BROTHER
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY,
SATISFACTORY QUALITY, NON-INFRINGEMENT AND/OR FITNESS FOR A PARTICULAR PURPOSE.

4. LIMITATION OF LIABILITY

IN NO EVENT SHALL BROTHER BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS
OPPORTUNITIES, LOSS OF USE OF DATA, INTERRUPTION OF BUSINESS, OR FOR INDIRECT, SPECIAL,
INCIDENTAL, PUNITIVE, EXEMPLARY OR CONSEQUENTIAL DAMAGES OF ANY KIND, ARISING OUT OF THE
USE, INABILITY TO USE, OR THE RESULTS OF USE OF THE SOFTWARE, WHETHER BASED IN CONTRACT,
TORT, OR OTHERWISE. YOUR USE OF THE SOFTWARE IS ENTIRELY AT YOUR OWN RISK. SHOULD THE
SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL SERVICE, REPAIR OR
CORRECTION AND, TO THE EXTENT PERMITTED BY THE APPLICABLE LAW, YOU AGREE TO
UNCONDITIONALLY WAIVE ALL STATUTORY OR OTHER RIGHTS THAT MAY BE HELD BY YOU AGAINST
BROTHER IN RESPECT OF SUCH DEFECT. Notwithstanding the above, these terms do not purport to limit the
statutory rights of a consumer that cannot be waived under the applicable law.

5. Term.

This EULA will become effective upon your acceptance and continue in effect unless you cease to use the SOFTWARE.
However, Brother may terminate this EULA without notice.

6. Governing Laws.

This English language translation of the original Japanese language EULA is governed and controlled under the
jurisdiction of the laws of Japan. If any of the provisions of this EULA shall be declared void, such provisions shall be
severable and independent from the other provisions of this EULA, and the validity of the other provisions and of the
entire EULA shall not be affected.
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1-2. Components included with printer

The components included with the printer are shown below. However, in the event that there is any missing
component(s), please contact your dealer.

®

v O Zy

X0228

No. Name Quantity No. Name Quantity
1 AC power cord 1 10 Flushing receiver 2
Cable clamp 1 Flushing foam 2
Grease 1 11 Waste ink tank 1
4 Clean stick R 6 12 Waste ink tube fixing rubber” 1
Clean stick T 6 13 | Print head 2
5 Cleaning cup 1 14 Rear cover installation screws™ 2
6 Filter cover and Fan filter 2 15 Rear cover 1
Gloves (for changing the wiper 16 Wiper cleaner 2
7 cleaner / for cleaning the 4 17 Adult platen 1
maintenance Unit) 18 Setup Manual 1

8 Carriage fixing pin 1 -

9 Tweezers 1 - - -

": The rubber is already attached to the waste ink tube of the main unit.
"2: Screws are already fixed with the machine.
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1-3. Other items you must make available for use

What you buy from our distributors

<TIPS>

Before Using Your Printer for the First Time >

° For details of the optional items, refer to "10-4. About consumable supplies, optional items and replacement parts >>P.335".

Ink pouch

Maintenance solution pouch
Cleaning solution
Pretreatment

Wiper cleaner

Others

USB cable
USB 2.0-compliant device cable (A/B)

<NOTE>

Using other cables than the specified one may cause the printer to be rendered inoperative. Do not use any extension
cable.

LAN cable
LAN cable (10BASE-T/100BASE-TX)

USB flash memory
Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You
cannot use a USB memory with security functions such as password lock function.

Pure water
It refers to such water as distilled water and purified water, which is used to dilute the pretreatment with it.

<NOTE>

Avoid using such water as tap water in which impurities are contained.

Heat press
It must deliver the performance through which the print range of the size of a platen to be used can be
covered and 180°C (356°F) can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be
sure to use the heat press, but not an oven, to smoothen the surface.

Peel-off sheet
Always use this sheet to flatten the fixed surface and enhance the peel property when fixating the
pretreatment and ink by means of the heat press. For details, refer to "6-3-1. Provisions for pretreatment
>>P115",

Silicone foam (of open-cell structure)
It is the foamed mattress which resists heat. Use this at a fixing stage through the use of the heat press.

Adhesive roller
Use these to remove lint from a T-shirt or debris from its surface.
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Before Using Your Printer for the First Time

e  T-shirt (printing medium)
e 100% cotton
o Polyester blended yarn fabric

<TIPS>
. Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even
if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on
it beforehand.
. Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water.
3 Perform a printing test beforehand. Then, the following phenomena may occur:
- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.
- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different
color.
- Fabric material may turn yellow after the pretreatment is fixed.
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n Name and function of each component

2-1. Front part

X0031

No. Name Function
1 Front cover Open this cover when cleaning the internal area of the printer.
2 | Carriage Holds the print head.

3 | Obstacle sensor

Checks the presence of any obstacles by their height (such as wrinkled T-shirt)
that are within range to collide with the print head.

4 | Platen sheet

It helps to keep the T-shirt from moving/shifting during printing so that an image
can be clearly printed.

5 | Platen

It secures a T-shirt in place, which is to be printed.

6 | Shoulder bar

Align the position of a T-shirt with this bar.

7 | T-shirt tray

This T-shirt tray holds such portions of T-shirt that droop down on it and feeds
the entire T-shirt into the printer.

8 | USB flash insertion slot

Insert a USB flash memory into this slot.

9 | LAN port

Into this port, insert the LAN cable which is to be connected with a PC.

10 | USB port

Into this port, insert the USB cable which is to be connected with a PC.
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Name and function of each component

>

No. Name Function
Use this button to turn the power on/off to the printer.
11 | Power button The pc?wer—off operation should be performed after completing any required
operation.
The standby power cannot be turned off.
With this clamp, the LAN and USB cables can be securely fixed to the lower
12 | Cable clamp X ) )
part of the main unit of printer.
13 | Operation panel Operate the printer using this panel.

2-2. Right side view

1 2 3
(N
X0032
No. Name Function
Ink cartridges placed here are, from the left in the top row, black (K) and yellow
, (YY), from the left in the middle row, cyan (C) and magenta (M), and from the left
1 | Ink cartridge slot ) ] ) )
in the bottom row, white (W12) and white (W34). Be sure to put each of the ink
cartridges in their correct places.
2 | Model plate On this plate, a product serial number is inscribed.
3 | Power cord insertion port Insert the power cord into this port.

24



Name and function of each component

2-3. Left side view/Rear side view

2 2 1
1

o
J

I

K>§

6 5
X0033
No. Name Function

This is the exhaust outlet for fan exhaust air. For proper use, keep this opening
apart from the nearest wall by 7.9 in. (20 cm) or more.

—_

Exhaust opening

2 | Fanfilter It absorbs ink mist which is generated inside the printer on its surface.

3 | Waste ink tube This tube is used to direct the flow of waste ink down into the waste ink tank.
4 | Waste ink tank This tank collects waste ink.

5 | Cleaning liquid tank It is the tank that reserves the cleaning solution used for maintenance.

6 | Rear cover It protects the platen's working range.
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Name and function of each component

2-4.

Inner-side view of front cover

Before opening the front cover, be sure to stop all operations, then house the platen in place, and finally turn off the
power.
To open the front cover, raise it while holding the center grip and open it until it is oriented almost vertically.
<IMPORTANT>
Be sure to press the power button to turn off the power before opening the front cover.

If you open the front cover while the power is on, no cleaning will be performed at the end of the print job, which is intended to

keep the print heads in good condition.

X0254
No. Name Function
1 | Print head (front: on the color side) It ejects the color ink.
2 | Print head (rear: on the white side) It ejects the white ink.
3 | Carriage guide shaft This shaft supports the carriage.
In order to keep good printing quality, this unit performs maintenance
4 | Maintenance unit functions to the print heads on a regular basis. (Example: Auto-Cleaning
Function)
It protects the surface of heads on the white side, and sucks ink durin
5 | Cap (rear: on the white side) P , g
head cleaning.
6 | Wiper cleaner (rear: on the white side) | It removes waste ink attached to the wiper surface.
7 | Wiper (for CMYK and white) It wipes away ink from the head surface.
To keep good printin ality the foam absorbs the ink-jet droplets ejected
8 | Flushing foam o , prinfing quaily skt P g
from the print head.
9 | Flushing receiver T<.) keep good pri-nting quality, the foam receives the ink-jet droplets
ejected from the print head.
10 | Wiper cleaner (front: on the color side) | It removes waste ink attached to the wiper surface.
It protects the surface of heads on the color side, and sucks ink durin
11 | Cap (front: on the color side) P , g
head cleaning.
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Name and function of each component

>

No. Name Function
To prevent drying of print heads in an emergency such as a blackout, it
fixes the carriage to the cap position of the maintenance unit.

12 | Carriage fixing pin 9 g P posit ! un

Refer to "4-2-3. When there is no prospect of electric power recovery for a
while due to power outage >>P.43".
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A J
X0255
No. Name Function
Use this lever to secure the platen in place.
1 | Platen fixing lever Tighten or loosen it to adjust the height of the platen when attaching/removing
the platen. Keep it tightened when printing.
2 | Platen positioning plate This is used to secure the platen at the fixed direction and hold it in place.
3 | Platen height adjustment lever | This lever should be used to adjust the platen's height.
Use this knob to secure the platen bearing in place. This lever should be used
4 | Knob to change the platen's height. Keep it tightened when printing. For details,
please refer to "6-4-2. Platen height adjustment >>P.131".
5 | Platen bearing This is used to secure and hold the platen in place.
6 | Collars Used to change the platen's height by changing the number. For details, please
refer to "6-4-2. Platen height adjustment >>P.131".
Platen height of each machine is finely adjusted by the number of the spacer.
7 | Spacer Never tamper with or remove these spacers even if adjusting the collars or it
will affect print output.
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Name and function of each component

2-6. Operation panel

|
12 T

s

O

©

@ 8 0036

No. Name Function
It indicates the job name or file name of print data, the active status of the
printer, and the menu for various settings.
When it remains off.  No error has occurred.
2 | Error LED When it remains on:  One or more errors have been detected. For content of
errors and their details, refer to "9-3. Error message >>P.304".

While the menu screen is being displayed, use this button to select your
3 | Up-arrow button A desired menu item.
In the numeric value setting menu, use this button to increase the target value.
While the menu screen is being displayed, use this button to select your
desired lower-level (right) menu item.
While the standby mode screen is being displayed, use this button to display a
warning when any warning message appears.
If this button is pressed when the printer is placed in the standby state, the
5 | MENU/OK button @ mer.1u screen will appear. . . | .

While the menu screen or the error screen is being displayed, use this button to
finalize and accept the currently displayed content.
While the menu screen is being displayed, use this button to select your
6 | Down-arrow button v desired menu item.
In the numeric value setting menu, use this button to decrease the target value.
Back button / D While the menu screen is being displayed, use this button to return to only one

7 |
Left-arrow button < upper-level (left) menu screen.

11

\\ /

10

\
!

1 Liquid crystal panel

4 | Right-arrow button >

There is no print data when this button remains off. This button blinks during
8 | Print button reception of print data, and it illuminates when such reception is completed.
Printing will begin if you press this button when it is illuminated.




Name and function of each component

>

No.

Name

Function

Stop button

\V)

With this button, such actions as printing and platen movement can be
canceled.

Printer will come to a stop after necessary actions for keeping the printer's good
quality, such as retracting operation of print heads and capping operation, are
completed.

While the menu screen is being displayed, the screen will exit and return to the
standby mode screen.

10

Platen button

It is used to move the platen toward the rear or front of the printer. Use this
button to ascertain whether the platen is set to a proper height after the platen's
height is adjusted. For details, refer to "6-5. Placing print medium in position
>>P.142".

1

Head cleaning
button

Perform a normal cleaning for the selected heads.

12

Power LED

When it remains off: The power of the printer is turned off.
When it remains on: The printer remains turned on (powered on).
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Name and function of each component

2-6-1. Liquid crystal panel

The picture shown below indicates a state under which the printer has received print data. On this screen, the printer's
current state and necessary information for printing are displayed.

10 1 2
3
Sample Data
4
B 14 x 16 inch OOO
é 4.88cc
1200001 @ 017 »
8 7 5
9 6 X0190
No. Indications Function
It displays a state of progress during the process of printing and/or print-data
1 | Progress bar display area p. y brog g P P g P
reception.
5 Text string display area on In this area, the print job name or file name, auto cleaning, receiving state,
basic display screen standby state, etc. are shown.
3 | Platen Size Elaten size that is specified by the print driver during file creation is indicated
ere.

The total number of printed sheets of which printing operation is completed in

4 | Number of printed sheets
P response to the received print data is displayed here. (0 to 999)

This mark appears when any warning is issued. Pressing > causes the

5 | Warning mark
g 0 current screen to move to the warning screen where the applicable warning

message is indicated.

6 | Resolution icon The printing resolution of received print data is displayed here.

The print direction is displayed here in the form of either bi-directional or
uni-directional icon.

The required ink volume (cc) for printing out one sheet of the received print data
8 | Ink volume to be used is displayed here.

(CMYK + White)

7 Print direction icon
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Name and function of each component

No. Indications Function

In this area, current remaining ink volume of each cartridge is displayed.

In the left-to-right order, the remaining ink volume in the black (K), yellow (Y),
cyan (C), magenta (M) and two white (W12 and W34) ink cartridges are shown

here.

9 Remaining ink volume ——
indication area ! : The remaining ink volume is running low. Make an ink pouch available for

._‘

use in the next printing session. ™

.: Ink has been depleted. Replace the old ink pouch with a new one.

The preview display screen of received print data is shown in this window. The
preview display screen shown here is indicated upside down as opposed to the
page orientation (the upper side of the preview image is oriented toward the front
10 | Preview image of the printer main unit).

Furthermore, it is possible to change the direction of the preview display screen
as well. For the change method, refer to "8-15. Preview display settings
>>p232".

<IMPORTANT>
*1:  If you perform printing that requires a large volume of ink when the remaining ink level is low, the ink may be depleted during the
printing process. As a rough indication, replace the ink pouch before you perform printing that requires 20cc or more ink.
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Menu list

On-screen menu manipulation

What to do How to operate

Start Pressing @ in the wait state causes the current screen to move to the menu

selection screen.

By means of A /¥, change a menu item to another menu item to be displayed.

Pressing P causes the current menu to change to another menu item which is

Select / Acknowledge ,
one level lower in the menu layer.

Pressing @ causes the currently displayed menu to be acknowledged.

Return to previous menu in Pressing :) causes the current menu to change to another menu item which is

upper menu layer . .
PP y one level higher in the menu layer.

e Ifyou press :) when a menu in the uppermost menu layer remains

Exit displayed, the menu will exit and the system will return to the standby state.

e Ifyou press @ when an optional menu remains displayed, the menu will

exit and the system will return to standby state.
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Menu list
1st layer 2nd layer 3rd layer Description
In the event that no ink-jet droplets are ejected,
[All Colors] this menu item enables you to perform cleaning
of all the nozzles of the color heads.
In the event that no ink-jet droplets are ejected,
[All Whites] this menu item enables you to perform cleaning
of all the nozzles of the white heads.
In the event that no ink-jet droplets are ejected,
[Normal Gleaning] [All Print Heads] this menu item enables you to perform cleaning
of the nozzles of all the print heads.
In the event that no ink-jet droplets are ejected,
[Black] this menu item enables you to perform cleaning
of only the black nozzles of the color heads.
In the event that no ink-jet droplets are ejected,
[Yellow Cyan this menu item enables you to perform cleaning
Magenta] of only the yellow, cyan, and magenta nozzles of
the color heads.
[All Colors]
[All Whites] . i
. [All Print Heads] Perform one.of t.he pO\.NeI’TU| cleaning .operatlons
[Head Cleaning] [Powerful Cleaning] (Black] when poor ejection of ink-jet droplets is not
[Yellow Cyan improved by means of the normal cleaning.
Magenta]
[All Colors]
(Al Whites] Perform one of the super cleaning operations
) [All Print Heads] - s .
[Super Cleaning] (Black] when poor ejection of ink-jet droplets is not
Yellow Cyan improved by means of the powerful cleaning.
Magenta]
[White-1]
[White-2]
[White-3]
[White-4]
[Flash Firing] [Black] Eerform one of the ﬂush?ng operations when the
[Yellow] ink-jet droplets are not ejected stably.
[Cyan]
[Magenta]
[All Whites]
[All Colors]
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1st layer 2nd layer Description
[Nozzle Check CMYK] This is the test pattern to check to see if ink-jet droplets are
Test Prinf ejected from the color heads properly or not.
[Nozzle Check White] This is the test pattern to check to see if ink-jet droplets are
ejected from the white head(s) properly or not.
[Print Data Load] With this menu item, any print data stored in a USB flash

memory (ARX4 file) is loaded into the system.

[Receiving History]

By selecting this menu item, you can display any print data
received in the order in which they are sorted from the
newest to the oldest ones, and you can select any one of
them.

[Maintenance]

[White Ink Circulation]

[White Ink Refilling]

[Maintenance Part Clean/Replace]

[White Head Cleaning]

[Install White Ink After Cleaning]

[Head Replacement]

[Install Ink after Replacing Head]

[Initial Ink Installation]

[White Ink Pause Mode]

[Exchange Filter]

[Printer transport preparation]

[Log copy to USB]

For details, please refer to "6. Basic printing procedures
>>P.107", "7. Precautions to keep good printing quality/use
printer over the long term >>P.161", or "9. Troubleshooting
>>pP.241".

[Printer Setting]

[Print Direction]

[Back Light]

[Auto Screen Erase Time]

[Menu TimeOut Setting]

[Speaker Volume]

[Temperature]

[Preview display settings]

[File name display setting]

[Obstcl sensr settng during print]

[Cartridge Attach/Remove Check]

[Low Temperature Mode]

[Auto Cleaning Setting]

[Auto Cleaning Start Timing]

[CR Speed Adjustment]

[Wiping frequency]

[Flushing Interval Setting]

[Flushing Volume Setting]

[Auto Job Delete]

[Revng Prnt Setting]

[Network filtering]

[IP Address Set]

For details, please refer to "7. Precautions to keep good
printing quality/use printer over the long term >>P.161" or
"8. What to do when needed >>P.222".
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1st layer 2nd layer Description
[Total Print]
[Temperature/Humidity Info]
[IP Address]
[Confirm network [Subnet Mask]
, [Default Gateway]
setting]
[Host name]
[MAC address]
[CTG Attach/Remove History]
[Check circulation schedule]
[English] Refer to "8. What to do when needed >>P.222".
[Espariol]
[Frangais]
[Language] [Deutsch]
[Italiano]
[BAEE]
(1]
[Firm Version]
[Version] [Data Info]
[Serial No.]
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n Installation and preparation

Be sure to use the printer after making correct setting in accordance with the instructions described in this chapter.

AAWARNING

Do not set up the printer in a dusty environment. If dust collects inside the printer, it may cause fire or electric
shocks or problems with correct operation.

Be sure to connect the ground. If the ground connection is not secure, you run a high risk of receiving a
serious electric shock, and problems with correct operation may also occur.

Do not bend the cords excessively or fasten them too hard with staples or anything similar to secure cords.
Otherwise it may cause fire or electric shocks.

PO @ PO

A\CAUTION

Setting up and moving of the printer should only be carried out by a qualified technician.

The printer machine weighs 120 kg (265 Ib).
Transporting and setting up of the printer should be held in the proper way. The machine may fall down and
cause injury.

When the printer falls down, disconnect the power cord and contact the place of purchase or a qualified
technician. If you continue to use it, it may result in fire or electric shocks or poor printing quality.

Do not place the printer on a shaky table or high shelf or other unstable location. Otherwise it may tip over or
fall down and cause injury. Furthermore, the table that supports the printer should be at least 35.4 in. (90 cm)
in width and 23.6 in. (60 cm) in depth, and should be able to bear a weight of 150 kg (330 Ib) or more.

Do not set up the printer in a place where it will be affected by vibration. Otherwise the printing quality may be
degraded or the printer may fall down, which causes injury or results in failure of the printer.

Do not connect the power cord until installation is complete. The printer may operate if the power switch is
turned on by mistake, which could result in injury.

Do not climb onto the printer or place heavy objects on top of it. Otherwise it may become unbalanced and tip
over or fall down and cause injury.

Be careful not to touch the claws of the mounting portion on the upper side of the rear cover. Otherwise you
may be injured.

Qb PP PRPEPPOO
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4-1. Installation of printer

Please refer to the Setup Manual included with the printer, for details of unpacking procedures and installation
procedures of accessories.
For an installation site of the printer, please bear the following points in mind:

e  When installing the printer, avoid any place that presents direct sunlight or a large amount of dust.

e  The body size is 55.1 in. (width) x 51.2 in. (depth) x 21.7 in. (height) (140 cm (width) x 130 cm (depth) x 55 cm
(height)). The main unit weighs 120 kg (264 Ib).

e  The right-and-left width of the legs is 34.1 in. (86.7 cm) while the front-to-rear width is 16.7 in. (42.3 cm). The
diameter of the legs is 1.57 in. (40 mm).

e  The height from the table to the top surface of the platen is approx. 12.6 in. (32 cm).

e Do not use any extension cable.

o As workspace in front of and on both sides of the printer, always keep 39.4 in. (100 cm) or wider space around it
from obstruction. Also, as a space to install the rear cover, keep 15.7 in. (40 cm) or wider clearance at the back
of the printer. Keep 15.7 in. (40 cm) or wider space free above the unit as well. As the air is exhausted toward
the rear side, keep 7.9 in. (20 cm) or more space open behind the exhaust opening.

e  Be sure to use a table that supports the printer should be at least 35.4 in. (90 cm) in width and 23.6 in. (60 cm)
in depth, and its top plate should be level and should be able to bear a weight of 150 kg (330 Ib) or more without
rattling the printer when in operation.

e  When installing the printer, place a level gauge on the top surface of the cover and the top surface of the platen
to make adjustments so that the main unit is set horizontally level.

e In preparation for a major earthquake or other natural disasters, fix the table and the main unit with a tool like a
fixing band to prevent the main unit from falling from the table.

_ 15.7 in. (40 cm) or more - \
Printer installation dimensions

Exhaust

— \

o 15.7 in. (40 cm) or more

106.3 in. (270 cm) or longer

394 ’('1’66{\)

4in. cm 3
-~ ormore N
/\\

J

39.4 in. (100 cm)
or more

)\ 39.4 in. (100 cm) or more
133.9in. (340 cm) or more

35.4 in. (90 cm) or more ~ 236in. (60 cm) or more

/ X0235

38



Leg dimension

e

1.57 in. (40 mm) SN
Leg

34.1in. (86.7 cm)

Platen height dimension surface

N / Platen top surface

> I Approx. 12.6 in. (32 cm)

Base

39
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Seismic protection example
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Installation and preparation

4-1-1. Installation of waste ink tank

Fix the waste ink tank to the table leg or the like by using two pieces of string, etc. Insert the waste ink tube and the
waste ink tube fixing rubber.
<IMPORTANT>
. The waste ink tube contained in the waste ink tank should be cut down to around 1.57 to 1.97 in. (4 to 5 cm) so that it can fit
into the tank. If the tip of the waste ink tube is immersed in the liquid, it will prevent the smooth flow of the waste ink, to
disable the ink suction operation of the head cleaning function.
. Avoid placing the waste ink tube horizontally as much as possible, and be sure not to let it bend. Otherwise the waste ink
may have difficulty flowing through the tube.
<TIPS>
° Install the waste ink tank in the front, because it must be emptied when the waste ink is full.
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Installation and preparation >

4-2. Power supply of printer

Even when the printer is placed in standby mode, such maintenance as white ink circulation is performed automatically.
PLEASE LEAVE THE PRINTER POWERED ON 24 HOURS A DAY.
<TIPS>

Every time this printer is powered on or off, maintenance operations are performed to keep its print heads in good condition.
Turning on and off the power frequently causes more ink to be consumed because of the maintenance operations. In order to
reduce the ink consumption, it is advisable to keep the power turned on for proper use of the printer.

4-2-1. Turning on the power

Please refer to the Setup Manual, after the unpacking procedures and installation procedures are completed.
Please check the following points, before connecting the power cord to the printer:

Ascertain whether the cartridges, wiper cleaner, flushing receiver, etc. are mounted correctly in place.
Ascertain whether the ink tube is connected to the print head correctly.

Wiper cleaner - ~

Cartridge

%

W12 W34

%

Flushing receiver

1
)
@)
(4)

X0256

Ascertain whether the waste ink tube is inserted into the waste ink tank which has been made available.
Ascertain whether the rear cover is put in position.

Ascertain whether there is enough cleaning solvent in the cleaning liquid tank and the tank is mounted correctly
in place.

Ascertain whether the required space (at least approx. 11.8 in. (30 cm)) for the platen to be moved forward is
kept and the min. clearance (7.9 in. (20 cm)) is maintained at the back side of the printer for exhausting air from
the exhaust opening.

Connect the power cord included with the printer to the power cord insertion port.

Insert the power plug into an electric outlet.

Make sure that the printer's earth terminal is properly grounded.

With the main unit's cover being closed, turn on the power to the printer.
<IMPORTANT>

Never power off the printer while it is in operation. Otherwise, the printer may be damaged.

Do not activate the printer with the ink tube not connected to the print head. Otherwise, the printer may be damaged.

Make sure that no flushing foam extends off the outboard end portions of the flushing receiver. If it sticks out of the end
portions, it may interfere with any nozzles and may result in non-ejection of ink-jet droplets.

<TIPS>

If the printer is activated after having been off for a long time, the maintenance operation including white ink circulation will
be performed for up to 40 minutes.
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Installation and preparation >

4-2-2. Turning off the power

When you need to turn off the power
Turn off the power in the following cases.
e  When the front cover needs to be opened for maintenance of the printer, etc.

e  When moving the printer elsewhere.
e Inthe event that the power supply interruption is anticipated in advance, including the case where a planned

power outage is scheduled.

<IMPORTANT>
. When you want to move the printer, perform [Printer transport preparation] before doing so. Otherwise, the print head may

fail to eject ink-jet droplets due to the vibration during transport. (For details, refer to "4-4. Moving the printer >>P.60".)

How to turn off the power

(1) Press the power button for a short time (less than 3 seconds).
If the printer is operating, wait for it to finish.

(2) Cleaning will start at the end of the print job.
Then the power will be turned off.

<IMPORTANT>
. No cleaning will be performed at the end of the print job to keep the print heads in good condition, if you open the front

cover before turning the power off, disconnect the AC power cable, or press and hold the power button for more than 3
seconds. In these cases, the print heads may fail to eject ink-jet droplets. For this reason, be sure to activate the printer

once again and perform the head cleaning after activation.
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Installation and preparation >

4-2-3. When there is no prospect of electric power recovery for a while due to power outage

(1) Open the front cover and move the carriage to the left, and stop it at the position where the left side of the carriage

reaches the end. The position of the print head and the cap should match.
Returning the print heads to the cap position prevents them from drying up.

(2) Insert the carriage fixing pin into its specified hole, and fix the carriage to the cap position.
<TIPS>
3 Note that the carriage fixing pin is housed in the area on the left side of maintenance unit.
. The front cover will not close completely if the carriage is fixed with the carriage fixing pin.

Carriage fixing pin

0 P—
[N
1y
L
v Fixed location

2

L Stowed position

X0192

Front cover

*The cover will not close

completely while the 2
carriage is fixed. \ :

1

Carriage fixing pin \\

(3) When the current state is brought to an available condition to turn on the power, pull out the carriage fixing pin,

X0200

return it to its stowed position and reactivate the printer.
<IMPORTANT>
3 For this reason, be sure to activate the printer once again and perform the head cleaning after activation.
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Installation and preparation

4-3. Connection between Printer and PC

This chapter provides information about the procedures to install the GTX-4 printer driver onto your PC and connection

method of the printer to PC.

For Windows 7, 8.1, and 10, different dialog boxes may be displayed. Proceed with the next step while checking each

procedural step.

This printer can also be installed on Macintosh. For details, please refer to "For Macintosh Instruction Manual'".

Installing the printer driver

"4-3-1. Installing printer driver onto your PC >>P.45"

When connecting via
USB

Add a Printer to PC

LV

"4-3-2. Connect with
USB2.0 cable >>P.46"

When connecting via LAN

B2

Set static IP
address on PC

C

Set static IP address on
Printer main unit

Printer static IP Address
Set
"4-3-3. When connecting via

LAN: Printer static IP address
setting >>P.48"

C2

Printer static IP Address
Set

"8-14. Static IP address setting
>>P.231"

Add a Printer to PC

"4-3-4. When connecting via LAN: Adding a printer to PC >>P.52"

Adjusting Printer

"7-4-1. CR (Carriage) speed adjustment >>P.212"
"7-4-2. Initial settings after head replacement >>P.213"
"7-4-3. Firing adjustment >>P.214"
"7-4-4. Platen feed adjustment >>P.215"

"7-4-5. White/color alignment >>P.216"

44



Installation and preparation >

4-3-1. |Installing printer driver onto your PC

To begin with, on your PC, install the printer driver for file output, "Brother GTX-4 FileOutput".
At this stage, do not connect the printer to your PC yet.

<TIPS>

o You must log into your PC with administrator privileges.

(1) Activate the PC.

(2) Complete all of the current sessions.

(3) Double-click on the "setup.exe" to execute the installer.

(4) Then, the installation procedures will begin. Follow the on-screen instructions to complete the installation.
(5) When the dialog box shown below appears, click [Install].

2] Windaws Security [

Would you like to install this device software?

= Mame: Brother Printers
wf Publisher: Brother Industries, Ltd.

[ Always trust software from "Brother Industries, Don't Install §
Lid.".

'@' ¥ou should only install driver software from publishers you trust. How can [ decide
which device software is safe to install?

(6) After the installation is completed, reactivate the PC.
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Installation and preparation >

4-3-2. Connect with USB2.0 cable

™

2

@)

After installation of the printer driver is completed as explained in "4-3-1. Installing printer driver onto your PC

>>P.45", connect the PC and the printer via a USB 2.0 cable with the printer power on.
<TIPS>

. For this connection of the USB cable, secure it in place by means of the cable clamp as required.
When the driver software installation window is displayed, click [Skip obtaining driver software from Windows

Update], and select [Yes] on the next screen.

The installation procedures will be automatically performed, and the relevant information is displayed on the lower right area of
the PC screen.

<TIPS>

. This screen may prompt more than once.

. And this also may require several minutes to complete.

Installing device driver software

USE Printing Support { Ready to use
BrotherGTX-4ux (_} Searching Windows Update...

mine Hees Arie gt are Wi ats W
ip obtaining drver software from Windows Update

After the installation is completed, open the [Devices and Printers] from [Control Panel].
<TIPS>

. In the case of Windows 8.1, select the [View devices and printers] from [Control Panel].

. In the case of Windows 10, select [Settings] -> [Device] -> [Devices and Printers].

[E=SEEr
e
@UJ@ » Control Panel » Hardware and Sound » Devices and Printers = &,|| Search Devices and Printers P
Add a device Add a printer = - (-]

4 Devices (4)

~

DN NWR  MEEIMETIE-AC N Caphassd [T
Urar

4 Printers and Faxes (4)

Brother GTX-4 Brother GTX-4 Fax Microsof ft XPS
FilcOutput Document Writer

8 items
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Installation and preparation

(4) Right-click the "Brother GTX-4" icon or the "Brother GTX-4 FileOutput" icon for file output, and select the [Set as
default printer].

(5) If LAN connection is required, perform static IP address setting on the printer and add the printer to the PC.
If connecting only via USB and LAN connection is not required, configuration task on the PC is now completed.

(6) Adjust the carriage speed. Then adjust the printer using "GTX-4 Installation".
<TIPS>
. In [Initial settings after head replacement] and subsequent steps, you can use "GTX-4 Installation" to adjust the printer.

Menu name Things to prepare See the operating procedure with
GTX-4 Maintenance
, "7-4-1. CR (Carriage) speed
1 | [CR Speed Adjustment] — adjustment >>P212"
5 [Initial settings after head . "7-4-2. Initial settings after head
replacement] replacement >>P.213"

Black paper or transparent sheet

3 | [Firing Adjustment] (such as OHP sheet) "7-4-3. Firing adjustment >>P.214"
White paper

"7-4-4. Platen feed adjustment
4 | [Platen-Rolling Adjustment] White paper )

>>P.215"
) i Black paper or pretreated black or | "7-4-5. White/color alignment
5 | [White/Color Alignment] dark color T-shirt >>P 216"

What to do in the White Ink Pause Mode

For the White ink pause mode, perform the following steps using the maintenance tool.

Menu name When in White Ink Pause Mode

1 | [CR Speed Adjustment] Performed

Performed for color head only

Upon completion of color head
setting, click [Cancel] to close the
maintenance tool once and then start
it. Then proceed to the following
steps.

Performed for color head only

Upon completion of color head
setting, click [Cancel] to close the
maintenance tool once and then start
it. Then proceed to the following

2 | [Initial settings after head replacement]

3 | [Firing Adjustment]

steps.
4 | [Platen-rolling adjustment] Performed
5 | [White/Color Alignment] Not required
6 | [Setting of the time displayed on the nozzle check pattern] Performed
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Installation and preparation

4-3-3. When connecting via LAN: Printer static IP address setting

There are two ways to set a static IP address for the printer; the setting procedures from the Start menu on the PC side,
and other setting procedures from menu manipulation on the printer side. When you set this through menu manipulation
on the printer side, refer to "8-14. Static IP address setting >>P.231".
<TIPS>
o When connecting via LAN, Printer static IP address needs to be obtained beforehand.
In addition, if the PC cannot recognize the Printer even after performing "4-3-4. When connecting via LAN: Adding a printer to PC
>>P.52", correct static IP address might not be assigned. Consult your administrator.

(1) With the printer powered on, make a connection with a USB 2.0 cable between the printer and your PC.
<TIPS>

. For this connection of the USB cable, secure it in place by means of the cable clamp as required.
(2) From [All Programs] in the Start menu, select the "GTX-4 Maintenance" from "Brother GTX-4 Tools".

(3) After the window shown below appears, select the [IP Address Set] and click [Next].

7 Brother GTX-4 Maintenance @

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Virtual printer hd ] [ Search

Select an item from the menu below and dick Next”.

() Initial settings after head replacement
Perform this setting when replacing the head or when setting up the printer anby.

() Firing Adjustment
Adjust this sstting when the edges of the print leck vague, solid areas are not even, or after 2 Print Head is replaced.

“) Platen-rolling adjustment

Make adjustments when horizental stripes {banding) occur in the printed image. Use this adjustment as 2
troubleshooting methed when other items such as proper temperature and humidity have already been verified.

() White/Color Alignment
Adjust when white print does not align with color print.

3 static IP address to the printer.

") Log Data Retrieval
Execute if there was 2 request after troubleshocting service,

() Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulstion.

() Set the scheduled time for white ink dirculation
Configure this sstting to set or cancel the scheduled time for white ink circulstion.
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Installation and preparation

(4) Select the desired IP address setting method and click [Next].
7 Brother GTX-4 Maintenance =

Step 1:
Select the method of setting the IP address.

() Automatically acquire the IP address

[ <o W[ vext> M concel |

49



Installation and preparation >

If you selected "Manually enter the IP address"

(5) Enter each of the pre-determined values of the printer for [IP Address], [Subnet Mask] and [Default Gateway], and

click [Next]. (One instance of each value is cited as shown in the window below.)
§ Brother GTX-4 Maintenance w

Step 1:
Input IP address.

Input IP address, Subnet Mask and the default Gateway to the printer,

IP Address

Subnet Mask

Default Gateway

= e
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Installation and preparation >

If you selected "Automatically acquire the IP address™

(5) Enter the host name to be set for the printer and click [Next].
<TIPS>
° The host name can contain up to 31 characters.

2 Brother GTX-4 Maintenance e

Step 2:
Enter the host name.

Enter the host name to be assodated with the printer,

Host name : ==

Press "Next” to automatically acquire the IP address,

text > Cancel

(6) When [IP address was successfully assigned to Printer.] is displayed, the process is complete.
If there is any error in each of the values you have entered for the static IP Address, Subnet Mask and Default Gateway, an error

message to inform you thereof accordingly will appear. In this case, correct the error and attempt the process again.

§7 Brother GTX-4 Maintenance ﬁ

Step 2:
IF address was assigned.

1P address was successfully assigned to Printer.

< Back E Mext > u Cancel
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Installation and preparation >

4-3-4. When connecting via LAN: Adding a printer to PC

™

2

@)

Connect your PC with the printer by means of the LAN cable to make a network connection, and power on the

printer.
<TIPS>
. For this connection of the LAN cable, secure it in place by means of the cable clamp as required.

Select the [Devices and Printers] from [Control Panell].

<TIPS>

. In the case of Windows 8.1, select the [View devices and printers] from [Control Panel].
. In the case of Windows 10, select [Settings] -> [Device] -> [Devices and Printers].

Click the [Add a printer].

@Uv‘é + Control Panel » Hardware and Sound b Devices and Printers « | 43 || Search Devices and Printers o

4 Devices (4)

DL NEWE  MEKIHATIE-RC LIS Oyl
Mawr
4 Printers and Faxes (4)
! C/
Brother GTX4  Brother GTX-4 Fax Microsoft XPS
FileOutput Document Writer

8 items
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Installation and preparation >
(4) Inthe window for selection of type of printer to be installed, select the [Add a local printer].
<TIPS>

. In the case of Windows 8.1, select [The printer that | want isn't listed] -> [Add a local printer or network printer with manual
settings], then click [Next].

. In the case of Windows 10, select [The printer that | want isn't listed] -> [Add a local printer or network printer with manual
settings], then click [Next].

r

() 1 Add Printer

What type of printer do you want to install?

% Add a local printer

Use this option only if you don't have a USB printer. (Windows automatically installs USB printers
when you plug them in.)

2 Add a network, wireless or Bluetooth printer

Make sure that your computer is connected to the network, or that your Bluetooth or wireless
printer is turned on.

(5) Select the [Create a new port], then select [Standard TCP/IP Port] for [Type of port], and finally click [Next].
- :
@ = Add Printer

Choose a printer port

A printer port is a type of connection that allows your computer to exchange information with a printer.

() Use an existing port: LPT1: {Printer Port) -

@) Create a new port:

Type of port: [Standard TCP/IP Port -
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(6)

(7)

(8)

In the [Hostname or IP address] field, enter the already-setup static IP address of the printer, uncheck the [Query
the printer and automatically select the driver to use], and click [Next]. (One instance of each value is cited as

shown in the window below.)

@ ) Add Printer
Type a printer hostname or IP address
Device type: TCP/IP Device
Hostname or IP address: 192.168.0.2
Port name: 19.2..16.8.0.2.
[T] Query the printer and automatically select the driver to use
b

<TIPS>

. If you set the printer's IP address by automatic acquisition, you must check the IP address of the printer in advance. You
can confirm the IP address by selecting [Confirm network setting] -> [IP Address] from the menu. For details, refer to "8-21.
Confirm network setting >>P.236".

. If you are using a DNS server, you can use a host name and domain name instead of the IP address. In that case, enter
the host name that has been set for "4-3-3. When connecting via LAN: Printer static IP address setting >>P.48". As for the
domain name, check with your network administrator.

Then, the detection window of TCP/IP port appears, and the current window will automatically go to the additional
port information window after the detection is completed.

After the window shown below appears, select the [Custom] in the [Device Type], and click [Settings].
- .
@ (= Add Printer

Additional port information required

The device is not found on the network. Be sure that:

. The device is turned on.

. The network is connected.

. The device is properly configured.

. The address on the previous page is correct.

T

If you think the address is not correct, click Back to return to the previous page. Then comect the
address and perform another search on the network. I you are sure the address is correct, select the
device type below.

Device Type

(7) Standard Generic Network Card
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(9) Inthe [Protocol], select the [LPR], enter "BINARY_P1" in [Queue Name] of the [LPR Settings], and click [OK].

When the current screen goes back to the previous screen, click [Next].

Configure Standard TCP/IP Port Monitor

Port Settings |

Port Mame: 192.168.0.2

Printer Mame or IP Address: 192.168.0.2

©) Raw @ LPR

Raw Settings

Protocol

Part Number |QlUI'J

LPR Settings

[T]LPR Byte Counting Enabled

[C] SMMP Status Enabled

Queue Name: BINARY_P1|

Cormrmunity Marne: | public

SMRAP Device Indesx | 1

| .

(10) After the window shown below appears, click the [Have Disk].

[

@ = Add Printer

Install the printer driver

,/  Choose your printer from the list. Click Windows Update to see more models.

To install the driver from an installation CD, click Have Disk.

Manufacturer * || Printers g

Brother M [5] Brother DCP-116C L
55l Brother DCP-117C
53l Brother DCP-128C
53l Brother DCP-129C

T l=ins o nen acne i

) This driver is digitally signed. [ Windows Update [ Have Disk... |

Tell me why driver signing is important
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(11) Click the [Browse], select the "32bit_OS" or "64bit_OS" folder in the installer according to the PC's OS (32 bit
version/64 bit version).

After the file path appears, click [OK].

Install From Disk

Insert the manufacturer’s installation disk, and then -
c,,y make sure that the comect drive is selected below. ok ]

Copy manufacturer’s files from:
=

(12) Make sure that a list of printer drivers is shown for the selected folder.

After that, click [Next].

@ i1 Add Printer

Install the printer driver

.} Choose your printer from the list. Click Windows Update to see more models.

To install the driver from an installation CD, click Have Disk.

lBrother GTX-4 |

5] This driver has an Authenticode(tm) signature, [ Windows Update J ‘E Have Disk... H

Tell me why driver signing is important

(13) After the window shown below appears, select the [Replace the current driver], and click [Next].

@ i1 Add Printer

Which version of the driver do you want to use?

Windows detected that a driver is already installed for this printer.

(©) Use the driver that is currently installed (recommended)
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(14) Enter [Printer name], and click [Next].

Installation and preparation

@ i1 Add Printer

Type a printer name

Printer name: Brother GTX-4 (LAN)

This printer will be installed with the Brother GTX-4 driver.

(15) Then, the specified printer will be added to the system, following which the window shown below appears, select

the [Do not share this printer], and click [Next].

'k_)' gl Add Printes

Printer Sharing

If you want to share this printer, you must provide a share name. You can use the suggested name or
type a new one. The share name will be visible to other network users.

[ _Nec W concel |

57

>



Installation and preparation

(16) As required, select the [Set as the default printer], and click [Finish]. This exits the setting for the PC.
S|

35 = Add Printer

You've successfully added Brother GTX-4 (LAN)

To check if your printer is working properly, or to see troubleshooting information for the printer, print a
test page.

Print a test page

(17) Adjust the carriage speed. Then adjust the printer using "GTX-4 Installation”.
<TIPS>
. In [Initial settings after head replacement] and subsequent steps, you can use "GTX-4 Installation" to adjust the printer.

Menu name Things to prepare See the operating procedure with
GTX-4 Maintenance
, "7-4-1. CR (Carriage) speed
1 | [CR Speed Adjustment —
[ peed Adjustment] adjustment >>P.212"
5 [Initial settings after head "7-4-2. Initial settings after head
replacement] replacement >>P.213"

Black paper or transparent sheet

3 | [Firing Adjustment] (such as OHP sheet) "7-4-3. Firing adjustment >>P.214"
White paper
"7-4-4. Platen feed adjustment

4 -Rolli j Whit

[Platen-Rolling Adjustment] ite paper >>P215"

) i Black paper or pretreated black or | "7-4-5. White/color alignment
hit lor Al t

5 | White/Color Alignmen] dark color T-shirt >>P216"

[Setting of the time displayed
on the nozzle check pattern]

"7-4-6. Setting of the time displayed
on the nozzle check pattern >>P.217"
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What to do in the White Ink Pause Mode

For the White ink pause mode, perform the following steps using "GTX-4 Maintenance".

Menu name

When in White Ink Pause Mode

[CR Speed Adjustment]

Performed

[Initial settings after head replacement]

Performed for color head only

Upon completion of color head
setting, click [Cancel] to close the
maintenance tool once and then start
it. Then proceed to the following
steps.

[Firing Adjustment]

Performed for color head only

Upon completion of color head
setting, click [Cancel] to close the
maintenance tool once and then start
it. Then proceed to the following
steps.

[Platen-rolling adjustment]

Performed

(@]

[White/Color Alignment]

Not required

[Setting of the time displayed on the nozzle check pattern]

Performed

59




Installation and preparation

4-4. Moving the printer

<IMPORTANT>
When you want to move the printer, perform [Printer transport preparation] before doing so. Otherwise, the print head may
fail to eject ink-jet droplets due to the vibration during transport.
(1) While the printer is in standby mode, press the @ on the operation panel to bring the menu screen into the view.
(2) From the menu, select [Maintenance] > [Printer transport preparation], and press @ .

(3) Check the remaining ink in the ink pouch and press @ .

Printer transport preparation

[ 2Imin[39]sec

Please Wait

(4) Once the transport preparation is complete, turn off the power.

(5) Remove the power plug from the outlet and move the printer.
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H Creating print data

5-1. Types of applications

You can create print data by either “using Brother products” or "using other applications”. Select applications to use
depending on your needs. You are recommended to use Brother product applications as far as possible. If you want to
use other applications, however, you are recommended to use one of the four recommended applications to achieve
high-quality print results. This chapter describes the procedures for using other applications.

Using Brother product

Applications to use

Reference

GTX Graphics Lab

Graphics Lab Instruction Manual

When using other applications

Applications to use

Reference

CoreIDRAW(X7/X8)

"5-2-1. CoreIDRAW >>P.63"

Adobe Photoshop(CS6/CC)

"5-2-2. Adobe Photoshop >>P.70"

Adobe lllustrator(CS6/CC)

"5-2-3. Adobe lllustrator >>P.75"

Adobe Photoshop Elements(14/15)

"5-2-4. Adobe Photoshop Elements >>P.81"

<TIPS>

. Make proper settings, such as color settings and printing conditions, of each application, in accordance with the setting contents

of the application.

. In this chapter, the value RGB=(254,254,254) is described as "RGB=254", and the value RGB=(255,255,255) is described as

"RGB=255".
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About color mode (color space)

The GTX-4 printer is a printer of RGB type.

Be sure to create image data in RGB mode, and always set the color space (input) you use for such data to sSRGB

(sRGB IEC61966-2.1).

<TIPS>

. When such application as Adobe and Corel is used, there are instances in which an image in CMYK mode cannot reproduce the
color that is intended.

. Even for an image in RGB mode, a similar color reproduction failure occurs when other color space than the specified one, such
as Adobe RGB, is used.

About print layout

Specify the platen size that uses the paper size specified in the Print menu, and confirm the print layout.
Moreover, use the "Brother GTX-4 FileOutput" printer driver for file output, then display and check the print preview.
<TIPS>

. In order for a print image to be oriented properly at all times, it is advisable to set the GTX-4 printer to the [Set as default printer].

How to create white data

When creating print data with [Color + White Ink] or [White Ink Only], RGB=(255) is treated as "Transparent color",
ejecting no ink. For such an image that you wish to print out in pure white color with white ink, make such a setting as
RGB=254.

<TIPS>

° The treatment of RGB=255 varies depending on the applications. Configure the settings appropriately.

About ARX4 file

Use the "Brother GTX-4 FileOutput" printer driver for file output in order to save your print data in the ARX4 format.

When your print data is saved in the ARX4 format, its information and the amount of used ink will be able to be reviewed.

<TIPS>

° When performing file output, be sure to use the printer driver, "Brother GTX-4 FileOutput". If file output is performed using [Print to
file] command that is supplied with each application, there may be some cases where the file extension cannot be saved
as .arx4, or the file destination cannot be specified.

° The GTX-4 printer cannot print out the print data that has been created for the GT-541/GT-782/ GT-3 series.

. If you make a printer driver setting from the Control Panel of your PC, such setting sometimes will not take effect in each
application. For this reason, verify that your printer driver has been set up properly before you begin printing.
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5-2. Creating print data from other applications

5-2-1. CorelDRAW

In CorelDRAW, configure the required settings for the following items:
e  Color setting
e  Printsize
As required, perform the following procedures:
e  Create print data (ARX4 file)
¢  What to do when using the color palette in Useful Tools
o  What to do when converting data to bitmap image data
e  What to do when replacing RGB=255 in bitmap image data with RGB=254

<TIPS>
. For this printer, it is recommendable to use CorelDRAW X7/X8. The display screen is described in CorelDRAW X7.

Color setting

(1) Inthe menu bar, select the [Tools] > [Color Management] > [Default Settings].

(2) Establish the settings of [Default Color Management Settings] as follows:
¢ [RGB]: [sRGB IEC61966-2.1]
e [Primary color mode]: [RGB]
¢ [Rendering intent]: [Relative colorimetric]

Default Color Management Settings X
Presets: ’Custom V]
Default color settings Color management policies
Open:
(Default) sRGE IECE1966-2.1 RGE: [Use embedded color profile vl

CMYEK: (Default) U.5. Web Coated (SWOP) v2 - CMYK: lUse embedded color profile VI

Grayscale: I(Defauit} Dot Gain 20% V] Grayscale: lUse embedded color profile VI

A [ Warn on color profile mismatch
Primasy color mode: | [] Warn on missing color profile

Rendering intent: Relative colorimetric impotaadpesie:
Color conversion settings RGB: lConvert to document color pr... vl
Color engine: [MicrosoftICM CMM Vl

CMYK: lAssign document color profile vl

[ Preserve pure black

2 le: I
[7] Map gray to CMYK black Grayscale lConvertto document color pr vl

[ Warn on color profile mismatch

Spot color definition: [Lab values '] [ Warn on missing color profile

% Description
Choose the default RGB color profile for new and untagged documents,

oK ] [ Cancel l [ Help
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Print size

(1) Inthe menu bar, select [File] > [Print].
(2) Set the [Printer] to either "Brother GTX-4" or "Brother GTX-4 FileOutput", click on [Apply], and close the [Print]

dialog box.
<TIPS>
. If [Printer] is set to "Brother GTX-4", the print data at the time of printing will be sent to the printer.
If [Printer] is set to "Brother GTX-4 FileOutput", the print data at the time of printing will be saved as an ARX4 file.
Print X

General |Colm I Composite I Layout | Prepress I %2 No }ssus|

Destination
Printer: |Brother GTX-4 FileOutput | | Preferences..
Page: [Match orientation (Portrait) V| " | Use PPD
Status: Default printer; Ready
Location: GTX4FPort
Comment: [ Print to file
Print range Copies
. ) Documents Number of copies: 1 =
) Current page Selection
Pages: 1 Collate
| Even & Odd
[Z] Print as bitmap: 300 —| dpi
Printstyle: | CorelDRAW Defaults v| [ seveas. |
[ PrintPreview | [ ok ][ cancel Apply | Hep |

(3) Inthe menu bar, select [Layout] > [Page Layout].
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(4) Make the following settings in the [Page Size] window:

o [Size]: [Custom]

o [Width]: 14.0 in. (355.6 mm)

¢ [Height]: 16.0 in. (406.4 mm)

o Page orientation: Portrait
<TIPS>
. Set the width and height to the size of platen to be used. The above size is the standard 14X16 platen size.

For details of platen size's numeric values, refer to "5-3-1. Select the platen size >>P.86".

Options X
P
- Workspace =
. P Page Size
= Document
- General Size and orientation

- Page Size & [C 2 | = D
. - - M’
.. Layout e LM w
- Label i I =] E
Width: 14-0| inches -
. Background z

B GLfldehnes Height: 16.0 = D O
... Grid
- Rulers " Apply size to current page onl
.. Save
V| Show page border
... Export To HTML []Show pag
[ Global Add Page Frame
Resolution
Rendering Resolution: 300 * dpi
Bleed
Bleed: 0.0

|| Show bleed area

[ ok ][ concet |[ Help |

Create print data (ARX4 file)

Save the image data and print settings as a set of print data in ARX4 file format.
The following will be made available if the print data is converted into an ARX4 file:
e Image data and print settings can be put together and stored.
e  Without connection to a PC, the printing can be performed directly from a USB flash memory unit.
<TIPS>
. Image editing is unavailable for any ARX4 file. As such, save your image data for an editing purpose in advance.
o For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Be sure to use the printer driver "Brother GTX-4 FileOutput".
° For details of directly sending data to the Printer from an application, refer to "6-6-2. Sending print data from other applications
>>P 149",

(1) Inthe menu bar, select [File] > [Print].
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(2) Open the [Color] tab, and make the following settings:
e Place a checkmark in the [Use document color settings] checkbox.
o [Color conversions performed by]: "Brother GTX-4" or "Brother GTX-4 FileOutput"
e [Correct colors using color profile]: [SRGB IEC61966-2.1]

¢ [Rendering intent]: [Relative colorimetric]
[ Print X

| Gene!ai| Color | Composite | Layout | Prepress | 17 No lssues

@ Print composite

() Print separations

@ Use document color settings

(@) Use color proof settings

Color conversions performed by: Brother GTX-4 FileOutput

Cutput colors as: RGB

|/ | Convert spot colors to RGE

Cofact colom g ok piohle | (Document) sRGB IEC61966-2.1

|| Preserve RGB numbers

[¥] Preserve pure black

Rendering intent: [ Relative colorimetric

0 The color settings and preview available in this dialog box are set for the Windows Graphic device
printer that you selected on the General tab.

Print Preview [ ok ][ cConcel | [ Apply | [ Help

(3) On [General] tab, select [Printer] and select "Brother GTX-4 FileOutput" for file output.
<TIPS>
° If the specified [Printer] is set to "Brother GTX-4", the print data will be sent to the printer.
If the specified [Printer] is set to "Brother GTX-4 FileOutput", the print data will be saved as an ARX4 file.

(4) On [Preferences], create your settings of printer driver.
<TIPS>
o For details, refer to "5-3. Set up the printer driver >>P.84".
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(5) When you press [OK] in the [Print] dialog box, the dialog box shown below will be displayed. After that, click [Save].

m

Present Layer 1 WaCMYK | [ White Data
—

<TIPS>
. There may be cases where this saving process takes several minutes.
94f' Brother GTX-4 File Output Preview window
Machine Mode GTX-422
Job Name IMG_1404
Date : 06/25/2017 18:40
Platen Size : 14x16
Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink
Highlight : 5
Mask : 3
Print Time : x1
Whiteness : 400 %
Use background black color ~ Off
Color Multiple Pass Printing : ~ Off
Color Ink : 097 cc
White Ink : 865cc
Print : 1 piece

(6) Specify the [Save In] and [File name] first, then click [Save] to save the ARX4 file to your PC.

What to do when using the color palette in Useful Tools

(1) Follow "5-4-1. Color palette for Adobe Photoshop, Photoshop Elements, lllustrator and CorelDRAW >>P.100" to

save the color palette files ("GT_Colors.xml" and "GT_Tshirts.xml") for CoreIDRAW on your PC.

(2) Inthe menu bar, select [Window] > [Color Palettes] > [Open Palette].

(3) Select the files having such filename as "GT_Colors.xml" and "GT_Tshirts.xml", respectively.

<TIPS>

. Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from

the resulting print color.
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What to do when converting data to bitmap image data

(1) Inthe menu bar, select [Bitmaps] > [Convert To Bitmap].

(2) Setthe [Color mode] to [RGB Color].

<TIPS>
. When the white ink is used for performing the printing, unmark the [Anti-aliasing] checkbox.

Convert To Bitmap X
Resolution: 300 * dpi
Color
Color moddll| RGB Color (24-bit) -|
Dithered

Always overprint black

Options
@Enti-aliasing
[¥| Transparent background
Uncompressed file size; 1,46 MB
| ok || cancel |[ Help

<TIPS>

° Even when the platen size to be used has been selected from the printer driver, the current setting in [Page Layout] may change

to [Settings from printer].
In the [Page Layout], be sure to change the width and the height according to the size of the platen.
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What to do when replacing RGB=255 in bitmap image data with RGB=254

RGB=255 is identified as a transparent color. In a portion where RGB=255 is contained, no ink will be ejected.

In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.
To make such replacement, use the method mentioned below.

(1) Inthe menu bar, select [Effects] > [Adjust] > [Replace Colors].

(2) From the [Old color] pull-down menu, click [More] to set RGB=255 in [Select Color].

RGB=255

Select Color

‘E@ Colors [Z] W Models =] Mixersl Bl Palettes

X

Options Color Mask: = T—T )
[“J1gnore grayscale o
[] Single destination color
1 v )

. R 255 ¢
Saturatiof {} 0
6 5 4
Lightness {} 0
B 5 4
Range: {} 30
Name:
b ! White
Reset ‘ oK I [ Cancel ‘ { Help
Add To Palette H ‘ Options ¥ H ok | [ Cancel
(3) Inthe same manner, set [New color] to RGB=254.
(4) Set[Range]to "1", and click on the [OK] button.
Replace Colors x
=] ™
Old color: H Options Color Mask:
a _ [7]Ignore grayscale

MNew color: : [ Single destination color

Difference Between Colors

HUE """" L | D TIrrrr | Trrrr | 0
iituration; T u L e e 0
L|ghtn¢55: T IJ | 0

l Preview ][ Reset ] Cancel H Help

<TIPS>
. For the vector data, change the fill color to RGB=254.
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5-2-2. Adobe Photoshop

In Photoshop, configure the settings mentioned below:
e  Color setting
As required, perform the following procedures:
e  Create print data (ARX4 file)
e  What to do when using the color palette in Useful Tools
e  What to do when replacing RGB=255 with RGB=254

<TIPS>

° For an image created in the CMYK color mode, select [Image] > [Mode] in the menu bar, and change the color to the RGB color
(sRGB). In order to edit an image, select [Image] > [Adjustments] in the menu bar and edit it, or edit it by means of the image
quality improvement of the printer driver (Refer to "5-3-9. Set up the image quality >>P.97").

. For this printer, it is recommended to use Photoshop CS6/CC. The display screen is described in Photoshop CC.

Color setting

(1) Inthe menu bar, select [Edit] > [Color Settings].

(2) Establish the settings of [Color Settings] as follows:

[Working Spaces]
¢ [RGB]: [sRGB IEC61966-2.1]

[Conversion Options]
¢ [Engine]: [Adobe(ACE)]
¢ [Intent]: [Relative Colorimetric]

[Color Management Policies]
¢ [RGB]: [Convert to Working RGB]
e [CMYK]: [Convert to Working CMYK]
o [Gray]: [Convert to Working Gray]
¢ [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes.
e [Missing profiles]: Mark the [Ask When Opening] checkbox.

Color Settings g

Seffings: Custom

Working Spaces Conversion Options
SRGB IEC61966-2.1 Engine: Adobe (ACE)
: Japan Color 2001 Coated Intent: Relative Colorimetric

ay: Dot Gain 15% Use Black Point Compensation save

jot: Dot Gain 15% Use Dither (8-bit/channel images)

Compensate for Scene-referred Profiles & preview
Color Management Policies
RGB: Convert to Working RGB Advanced Controls

CMYK: Convert to Working CMYK IR AR R

Blend RGB Colors Using Gamma:
Gray: Convert to Working Gray = LEaSI '

Blend Text Colors Using Gamma
Profile Mis Ask When Opening Ask When Pasting -

Missing Profiles: Ask When Opening

Description
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Create print data (ARX4 file)

Save the image data and print settings as a set of print data in ARX4 file format.
The following will be made available if the print data is converted into an ARX4 file:
Image data and print settings can be put together and stored.

Without connecting to a PC, the printing can be performed directly from a USB flash memory.

<TIPS>
Image editing is unavailable for any ARX4 file. As such, save your image data for an editing purpose in advance.

(1)

2

3)

(4)

Creating print data >

For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Be sure to use the printer driver "Brother GTX-4 FileOutput".
For details of directly sending data to the Printer from an application, refer to "6-6-2. Sending print data from other applications

>>P. 149",

In the menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX-4" or "Brother GTX-4

FileOutput", the layout is set to the platen size.

Make the settings as follows:

e [Color Handling]: [Printer Manages Colors]
o [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings

14inx 16in

Printer Setup
Brother GTX-4 FileOutput

B 1 Print Settings...

Layout: n Ei

~ Color Management

Rememberto enable the printe
A man entin the print settin

Document Profile: Untagged RGB
Color Handling: = Printer Manages Colors
Printer Profile:
Normal Printing  ~

Rendering Intent:  Relative Colorimetric

~  Description

From [Printer], select "Brother GTX-4 FileOutput" for file output.

<TIPS>

. If [Printer] is set to "Brother GTX-4", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX-4 FileOutput", the print data will be saved as an ARX4 file.

On [Print Settings], make your settings for the printer driver.

<TIPS>

. For setting details, refer to "5-3. Set up the printer driver >>P.84".
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(5) When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save].
<TIPS>
e  There may be cases where this saving process takes several minutes.

94f' Brother GTX-4 File Output Preview window

Machine Mode GTX-422
Job Name : IMG_1404
Date : 06/25/2017 18:40
Platen Size : 14¢16
Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink
Highlight : 5
Mask : 3
Print Time : x1
Whiteness : 400 %
Use background black color ~ Off
Color Multiple Pass Printing : ~ Off

Color Ink : 097 cc 100% [} 600%
White Ink : 865cc
Print : 1 piece

Present Layer 1 WaCMYK | [ White Data
ackoround Coor [
Close

(6) Specify the [Save In] and [File name] first, then click [Save] to save the ARX4 file to your PC.
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What to do when using the color palette in Useful Tools

(1) Follow "5-4-1. Color palette for Adobe Photoshop, Photoshop Elements, lllustrator and CorelDRAW >>P.100" to
save the color palette file for Photoshop "GT_Colors_T.ase" on your PC.

(2) Inthe menu bar, select [Window] > [Swatches].

(3) Click onthe W == to open the submenu.

Swatches

HNE ' IEEEEEN
1] ]

(4) From [Replace Swatches], select [Swatch Exchange (*.ASE)] for the type of file and then select the file name
[GT_Colors_T.ase].

Swatches

RGB=254

<TIPS>

. Do not use any color from the color sample palette, such as HKS and Pantone. Otherwise, an on-screen color may differ from
the resulting print color.
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What to do when replacing RGB=255 with RGB=254

RGB=255 is identified as a transparent color. To a portion where RGB=255 is contained, no ink will be ejected.
In order for the white ink to be printed, select an area for RGB=255, and replace it with RGB=254.
To make such replacement, use the method mentioned below.

(1) On the menu bar, select [Layer] > [New Adjustment Layer] > [Selective Color], and create a new layer.

(2) Setthe opacity to 20%, and click [OK].

.
New Layer

1e: Selective Color 1

Use Previous Layer to Create Clipping Mask

Color Iz] None

Mode: Normal

(3) From the [Selective Color], make the following settings:
o [Colors]: [Whites]
o [Black]: 1%
o Mark the [Absolute] option

<TIPS>
o The method to replace RGB=255 with RGB=254 as shown above can be used only when the [Color mode] is set to [8 bit] of
[RGB Color].

. For Photoshop, the action file "SolidWhite.atn" is made available in Useful Tools, which changes RGB=255 to RGB=254 (Refer
to "5-4-2. Action file for Photoshop >>P.100"). For how to use it, refer to the Help feature that Photoshop is provided with.

74



Creating print data

5-2-3. Adobe lllustrator

In lllustrator, perform the required procedures mentioned below:
e  Color setting
e  Openanew file
As required, perform the following procedures:
e  Create print data (ARX4 file)
e  What to do when using the color palette in Useful Tools

<TIPS>

. Take one of the actions mentioned below, in order to avoid such troubles that no image data is inserted into the print range or part
of image data is cut off.

- Before start-up, specify the PC's default printer as the "Brother GTX-4" or the "Brother GTX-4 FileOutput".
- Use the "Brother GTX-4 FileOutput" printer driver to output a file, then display and check the print preview.

. For an image created in CMYK color mode, load the image into Photoshop, select [Image] > [Mode] in the menu bar, and change
the color to the RGB color (sRGB). In order to edit an image, load the image into the Photoshop, edit it in the form of bitmap data,
or edit it by means of the image quality improvement of printer driver (Refer to "5-3-9. Set up the image quality >>P.97").

o For this printer, it is recommended to use lllustrator CS6/CC. The display screen is described in lllustrator CC.
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Color setting

(1) In the menu bar, select [Edit] > [Color Settings].
(2) Click on the [More Options].

(3) Ensure selection of the settings as mentioned below, and click [OK].
o [Settings]: [Custom]
[Working Spaces]
¢ [RGB]: [sRGB IEC61966-2.1]
[Color Management Policies]
¢ [RGB]: [Convert to Working Space]
o [CMYK]: [Convert to Working Space]

Creating print data

¢ [Profile Mismatches]: Mark the [Ask When Opening] and [Ask When Pasting] checkboxes.

e [Missing profiles]: Mark the [Ask When Opening] checkbox.
[Conversion Options]

¢ [Engine]: [Adobe(ACE)]

¢ [Intent]: [Relative Colorimetric]

-
Color Settings

N synchronize, select Color Settings in Bridge.
Settings: Custom
Working Spaces
RGB: sRGB IEC61966-2.1

CMYK: U.S. Web Coated (SWOP) v2

Color Management Policies
RGB: Convesrt to Working Space
CMYK: Convert to Working Space

Profile Mismatches: ¥ Ask When QOpening ¥ Ask When Pasting

Missing Profiles: ¥ Ask When Opening

Conversion Options
Engine: Adobe (ACE)
Intent: | Relative Colorimetric

v Use Black Point Compensation

lf‘ Hold the cursor over a setting for additional information.

Less Options

a Unsynchronized: Your Creative Cloud applications are not synchronized for consistent color. To

Save...
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Open a new file

(1) Setup a new document as follows:

<TIPS>

[Width]: 14.0 in. (355.6 mm)
[Height]: 16.0 in. (406.4 mm)
[Orientation]: Portrait
[Color Mode]: [RGB]

Creating print data

. Set the width and height to the size of platen to be used. The above size is the standard 14X16 platen size.
For details of platen size's numeric values, refer to "5-3-1. Select the platen size >>P.86".

New Document

Name:

Profile:

Number of Artboards:

Size:
Width:

Height:

Bleed:

~ Advanced

Color Mode:
Raster Effects:

Preview Mode:

Templates...

[Custom]

A
-

[Custom]

Top Bottom

-
- -

RGB
High (300 ppi)

Default

Units:

Orientation: [

Left

v

Align New Objects to Pixel Grid

x
v

Inches

Right

Cancel
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Create print data (ARX4 file)

Save the image data and print settings as a set of print data in ARX4 file format.
The following will be made available if the print data is converted into an ARX4 file:
e Image data and print settings can be put together and stored.
e  Without connecting to a PC, the printing can be performed directly from a USB flash memory.
<TIPS>
o Image editing is unavailable for any ARX4 file. As such, save your image data for an editing purpose in advance.
o For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Be sure to use the printer driver "Brother GTX-4 FileOutput".
° For details of directly sending data to the Printer from an application, refer to "6-6-2. Sending print data from other applications
>>P 149",

(1) Inthe menu bar, select [File] > [Print] > [Color Management].

(2) Make the settings as follows:
o [Document Profile]: [SRGB IEC61966-2.1]
e [Color Handling]: [Let lllustrator determine colors]
o [Printer Profile]: [sSRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: [Default]

Printer: Brother GTX-4 FleQutput

General Color Management
Marks and Bleed

int
Output Print Method

Graphics Document Profile: sRGB IEC61966-2.1

Color Management T —
Advanced Color Handling: | Let Tllustrator determine colors

s / f
ummary Printer Profile: | sSRGB IEC61966-2.1

Rendering Intent: Relative Colorimetric

Description

Document: 14 in x 16 in
Media: 14 in x 16 in
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From [Printer], select "Brother GTX-4 FileOutput" for file output.
<TIPS>
. If [Printer] is set to "Brother GTX-4", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX-4 FileOutput", the print data will be saved as an ARX4 file.

On the [Advanced], make your settings for the printer driver.

<CAUTION>

. For Adobe lllustrator, set the platen size for the paper size in the Print dialog box in the application. The size or placement of
the image may not be set correctly if you make settings in the Print Settings dialog.

<TIPS>

° For setting details, refer to "5-3. Set up the printer driver >>P.84".

When you press [Print], the dialog box shown below will be displayed on the screen. After that, click [Save].
<TIPS>
3 There may be cases where this saving process takes several minutes.

94f' Brother GTX-4 File Output Preview window L =0 g
Machine Mode GTX-422 7. 70
Job Name IMG_1404 =
Date : 06/25/2017 18:40
Platen Size : 14x16
Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink

Highiight : 5 .
Mask : 3
Print Time : x1
Whiteness : 400 %
Use background black color ~ Off
Color Multiple Pass Printing Off

:
Color Ink : 097 cc 100% [} 600%
White Ink : 865cc
Print : 1 piece

Present Layer 1 WaCMYK | [ White Data
3 ackoround Coor [
Close

Specify the [Save In] and [File name] first, then click [Save] to save the ARX4 file to your PC.
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What to do when using the color palette in Useful Tools

(1) Follow "5-4-1. Color palette for Adobe Photoshop, Photoshop Elements, lllustrator and CorelDRAW >>P.100" to

save the color palette file "GT_Colors_T.ase" for lllustrator on your PC.

(2) Inthe menu bar, select [Window] > [Swatches].

(3) Clickonthe W==, and select [Open Swatch Library] from the submenu.

(4) Select [Other Library].

Swatches

(5) On the [Open] screen, select the file having such filename as "GT_Colors_T.ase".
<TIPS>
. Unlike the Photoshop or CorelDRAW, this Swatch needs to be selected each time a file is opened.
However, you can fix the Swatch library in the following method to display the screen automatically whenever you start the
application if you are using lllustrator CC.
Click W== on the top right comner of the Swatch library and select [Fix] from the submenu.

GT T
GT_Cobors_ Add to Swatches

Sort by Name
Sort by Kind
v | Show Find Field

v | Small Thumbnail View
Medium Thumbnail View

ML L.
Ak b hhbhh

Large Thumbnail View
Srall List View
Large List View
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5-2-4. Adobe Photoshop Elements

In Photoshop Elements, make the setting mentioned below:
e  Color setting
As required, perform the following procedures:
e  Create print data (ARX4 file)
e  What to do when using the color palette in Useful Tools

<TIPS>
. For this printer, it is recommendable to use Photoshop Elements 14/15. The display screen is described in the Photoshop

Elements 15.

Color setting

(1) Inthe menu bar, select [Edit] > [Color Settings].

(2) In the [Color Settings] window, select the [Always Optimize Colors for Computer Screens], and click [OK].

Color Settinags x
© Learn more about: Color Settings “
Choose how to manage color in your images: Reset

) No Color Management
(®) Always Optimize Colors for Computer Screens
O Always Optimize for Printing

O Allow Me to Choose

Mote: The "Mo Color Management” setting will ignore and discard embedded color
profiles if they exist. The other settings will utiize embedded profiles or convert
to sRGB or AdobeRGB, if the embedded profiles cannot be supported.
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Create print data (ARX4 file)

Save the image data and print settings as a set of print data in ARX4 file format.
The following will be made available if the print data is converted into an ARX4 file:
e Image data and print settings can be put together and stored.
e  Without connection to a PC, the printing can be performed directly from a USB flash memory.
<TIPS>
o Image editing is unavailable for any ARX4 file. As such, save your image data for an editing purpose in advance.
o For file output, there are some cases where neither file output destination nor extension cannot be specified by the [Print to file]
command. Be sure to use the printer driver "Brother GTX-4 FileOutput".
° For details of directly sending data to the Printer from an application, refer to "6-6-2. Sending print data from other applications
>>P 149",

(1) Inthe menu bar, select [File] > [Print].
(2) Select [More Options] > [Color Management].

(3) Make the settings as follows:
e [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

More Options x

Printing Choices Color Management

Custom Print Size
olor Managemen

Color Handling: | printer Manages Colors =

Image Space: sRGB IEC61966-2.1

Printer Profie: | Adobe RGB (1998) b4

Rendering Intent: = Relative Colorimetric -

; Did you remember to enable color management
" in the printer preferences dialog?

| Printer Preferences... |

oK | Can:el_ Help

(4) When selecting a printer, select "Brother GTX-4 FileOutput" for file output.
<TIPS>
. If the [Printer] is set to "Brother GTX-4", the print data will be sent to the printer.
If the [Printer] is set to "Brother GTX-4 FileOutput", the print data will be saved as ARX4 file.

(5) On [Printer Preferences], make your settings for the printer driver.
<TIPS>
. For setting details, refer to "5-3. Set up the printer driver >>P.84".
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(6) When you press [OK], the dialog box shown below will be displayed on the screen. After that, click [Savel].
<TIPS>
e  There may be cases where this saving process takes several minutes.

94f' Brother GTX-4 File Output Preview window

Machine Mode GTX-422
Job Name IMG_1404
Date : 06/25/2017 18:40
Platen Size : 14¢16
Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink
Highlight : 5
Mask : 3
Print Time : x1
Whiteness : 400 %
Use background black color ~ Off
Color Multiple Pass Printing : ~ Off

Color Ink : 097 cc 100% [} 600%
White Ink : 865cc
Print : 1 piece

Present Layer 1 WaCMYK | [ White Data
ackoround Coor [
Close

(7) Specify the [Save In] and [File name] first, then click [Save] to save the ARX4 file to your PC.

What to do when using the color palette in Useful Tools

The color Swatch "GT_Colors_T.ase" for Photoshop can also be used in the Photoshop Element. For details, refer to
"5-2-2. Adobe Photoshop >>P.70".
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5-3. Set up the printer driver
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<TIPS>

(1)

The GTX-4 printer driver treats RGB=(255,255,255) as "Transparent color" and does not eject the ink. For such an image that
you wish to print out in pure white color with white ink, make such a setting as RGB=(254,254,254).

For the color replacement method, refer to a relevant page or help menu of each application software of "5-2. Creating print data
from other applications >>P.63".

By following the printing procedures of each application software, open the print setup dialog box of the printer

driver.
= Printing Preferences @
Paper/Quality || Main Setting
Machine Mods : [aTx422 -]
Platen Size : [14:16 '] [ Advanced
Select Ink - [ color+White Ink -]
Mode : @ Mormal () Eco-Mode
Resolution : @ 1200dpi x 1200dpi

White Ink Settings

Highiiaht : D 5
1 2 3 4 5
Mask : D 3
Prirt Time - | x1 Whiteness : | 400 %
[ 2 Layer White
[7] White/Calor Pause
[] Use background black color for black T-shirts only)
[ Calor Multiple Pass Printing
Wdvanced :

Click to open advanced menu.
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(2) Inthe dialog box for setting the printer driver, configure required settings.
If you click on the [Advanced], [White Ink Settings], [Color Processing], [Color Balance] and [Uni-Directional Printing] can be
configured.
<TIPS>
. Depending on the settings you have made in the [Select Ink:] option or the like, setup items that appear on the screen vary.
. The rollover help is displayed in the square portion at the bottom of dialog box. Place the mouse pointer over it to browse
the help feature.

. For the detailed description of setup items, refer to each chapter mentioned below.

Brother GTX-4 Advanced menu &J

White Ink Settings

B oreen (0,199,0)

Custom
Minimum Whiteness : ‘@ Mormal _) Spedial
1 2
D 1
01 2 3 45 6 7 8 9 10
Choke Width : 2
Color Processing
a 10 20 30 40
Saturation : D 5
Brightness : D 5
Contrast : D 5
Color Balance
54 -3-2-10 12 3 4 5
Cyan : D 0
Magenta : D 0
Yellow : D 0
Black : D 0
[ Uni-Directional Printing
OK ] I Cancel

(3) After your settings are completed, click [OK].
<TIPS>

. You can refer to each value you have set up here by opening an ARX4 file from the "GTX-4 File Viewer".
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5-3-1.

Select the platen size

Creating print data

>

From the pull-down menu of [Platen Size:], select a platen size for print area.

<TIPS>

. The platen size is equivalent to the paper size.

Setup item Platen to be used Size
[16X21] 16X21 platen 16.0in.x21.0in. (406.4 mm x 533.4 mm)
[16X18] 16X18 platen 16.0in. x 18.0in. (406.4 mm x 457.2 mm)
[14X16] 14X16 platen 14.0in. x 16.0in. (355.6 mm x 406.4 mm)
[10X12] 10X12 platen 10.0in.x 12.0in. (254.0 mm x 304.8 mm)
[7X8] 7X8 platen 7.0in.x8.0in. (177.8 mm x 203.2 mm)
rr.,_,-n Printing Preferences ﬂ‘
Main Setting
Machine Mode : [GTX—422 ']
Platen Size :
Select Ink :
Mode :
Resolution :
White Ink Settings : 1 3 5 7 9 4
Highlight : |] ]T
1 2 3 4 5
Mask : D 3
Print Time : IT Whiteness : lm
[7]2 Layer White 0 10 20 40 5 B0
erval [sec.) 20
[] White/Color Pause
erval [sec.) 2
[] Use background black color ffor black T-shirts only)
[] Color Muttiple Pass Printing
Platen Size :
Select the size of the platen used for print.
16x21 (406.4x533.4mm)
16x18 (406.4¢457 2mm)
14x16 (355.6x406.4mm) “standard
10¢12 (254.0304.8mm)
78 (177.8203.2mm)
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5-3-2. Select the ink type

>

From the [Select Ink:] option, select a combination of inks to be used.

Setup item Description
[Color+White Ink] This option enables a color image to be printed out on the mask layer of white ink.
[White Ink Only] This option enables the white ink only to be used for printing out a monochrome image.

[Color Ink Only]

This option enables a color image to be printed out on a white background or lighter and
pale color background.

[Black Ink Only]

This option enables the black ink only to be used for printing out monochrome image.

G N
= Printing Preferences Iﬂ
Paper/Quality | Main Setting
Machine Mode : [GTX422 ']
Platen Size : (14016 v [ Advanced |
St k-
- SN Color+White Ink _
White Ink Only
Mode : Color Ink Only
Black Ink Only
Resolution : @ 1200dpi x 1200dpi
White Ink Settings : 1 3 5 7 9 1
Highlight : U 5
1 2 3 4 5
Mask : [} 3
Print Time : | x1 Whiteness : | 400 %
[ 2 Layer White 0 3 40 i 3
Interval (¢ .
[] White/Color Pause 0 0 20 30 40 50) &0
al (se 20
[] Use background black color ffor black T-shirts only)
[T] Color Muttiple Pass Printing
Select Ink :
Selects ink combination.
Color+White Ink : Prints colorimages on White ink mask.
[White Ink Only : Prints monochrome images with only white ink.
Color Ink Only : Prints only colorimages on white or light color materials.
Black Ink Only : Prints monochrome images with only black ink.
o
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5-3-3. Select the mode

Creating print data

>

If you set [Mode:] to [Eco-Mode], the white ink volume serving as the background is automatically adjusted to reduce the

overall ink consumption.
<TIPS>

° The luminance on the finished print may be slightly reduced depending on the color.

=
= Printing Preferences

Paper/Quality | Main Setting

Machine Mode - [GTx422 -
Platen Size : (148 ] [ Advanced
Select Ink : [Color+Whie Ink v

Resolution : @ 1200dpi x 1200dpi
White Ink Settings : 1 3 5 7 9 1 9
Highlight - D 5
1 2 3 4 5
Mask - i 3

Print Time : I x1 Whiteness : | 400 %
[ 2 Layer White 10 20 3 40 A0 B
Interval [sec.): * F 0
[] White/Color Pause [ 10 20 30 40 50 [
Interval [ses 0
[] Use background black color ffor black T-shirts only)
[ Color Multiple Pass Printing

[Mode
fjust the amount of the base layer white ink automatically to reduce ink consumption
|

|
Qgeml 3

[However, the level of brightness of the end result may be decreased slightly depending on
the color.
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5-3-4. Set up the white ink

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], the setup items for [White Ink Settings:] will
appear.

Adjust the white ink volume separately in the [Highlight:] (visible white ink volume) and in the [Mask:] (white ink volume to
cover the background color).

Also, set the white ink time in the [2 Layer White] and [White/Color Pause].

e N
= Printing Preferences g
Paper/Quality | Main Setting
Machine Mode : [GTx422 -]
Platen Size : (148 v) [ Advanced |
Select Ink : [Color+Whie Ink v
Mode : @ Normal () Eco-Mode
Resolution : @ 1200dpi x 1200dpi

White Ink Settings :
Highlight :

Mask :

Print Time : | x1 Whiteness : | 400 %
1 ] 3 5 B

[ 2 Layer White 0

Interval [sec

40 [

[T] White/Color Pause

Interval [se

|| Use background black color ffor black T-shirts only)

[ Color Multiple Pass Printing

[White Ink Settings :
[You can set "Highlight" and "Mask" when "Color+White Ink" or "White Ink Only" is
selected.
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Highlight

This enables you to select whiteness (thickness) of RGB=254 in such nine levels as [1] to [9]. When you increase this
value, the White ink volume will increase.

>

Highlight setpoints

Ink volume

(1]

White ink volume 200%

[2]

White ink volume 250%

[3]

White ink volume 300%

[4]

White ink volume 350%

[5]

White ink volume 400%

[6]

White ink volume 450%

[7]

White ink volume 500%

[8]

White ink volume 550%

El

White ink volume 600%

<TIPS>

. Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an

appropriate highlight setting value before creating print data. Perform a highlight check pattern print and select an appropriate

setting value by referring to "5-4-6. Print out of highlight check pattern >>P.104".

o Depending on the settings of [Highlight:] and [Color Multiple Pass Printing], the [Print Time:] and [Whiteness:] will change

accordingly.

. [Print Time:] will be set to [X1] if the setup value of [Highlight:] is [5] and [Color Multiple Pass Printing] is turned OFF. With this [X1]
serving as a reference value, how many times relates to how long the print time will take when printing.

. Actual ink consumption depends on the actual colors used in the original image. As such, use this number as a reference for ink

consumption.

Mask

This enables you to select the volume of white ink which is used as background color for color inks in such five levels as

[1] to [5].

Setup value Description

[1lor[2] These setup values are suitable for such lighter and pale background colors as pale pink,
ash and cream.

[3] This is the default value.
This value will reproduce the most smooth white-gray-black gradation.

[4] This value is suitable for vivid background color, e.g. red, purple, green, etc. It also covers
the strong background colors.

[5] This value enables the printing with the largest amount of white ink under all colors except
darker color areas.

2 Layer White

You can make highlight settings at a level of [1] to [13] when 2 Layer White is enabled.
Set the time from the start of printing the first white ink layer to the start of printing the second white ink layer.
If you set a time shorter than the time it takes to print the first layer, the additional waiting time will be set to 0 seconds.

<TIPS>

. This setting menu will be enabled only if you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:] settings.
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White / Color Pause

Set the time from the start of printing the previous white ink layer to the start of printing the color ink layer.

If you set a time shorter than the time it takes to print the previous white ink layer, the additional waiting time will be set to
0 seconds.

<TIPS>

. This setting menu will be enabled only if you have selected [Color+White Ink] in the [Select Ink:] settings.

o Check this checkbox to activate it when you print a tiny image.

. Tiny images may become black when printed. When that occurs, print a white layer first and wait for a while (waiting time), to
print the color layers.

5-3-5. Specify whether or not to use the background black color

If you have selected [Color+White Ink] in the [Select Ink:], the setup items of [Use background black color (for black
T-shirts only)] will appear.

In the event that you wish to print a black T-shirt making use of the T-shirt's background black color, mark the [Use
background black color (for black T-shirts only)] checkbox.

,

= Printing Preferences léj
Paper/Quality | Main Setting
Machine Mode : [GTX422 ']
Platen Size : [1&(16 '] [ Advanced
Select Ink : [Color+Whie Ink v
Mode - @ Normal ") Eco-Mode
Resolution : (@ 1200dpi x 1200dpi
White Ink Settings : 1 3 5 7 9
Highlight - D 5
1 2 3 4 5
Mask : U 3

Print Time : | x1 Whiteness : | 400 %

[ 2 Layer White
s fie

[] White/Color Pause

olor Muftiple Pass Pnnting

Use background black color :

[Tum ON this item when printing an image on black material with its black color used.
Black (RGB = 0) is automatically transparent.

[Tum OFF this item when you select some transparent color in advanced menu.
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5-3-6. Specify whether or not to perform Multiple Pass Printing
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>

If you have selected one of the [Color+White Ink], [Color Ink Only] or [Black Ink Only] in the [Select Ink:], the setup items
for [Color Multiple Pass Printing] will appear.
In cases where small and horizontal stripes are highly noticeable in the print result, mark the [Color Multiple Pass

Printing] checkbox.
<TIPS>

print time, refer to [Print Time:].

Even if the [Color Multiple Pass Printing] checkbox is marked, the amount of inks to be consumed will remain unchanged.
When the [Color Multiple Pass Printing] checkbox is marked, it takes a longer time for the print time to be completed. For typical

,

r@: Printing Preferences

S5

Paper/Quality | Main Setting

Machine Mode : [GTX422 ']
Platen Size : (14016 v [ Advanced |
Select Ink : [Color+Whie Ink -]
Mode - @ Normal ") Eco-Mode
Resolution : (@ 1200dpi x 1200dpi
White Ink Settings : 1 3 5 7 9
Highlight : U 5
1 2 3 4 5
Mask : [} 3
Print Time : | x2 Whiteness : | 400 %
[ 2 Layer White 4 ]
f (26 L
["] White/Color Pause 0 2 a0 40 0 B0
(58 [
for black T-shirts only)
Color Muttiple Pass Printing :
Color Muttiple Pass printing. for color print data, increases the number of platen line feeds to
produce finer ink dots. It takes longer to print but enables better color printing.
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5-3-7. Set up the color ink

If you have selected [Color Ink Only] or [Black Ink Only] in the [Select Ink:], the setup items of [Color Ink Settings:] will
appear.
In the [Color Ink Settings:] window, you can make your setting from the [Ink Volume:] or [Double Printing:] option.

= N
= Printing Preferences léj
Paper/Quality | Main Setting
Machine Mode : [GTX422 ']
Platen Size : (14016 v] [ Advanced
Select Ink : Color Ink Only L
Mode : @) Nomal Eco-Mode
Resolution : (@ 1200dpi x 1200dpi

Color Ink Settings :

Ink Volume :

Double Printing :

[¥] Color Multiple Pass Printing

Color Ink Settings :
Enables you to set "Ink Volume" and "Double Printing" when "Color Ink Only" or "Black Ink
Only" is selected.

Ink volume

This enables you to select the ink volume in such ten levels as [1] to [10].

Setup value Description
[10] This is the default value.
This value corresponds to 100%-cotton fabrics as well as for blended yarn fabrics (hemp
50%/polyester 50% or cotton 50%/polyester 50%).

[9]to [7] These values correspond to a thinner T-shirt, thick towel, and cotton products woven with
twill fabrics.

[6] to [4] These values correspond to thin and plain fabrics as well as for blended yarn fabrics that
consist of cotton, polyester and polyurethane.

[3]to [1] These values correspond to polyester jerseys and synthetic fabrics that have no water
absorbency.

<TIPS>

° When you print other clothes than a thick T-shirt, check on the actual blurring first, then adjust a value in the [Ink Volume:] option.
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Double Printing

Performing the print cycle two times separately will make the printed color stand out more.

>

Setup value Description

[0] No separate processes

[1] Separate processes (wait time between the 1st and 2nd print cycle)

[2] Separate processes (longer wait time than the case with setting [1] between the 1st and
2nd print cycle)

[3] Separate processes (longer wait time than the case with setting [2] between the 1st and
2nd print cycle)

<TIPS>

. For the options [1] to [3], the platen will reciprocate two times.
o The higher the setpoint is, the longer the print time will be.

5-3-8. Set up the white ink

If you have selected [Color+White Ink] or [White Ink Only] in the [Select Ink:], this setting menu will be enabled.
When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [White Ink Settings]
appear.

In the [White Ink Settings], you can make settings for [Transparent Color:], [Tolerance:], [Minimum Whiteness :],and
[Choke Width:].

r N
Brother GTX-4 Advanced menu @

Il qreen (0,199,0) Custom...

4

Minimum Whiteness : @ Normal

[¥]

kL

U

0012
Choke Width : D

3 456 7 8 9 10

B ]

Color Processing

0o 10 20 30 40
Saturation : U 5
Brightness : D 5
Contrast : D 5

Color Balance
54 -3-2-10 12 3 45

Cyan: D [T
Magenta : D [T
Yellow : 0 [0
Black 0 [0

[] Uni-Directional Printing

[Transparent Color :

Selecting a color to make it transparent, RGB=255 white is always transparent. Turning this feature
ON allows you to select another color in the image and make it transparent, you can input RGB
values for custom transparent color. Itis recommended that the [Use background black color]
function is turned OFF to produce better colors.

 —

[ Cancel ]
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Transparent color

With this option, specify a color which is treated as a transparent color without using any color during the printing
process. If you want to specify other colors excluding the RGB=255 as "Transparent color", perform the following
procedures to make your setting.

<TIPS>

o The RGB=255 is treated as a "Transparent color" (non-printing color).

o You would be better off making [Use background black color (for black T-shirts only)] OFF to produce better colors.

(1) Click the [Transparent Color:] checkbox.
Then, the pull-down menu for color selection becomes active.

(2) In the pull-down menu, select a color which serves as a background color of T-shirt, or click on the [Custom...] to

specify a RGB value.

<TIPS>

e  This custom color you have specified is valid only for one color which is specified immediately before. This color cannot be
saved in the list.

-
Brother GTX-4 Advanced menu @} Color m
White Ink Settings L Basic colors:
Transparent Color : B green (0,199,0) |= ET EEFEEBR
=TT N
Tolerance : ue £, 108, 30
I oyal blue (30,0,255) . ' . . . . . .
Minimum Whiteness : I purple (118,0,235) . . . . - . . .
[ yellow (255,255,0)
1 goid (255, 174,0) EEEEEEEN
I orange (255, 108,0) ! E | A 0 B Bl Ol
I red (255,0,0) = N W
I pink (255,0,150)
idth : o Custom colors:
Chokedth B Geep red (255,0,102) 2 =
ot Procec I aro0n (109,0,62) e
s [ pale orange (255,221,154)
) [ sand (204,196,171) .. -
Saturation : [ Jight green (36,255,0) — 5 -
N I elly green (0,154,70) ,T | Defing Custom Colors >> ]
ngniness : I olive (117,115,51) Cancel
Contrast : CJlime (213,255,44) s
I 2quamarine (0,126,82)
—— I <pruce (0,98,110)
. [ aquatic blue (36,213,255)
I steel blue (117,145,174)
Cyan: B lavender (174,111,255) 0
Magenta : light brown (1&];3, 148,120) e 0
Yellow : B 0
Black : [ 0
[~ Uni-Directional Printing
[Transparent Color :
Selecting a color to make it transparent, RGB=255 white is always transparent. Turning this feature
ON allows you to select another color in the image and make it transparent, you can input RGB
wvalues for custom transparent color, It is recommended that the [Use background black color]
function is turned OFF to produce better colors.
[ o ] [ cancel |

Tolerance
Specify the gradation range (RGB values) to smoothly connect the zone between "Unprinted color" and "Printed color"
to be gradually changed in tone.

<TIPS>
. If this value is increased, the gradation range in which the mask white is generated from a state in which no mask white exists will

increase.
o The gradation's image quality depends on image data. For this reason, it is advisable to perform a test printing beforehand.
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Minimum white ink volume

When printing with [Color+White Ink], the volume of background white color ink for dark or black color ink can be
controlled.

When printing with [Color+White Ink], you can increase the amount of the white ink volume used as the base in a dark
area by specifying a larger value.

Selecting [Special] allows you to select a value of [3] or higher.

<TIPS>

. Larger the value, the more likely that blurring occurs.

White Ink Choke Width

This enables you to select the white ink choke width in such ten levels as [1] to [10]. When you increase this value, the

choke width increases. By decreasing the print range of white ink, the white ink will be prevented from extending off from

under the color inks.

<TIPS>

. Check the original image if white lines and/or dots are seen around the image, this may be caused by "Anti-alias" bitmap.

. There are instances in which fine lines (characters or photographs) will disappear if this level is increased. For this reason, it is
advisable to perform a test printing beforehand.
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5-3-9. Set up the image quality

Creating print data >

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Processing] appear.
In the [Color Processing] option, you can make settings for [Saturation:], [Brightness:] and [Contrast:].
Make adjustments to increase vividness, brightness and clarity of an image without using any functions of application

software.
Setup item Description
[Saturation:] The more vivid the color is, the higher its value.
[Brightness:] The brighter the color is, the higher its value.
[Contrast:] Contrast makes the image lighter for lighter colors and darker for darker colors if its value
increases.
<TIPS>

. If a value of [Contrast:] is increased, there may be some cases in which fine lines will disappear.

. For this reason, it is advisable to perform a test printing beforehand when you specify a higher value.

S

-
Brother GTX-4 Advanced menu
White Ink Settings
Il qreen (0,199,0) Custom...
)
Minimum Whiteness : @ Normal Spedial
1 o
[} -
0 12 3 45 6 7 8 9 10
Choke Width : [ 2
Color Processing
a 40
Saturation : 5
Brightness : 5

Contrast : [] 5

Color Balance

Hed e dl Bl AdoE o B

Cyan : [ [T
Magenta : (i [T
Yellow : 0 [0
Black : 0 [0

[] Uni-Directional Printing

Saturation :
Saturation increases the color brightness. Use for grayish and colorless images, artwork created in
CMYK color mode, scanned data, etc.

[ OK ] [ Cancel
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5-3-10. Set up the color balance

>

When you click on the [Advanced] in the [Printing Preferences] dialog box, the setup items of [Color Balance] appear.
In the [Color Balance], you can make settings for [Cyan:], [Magenta:], [Yellow:], and [Black:].

You can adjust the color in 11 gradations, -5 to +5.

<TIPS>

. If you select [Black Ink Only] for ink selection, you can adjust [Black:] only.

Setup item Description

[Cyan] Adjust the cyan ink volume.
If you increase its value, the color becomes light bluish overall. If you decrease its value,
the color becomes reddish overall.

[Magenta:] Adjust the magenta ink volume.
If you increase its value, the color becomes reddish-purple overall. If you decrease its
value, the color becomes greenish overall.

[Yellow:] Adjust the yellow ink volume.
If you increase its value, the color becomes yellowish overall. If you decrease its value,
the color becomes bluish overall.

[Black:] Adjust the black ink volume.
If you increase its value, the color becomes blackish overall. If you decrease its value, the
color becomes whitish overall.

r N
Brother GTX-4 Advanced menu lg
White Ink Settings
Il qreen (0,199,0) Custom...
]
Minimum Whiteness : @) Normal () Spedial
1 o
b [
01 E 3 456 7 8 9 10
Choke Width : U 2
Color Processing
0o 10 20 30 40
Saturation : U 5
Brightness : D 5
Contrast : D 5

Color Balance
54 -3-2-10 12 3 45

Cyan : D

Magenta : D
Yellow : D
Black : D

T

[] Uni-Directional Printing

Cyan:

\Adjust the cyan ink volume.

If you increase its value, the color becomes light bluish overall.
If you decrease its value, the color becomes reddish overall.

[ OK ] [ Cancel
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5-3-11.

Specify the print direction

Creating print data

>

When you click on the [Advanced] in the [Printing Preferences] dialog box, you can make the settings for [Uni-Directional

Printing].

<TIPS>

What you have specified on the printer's operation panel are prioritized, and this option becomes active only when the print

direction specified on the printer side is set to [Auto].

Print time will be doubled.

-
Brother GTX-4 Advanced menu

White Ink Settings

M oreen (0,199,0)

Custom...

Minimum Whiteness : @ Normal () Spedial

0

0123 456789 10

¥]

M [

Choke Width : U
Color Processing
0o 1 20 30 40
Saturation : U 5
Brightness : D 5
Contrast : D 5

Color Balance
54-3-2-10 12 3 4 5

Cyan: D

Magenta : D
Yellow : D
Black : D

[ uni-Directional Printing

T

Uni-Directional Printing :

Makes the print uni-directional.

The value of Print Direction set by the Panel has priority. This is available only if [Auto] is selected
In Print Direction through the Control Panel.

(]
~
J

Cancel
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5-4. How to use Useful Tools

Useful tools and print data are provided for adjusting colors or searching for an appropriate print setting.
The "Useful Tools" will be installed onto the subdirectory under the "Brother GTX-4 Tools" of your PC.
For the details of each tool, please refer to the chapters described later.

5-4-1. Color palette for Adobe Photoshop, Photoshop Elements, lllustrator and CoreIDRAW

The different color palettes are available for each software application as follows:
e "GT _Colors_T.ase" for Adobe Photoshop/Photoshop Elements/lllustrator
e "GT_Colors.xml"and "GT_Tshirts.xml" for CoreDRAW
<TIPS>
. When using the printer driver by default, use one of them as a color sample to check color reproduction and create/edit the
image data. (Because CorelDRAW cannot contain identical color in the same palette, the color palette is divided into two files.)

(1) From the "Useful Tools", click a required file, and follow the on-screen instructions to save the file on your PC.
(2) To use a color palette for each application, refer to the applicable page(s) to each application in "5-2. Creating print

data from other applications >>P.63", or see the Help menu of each application.

5-4-2. Action file for Photoshop

For Photoshop, an action file is made available, which changes RGB=255 to RGB=254.
(1) From the "Useful Tools", click "SolidWhite.atn", and follow the on-screen instructions to save the file on your PC.
(2) Inthe menu bar of Photoshop, select [Window] > [Action file].

(3) Clickonthe W == to open the submenu.

(4) From the [Load Actions], select "SolidWhite.atn" saved on your PC.
<TIPS>
. For information on using action files, refer to the Help feature that Photoshop is provided with.
. "SolidWhite.atn" can be used only when the [Color mode] is set to [8 bit] of [RGB Color].
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5-4-3. Color sample

The PDF file is provided that can be used as a Color sample.

Please use this color chart as a color sample like the one that is commonly provided by an ink maker, for the print data
(ARX4 file) you created using your desired printer driver setting.

<TIPS>

. Make use of this color chart when you perform the printing after changing the settings of the printer driver.
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Brother GT Garment Prmter T-shirt Transparent Colors

(1) From the "Useful Tools", click a required file name to download the data. The following files are provided as color

samples.
e  GT_Blues.pdf
e  GT_Greens.pdf
e  GT_Oranges.pdf
e  GT_Reds.pdf
e  GT_ColorChart.pdf

(2) Configure the printer driver and create print data.
<TIPS>
. For details of the printer driver's setting procedures, refer to "5-3. Set up the printer driver >>P.84".
. For details of how to create print data, please refer to the descriptions of respective applications contained in "5-2. Creating
print data from other applications >>P.63".

(3) Send the created print data to the printer and perform printing.
<TIPS>
. Check the print result and adjust the printer driver's settings.
. For the print procedure details, refer to "6. Basic printing procedures >>P.107".
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5-4-4. Printing a grid pattern onto platen sheet

You can print a grid pattern onto a new platen sheet.

Platen sheet Grid

/

Platen
X0163

(1) From the "Useful Tools", open such an ARX4 file (for example, Grid14x16.arx4) that has a grid size suitable to the
platen size.
(2) Send the print data of grid pattern to the printer.

(3) Without putting a T-shirt in place, print the grid pattern directly onto the platen sheet.

<TIPS>
. After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink.
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5-4-5. Printing ink volume

This is one of the print data for selecting ideal setting for [Ink Volume:] of the printer driver.

Download the data from "Useful Tools" and print the ink volume for checking the blurring beforehand.

<TIPS>

. For the print procedure details, refer to "6. Basic printing procedures >>P.107".

. Appropriate ink volume setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an
appropriate ink volume setting value before creating print data.

. There are four types of ink volume printing data. Select the ink volume print data to match the [Double Printing:] setting for the
printer driver.

(1) Select the desired file from "Ink Volume SinglePrint.arx4", "Ink Volume DoublePrint1.arx4", "Ink Volume
DoublePrint2.arx4", and "Ink Volume DoublePrint3.arx4" from the "Useful Tools" to download data.
(2) Send the data to the printer and perform printing.

(3) Check the print result and adjust the value for [Ink Volume:] of the printer driver.

9 D:\Program Files (x86)\Brother\GTX-4 Taols\Ink Volume SinglePrint.ancd BN
Machine Mode GTX422 <70 0 70
0 g
N 1111 11110
ome e 1735 | it e e o
Platen Size 14015
Resokuion 1200dpi x 1200pi
[
Select Ink Color Ik Oy
Color Ik Volume - 10
Double Prnting - (]
Color Mutple Pass Printing .~ OF 1
= o e ——
Color Ink 04lec took - 6002
ot 1 piece
Send to Printer
Browse... | Cose |
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5-4-6. Print out of highlight check pattern

This is one of the print data files for selecting the ideal setting for [Highlight:] of the printer driver.

Download the data from "Useful Tools" and print the highlight check pattern for checking whiteness, background hiding

level, and blurring beforehand.

<TIPS>

. Please print on a pretreated T-shirt. For the print procedure details, refer to "6. Basic printing procedures >>P.107".

. Appropriate highlight setting value depends on color or material of the T-shirt. It is recommended to consider and decide on an
appropriate highlight setting value before creating print data.

(1) From the "Useful Tools", click "Highlight-Mask Check at MW1.zip" or "Highlight-Mask Check at MW2.zip" to

download data.

<TIPS>

. The file you should select differs depending on whether "Minimum Whiteness:" is set to [1] or [2].
. Check the number at the end of the file name before downloading the file.

(2) Unzip the file and the following print data will be displayed.
e  "HighlightCheckPattern"
e  "MaskCheckPattern" at each highlight

(3) Print "HighlightCheckPattern" and select the optimum highlight setting.
(4) Print "MaskCheckPattern" for the optimum highlight setting and select the optimum mask setting.
(5) Check the print result and adjust the values for [Highlight:] and [Mask:] of the printer driver.

- ey
& DAUsers\john\AppData\Local\Temp\Temp1._Highlight-Mask Check at MWL zip\Highlight-Mask C.. i sl e
Machine Mode GTX-422 -70 0 jﬂ
-80
Job Name Highlight Chack MW1
Date 09/D4/72018 1705
Platen Size 14x16
Resoluion 1200 x 1200dpi
Select Ink : Color+White Ink
Highlight 1 o
Mask : 3
Prirt Time xl
Whiteness 200%
Use background black color - OFf
Color Mukigle Fass Priting:  OF

[ Detaie.. | gy
Color Ink 064ce 100% [} 600N
Whits Ink 1066cc
Print 1 piece
Present Layer [ Total w | [ White Data
| Sendto Priter | :

Background Color _ Change...
4
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5-4-7. Data for confirming firing timing

This print data is used to confirm that the firing timing is appropriate.
(1) From the "Useful Tools", click "FIRING CHK COLOR.arx4" or "FIRING CHK WHITE.arx4" to download data.
(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the firing timing has been set correctly.

54 DA\Program Files (x86)\BrothenGTX-4 Tools\FIRING CHK COLOR.ané = liE e
Machine Mode GTX422 70 0 70
S0 N .
Job Name - FIRING CHK COLOR - R G- =
] .
Date 19/17/2015 00.05
Ploten Size : 14016
Resolution 1200dpi x 1200dpi
(] =
Select nkc - Color nk Orly
Color Ik Vokume - 10
Double Printing - ]
Color Muiple Pass Porting -~ OF
| Dee B ;
Color ink D08cc 00% [} 600%
Print 1 piece
_Bowe.. |

5-4-8. Data for confirming platen-rolling adjustment

This print data is used to confirm that the platen-rolling adjustment is appropriate.
(1) From the "Useful Tools", click "FEEDING PATTERN(1).arx4" to download data.
(2) Send the data to the printer and perform printing.

(3) Check the print result to make sure the platen-rolling adjustment has been set correctly.

547 DAProgram Files (x86)\BrothenGTX-4 Tools\FEEDING PATTERN(1).arxd ==
Machine Mode GTX422 70 0 70
20— » 1
et FEEDING PATTERN(T) | o7 arridoe Adjusting Pattern -
Fip
Date : 12/1372015 18:52
- aa |m 444444444444
Platen Size : 1416
Resolution 1200dpi x 1200dpi
0 =
Select Ink - Color Ink Only
Color Ink Valume - 10
Double Printing - (]
Color Muitiple Pass Printing Off
| peai. | B0~ ;
Color ik ; 003ce 100% [ 600
Print 1 piece
_Bowee..|
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5-4-9. Data for confirming White/Color alignment

Creating print data

>

This print data is used to confirm the alignment of the print position on the white side with the print position on the color

side.
(1)
()
@)

From the "Useful Tools", click "ALIGN CHK.arx4" to download data.

Send the data to the printer and perform printing.

Check the print result to make sure the print position on the white side has been aligned with the print position on

the color side correctly.

54 DA\Program Files (x86]\Brothen\GTX-4 Tools\ALIGN CHK.arxé [E=ESE
Machine Mode GTX422 70 0 70
40
Job Name ALIGN CHK
Date - D4A19/2017 16:31
Platen Size : 1416
Resolution 1200dpi x 1200dpi
Select Ik - Color+White Ink
Highiight - 1 4
Mask 3
Print Time: x1
Whiteness : 200%
Use background black color - OfF
Color Multiple Psss Prrting - OFF
Detais_. | 80—
Color Ink : 0.00ce 100% [} 600"
White Inkc DE5cc
Print 1plece
e Fresert Layer 1 W+CMYK | [ White Data
Send to Prter |
— — Background Color _ | change.. |
[ Bome. | [ Oom | o
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AWARNING

0 If a foreign object gets inside the printer, immediately turn off the power, disconnect the power cord, and
2 contact the place of purchase or a qualified technician. If you continue to use the printer while there is a

foreign object inside, it may result in fire or electric shocks or problems with correct operation.

Do not allow the printer to come into contact with liquids. Otherwise it may cause fire or electric shocks or
problems with correct operation.
If any liquid gets inside the printer, immediately turn off the power, disconnect the power cord, and contact

the place of purchase or a qualified technician.

® Do not use the printer when smoke or a bad odor is coming from the printer. Otherwise it may cause fire or
f electric shocks or problems with correct operation. Immediately turn off the power, disconnect the power

cord, and contact the place of purchase or a qualified technician.

Keep your finger or any body part away from the rotating fan. Otherwise it will be caught up, which results in
injuries.
Turn off the power when you approach the fan.
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>

ACAUTION

Q0 P @Po

e &

This printer should only be used by operators who are appropriately trained in its safe operation.

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand
may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may
touch against moving parts and this may result in injury.

Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation.
In case of contact with eyes, do not rub but immediately rinse the eyes with water.

Do not disassemble the ink cartridge.

Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They
may cause diarrhea or vomiting.

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution,
pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately
rinse the eyes with water.

Keep the liquids out of the reach of children.

When the pretreatment is applied to printed objects (like a T-shirt) with a spray or pretreatment applicator,
sprayed mist is generated. So wear a pair of plastic gloves, a mask and protective glasses (or goggles)
designed to shield against liquid splash, and fully take care of the air ventilation when you are working with it.

When a problem occurs with the operation of the printer, contact the place of purchase or a qualified
technician.

(1) mPorTANT

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
hit and damaged.
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6-1. Basic printing process flow

What are described below are the basic work flows before the start and after the completion of print process.

Tasks to be performed
before starting print
operation

Pretreatment for print
medium

Platen adjustment

Placing print medium
in position

Sending/Loading
Print data

Removing printed
matter
from platen

Fixation of ink

Before starting printing, perform check and preparation tasks on the printer.
Refer to "6-2. Tasks to be performed before starting print operation >>P.110".

To fixate the white ink onto a T-shirt, apply the pretreatment to it beforehand.
If you are not using white ink, you do not need to pretreat print medium.
Refer to "6-3. Pretreating process for print medium >>P.115".

Replace the currently used platen with another one that suits the print medium.
After the platen replacement is completed, adjust the platen's height.
Refer to "6-4. Platen adjustment >>P.128".

Put a print medium on the platen.
Refer to "6-5. Placing print medium in position >>P.142".

Send or load print data to the printer.
Refer to "6-6. Sending/Loading Print Data >>P.145".

Start the print operation.
Refer to "6-7. Executing a printing job >>P.155".

Remove the print medium from the platen.
Refer to "6-8. Removing printed matter from platen >>P.158".

Fixate the ink onto the print medium.
Refer to "6-9. Fixation of ink >>P.159".
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6-2. Tasks to be performed before starting print operation

6-2-1. Confirmation and disposal of waste ink

Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or higher
level, discard the ink.

(1) Check on the waste ink tank, and discard the waste ink.
In an area under the other end of the waste ink tube (when removed) from the waste ink tank, place a receiving tray or the like so
that the waste ink spilled from the tube will not be discharged onto the floor, etc.
<NOTE>

. Dispose of the waste ink properly as water-based waste fluid in accordance with applicable laws and ordinances.

Waste ink tank

-

I

X0045
Waste ink tank
9
Waste ink tube
Receiving tray
X0046

(2) Return the waste ink tank to its original state, and insert the waste ink tube into the tank.
<IMPORTANT>
3 The waste ink tube contained in the waste ink tank should be cut down to around 1.57 to 1.97 in. (4 to 5 cm) so that it can fit
into the tank. If the tip of the waste ink tube is immersed in the liquid, it will prevent the smooth flow of the waste ink, to
disable the ink suction operation of the head cleaning function.
3 Avoid placing the waste ink tube horizontally as much as possible, and be sure not to let it bend.
Otherwise the waste ink may have difficulty flowing through the tube.
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6-2-2. Confirmation and replenishment of cleaning solution

Check to see if the amount of cleaning solution is kept at a proper liquid level in the cleaning liquid tank, and refill the

tank with the solution when its amount is below the proper level.

<TIPS>

. Also, refill the tank with the solution when a warning message appears on the operation panel screen or in the warning message
window when the cleaning liquid tank is not pulled out.

(1) Pull out the cleaning liquid tank from the side of the printer.

(2) Openits lid and refill it with the cleaning solution up to the "FULL" line.
<IMPORTANT>
. Be sure not to put the cleaning solution into the tank above the "FULL" line.

Cleaning solution

Cleaning liquid tank

X0044

(3) Close the lid and slowly place the cleaning liquid tank into the printer.
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6-2-3. Daily agitation of the white ink

Perform the procedures shown below if a white ink cartridge stirring message is displayed before starting operation.

% Maintenance

Remove the White Ink Cartridoe
and shake it

After shaking the White Ink
Press OK

(1) Take out the white ink cartridge from the printer.
<CAUTION>

3 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

( N\

L
A

W12 W34
-

White Ink Cartridge

X0039

(2) Shake the cartridge 100 times side by side to stir the white ink.

<IMPORTANT>

. The white ink cartridge should be held horizontally when shaking it.

. Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch.

<NOTE>

e  Wear the provided gloves when performing this task.

3 When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the
edge of the ink pouch slightly winded, to make the ink easier to stir.

Edge of the rib
White Ink Cartridge geoftherb~ =~

Ink pouch \//

Remaining ink volume should
be approx. 5.9 in. (15 cm)
Shake 100 times (for approx. 50 seconds) X0194
(Swing distance should be approx. 2 in. (5 cm).

Increase the swing distance when the

remaining ink level becomes low.)
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(3) Open the lid of the cartridge and place the ink pouch in its correct position.

<IMPORTANT>

. Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow
into the wound section of the pouch when stirred, which can cause improper winding of the pouch.

3 When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge
downward and open the lid.

. When setting the ink pouch, avoid unevenness or wrinkles on the pouch.

e  When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

<NOTE>

3 If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid.

Cartridge Lid

X0182

X0078

Not sagged

X0142
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(4) Close the lid, and put the white ink cartridge in position inside the printer.
<IMPORTANT>
e W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause the
printer malfunction.
. When setting the cartridge, do not shake the cartridge with the ink pouch facing down with the aim of facilitating the winding
of the pouch. Doing so will cause wrinkles, and the proper winding of the ink pouch will not be possible.

X0283

(5) Repeat the same process to shake the other white ink cartridge to stir up the ink.

(6) On the operation panel, press @

Then, the white ink refilling will be performed automatically.
The following screen will be displayed without white ink refilling in the case of insufficient agitation.

After performing steps (1) to (5), press @ again.
%X Maintenance
Remove the White Ink Cartridoe
and shake it
(over 60 seconds)

After shaking the White Ink
Press OK

(7) When you are finished replacing the white ink, press @ in the operation panel to print the nozzle check

pattern.
% Maintenance
Perform test print (White/Color)
and check head firing
Press OK
<TIPS>

. For details, refer to "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.192".
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>

6-3. Pretreating process for print medium

To fixate the white ink onto the surface of fabric of a T-shirt, apply the pretreatment to it beforehand. If you are not using
white ink, you do not need to pretreat print medium.

Workflow of pretreating process

Step ltem

Detailed description

1 Dilution of pretreatment

Put the pretreatment into a polypropylene container or the like, and dilute it with

pure water.

Application of diluted
pretreatment

By means of a spray or roller, apply the diluted pretreatment onto the print medium.

3 Fixation of pretreatment

Fixate the pretreatment by using the heat press to apply heat and pressure onto

the print medium.

6-3-1. Provisions for pretreatment

Items to be prepared

Two types of application means are available for the pretreatment—roller and spray.
With reference to the table below, make what you need available in advance.

o: What you need
A: Useful items, if any

—: Not required

Items to be prepared

For roller coating

For spray coating

Pretreatment

o

o

Pure water

(¢]

Pretreatment roller

Handle (handgrip of roller)

Tray

Agent-coating table

Weighing instrument

o
o
o
o

A
o

Spray

Heat press

Peel-off sheet

Silicone foam (of open-cell structure)

Adhesive roller

> > Do

>I>|>|lo|o|o

° Pretreatment

It is the white liquid that is needed for pretreating process for printing with white ink. If a print medium is not
coated with this agent, no color development of white ink takes place, and the whiteness becomes insufficient.
Also, no color will be produced from the color inks that are applied onto the white ink. In order to apply the

pretreatment onto a T-shirt, use a spray or roller, and use the heat press to fixate it.

<CAUTION>

3 Be sure to wear a pair of plastic gloves, a mask and protective glasses during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.

http://sds.brother.co.jp/sdsapp/index.html

° Pure water

It refers to distilled water, purified water, etc. which is used to dilute the pretreatment with it.
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Pretreatment roller (option)
This is used to apply the pretreatment onto a T-shirt. It is advisable to use such a handgrip for the roller that is
resistant to rust formation.

<NOTE>

Separately provide a tray (container for dilution), handle (handgrip for roller), agent-coating table and weighing instrument
for amount of coating.

Spray (commercially available item)

This is used to apply the pretreatment onto a T-shirt. Use a spray (preferably of an electrically-operated type)
that can emit fine spray. As compared with a roller, a spray allows for easy and even coating and reduces
non-uniform coating, while it requires a special space for using it.

In addition to a spray, a pretreatment application device (commercial product) is available that can apply the
pretreatment onto a T-shirt automatically. As required, make them available for use separately.

<CAUTION>

Fully take care of the air ventilation when you work on operation that generates mist such as spray application.

Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<IMPORTANT>

If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.
Otherwise, it may cause failure of print heads.

Heat press

It must deliver the performance through which the print range of the platen can to be covered and 180°C
(356°F) can be kept for 35 seconds or more. At a fixing stage of the pretreatment, be sure to use the heat press,
but not an oven, to smoothen the surface.

Peel-off sheet

When using the heat press, place this sheet on a T-shirt so that neither inks nor pretreatment can be attached to
the press surface of the heat press. As a peel-off sheet, use a silicone-coated paper or a fluororesin sheet.
There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used at the ink
fixation stage. There is a tendency to bring the print result to an almost bright finish if a fluororesin sheet is used
at the ink fixation stage.

Silicone foam (of open-cell structure)
It is the foamed mattress which is made of silicone that resists heat. When fixating the inks or pretreatment by

means of the heat press, use this foam to ventilate steam with ease.

Adhesive roller
Use these to remove lint from a T-shirt or debris from its surface.
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e  T-shirt (printing medium)
100%-cotton fabric or polyester blended yarn fabric (cotton 50% or more)

<TIPS>

. Although it is advisable to use a 100% cotton T-shirt, some textiles cannot necessarily guarantee good printing quality even
if they are made of 100% cotton or blended yarn. In particular, for a T-shirt made of new material, perform a printing test on
it beforehand.

. Some textiles may leave noticeable imprints of the pretreatment after it is fixated. In that case, wash them away with water.

3 Perform a printing test beforehand. Then, the following phenomena may occur:
- The textiles may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.
- A deep-colored polyester blended yarn fabric dissolves dye, which may cause the white ink to change to a slightly different
color.
- It is likely that a textile may become yellowish in color after the pretreatment is fixated.
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6-3-2. Dilution of pretreatment

Be sure to use the pretreatment after diluting it with pure water.

<CAUTION>

. Be sure to wear a pair of plastic gloves and protective glasses during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http:/sds.brother.co.jp/sdsapp/index.html

Dilution ratio

Use within the ratio range of x3 (Pretreatment:Pure water=1:2) (Volume ratio).

Dilution method

<TIPS>

o The figure below is based on the pretreatment (20 kg (44 Ib)). When using the pretreatment (5 kg (11 Ib)), remove the cap and
pour the agent into the container, and dilute it with pure water, referring to step (4) and the subsequent steps. Dilution ratio is the
same.

(1) Unpack the pretreatment container from the shipping carton by cutting off the perforated paper along the perforated

tear-off line to open the carton.

Pretreatment

X0079

(2) Remove the cap, and place the cap in position.

@/ Cock

‘QEE,Z:E:,; l A
Pretreatment =
\
Cap

X0080
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(3) Orient the pour spout of cock in the position as shown in the figure below.

Cock

Pretreatment

~

X0081

(4) Lean the entire shipping carton of pretreatment toward a container for dilution to pour the agent into the container,

and dilute it with pure water.

<IMPORTANT>

. Use with the dilution rate of x3 (Pretreatment:Pure water=1:2) (Volume ratio).

. Close the cap of the container for dilution, and shake it sufficiently to provide equal concentration.

Pure water

Pretreatment
NG

Container for dilution

e

X0082

(5) To provide safekeeping for the pretreatment, close the cock, place the pretreatment with the cock part facing

upward, and store the entire carton in a safe place.
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6-3-3. Application of pretreatment

>

In order for the pretreated portions to be printed with inks, apply the pretreatment evenly to a wider area than the print
range.
<CAUTION>

Fully take care of the air ventilation when you work on operation that generates mist such as spray application.

Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<IMPORTANT>

Some T-shirts may leave distinct imprints of the pretreatment after it is fixated. Wash away any imprint of the pretreatment with
water, if any.

Also, some T-shirts may be discolored by the pretreatment and cannot be restored to the original color even if they are washed.
When performing the printing for the first time, do that after applying the agent to an unnoticeable area on trial.

If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.
Otherwise, it may cause failure of print heads.

Reference guide for amount of coating of pretreatment

Determine a coating area and amount of coating according to a platen size. When your coating area differs from what
are shown in the table below, calculate the amount of coating based on the area ratio.
<IMPORTANT>

Depending on the type of fabric, the print quality cannot be guaranteed with the amount of coating of pretreatment shown below.
It is therefore necessary to conduct sufficient print tests and adjust the amount of coating.

If the amount of coating of pretreatment is too small, imprints of the pretreatment may become less noticeable after it is fixated,
whereas color reproduction of the white ink and color inks on the white ink will deteriorate.

Meanwhile, if the amount of coating of pretreatment is too large, imprints of the pretreatment may become noticeable, the printed
surface may be cracked or discoloring may occur after washing.

Platen Size Amount of coating of pretreatment
16 x 21 45 g (1.6 02)
16x18 399 (1.4 0z)
14 x 16 30g(1.10z)
10x 12 16 g (0.6 02)
7x8 89 (0.3 02)
Letter size/Ad-size 15g(0.50z)
Pocket size
(3.9in. x3.9n. (10 cm x 10 cm)) 39(0-102)
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For coating with a spray (commercial product: preferably of an electrically-operated type)

(1) Fill a spray with the diluted pretreatment.
<TIPS>
° Please use a spray (preferably of an electrically-operated type) that can emit fine spray.

Spray

Pretreatment

X0083

(2) Puta T-shirt flatly on a flat surface or lean it back against wall, and apply the pretreatment evenly onto it.
<CAUTION>
. Fully take care of the air ventilation when you work on operation that generates mist such as spray application.
3 Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.
3 For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<IMPORTANT>
3 If you are using an electric spray to apply the pretreatment, perform the work at a place as far as possible from the printer.

Otherwise, it may cause failure of print heads.

<TIPS>

3 Note that pretreatment will not soak into the back (reverse) side of a T-shirt if you put an intermediate plate in the T-shirt.
Remove the intermediate plate from the T-shirt before the pressing stage.

. When you are still unaccustomed to the spray coating, perform it while measuring the amount of coating by means of a

weighing instrument.

Spray

a9y \ v R,

> g o Lo o I

N\

T-shirt X0084
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For coating with a pretreatment roller (option)

<TIPS>
. For details of the item code, refer to "10-4. About consumable supplies, optional items and replacement parts >>P.335".

(1) Make a polypropylene tray or the like, handle (handgrip for roller), weighing instrument to measure the amount of

coating and agent-coating table ready for use.

<TIPS>
3 It is convenient for you to use an agent-coating table that can cover the print area, because it prevents the pretreatment

from soaking into the underside of the area.

Tray Agent-coating table

' Handle (handgrip of roller) Weighing instrument
X0086

(2) Weigh a T-shirt before applying the pretreatment to it, so that you will be able to know how much of the agent you

have applied to it later.

T-shirt

¢

Weighing instrument
(@)
O

(3) Slide a T-shirt onto the agent-coating table, with its printing side facing upward.

<TIPS>
3 Note that pretreatment agent will not soak into the back (reverse) side of a T-shirt if you put an intermediate plate inside the

X0087

T-shirt when there is not an agent-coating table.

T-shirt Agent-coating table

X0088
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(4) Attach the pretreatment roller to the handle (handgrip of roller).
<TIPS>
. Use a commercially available handle provided with a roller that fits the pretreatment roller's inside diameter of 0.8 in. (21
mm).

Pretreatment roller

Handle (handgrip of roller)
a

0.8in. 21 mm) X
X0089

(5) Pour the diluted pretreatment into the tray, and dip the pretreatment roller in the agent so that it will be dampened

/ Pretreatment

with the agent.

Pretreatment roller

L=
\/,,;.

Tray '
X0090

(6) Rub the pretreatment roller well against the scrub board of the tray and squeeze a redundant agent out of it.

Pretreatment roller

Tray

X0091
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(7) Move the pretreatment roller on the T-shirt in a longitudinal direction, and apply the agent evenly onto the print

range.

T-shirt — | — Pretreatment roller
X0092

(8) Move the pretreatment roller on the T-shirt in a lateral direction, and apply the agent evenly onto the print range.
<TIPS>

Depending on a difference in the force applied by you to the pretreatment roller, the pretreatment may not be applied evenly
to a T-shirt. Move the pretreatment roller repeatedly on each area to apply the agent evenly onto such area.

When there is any area (gap) that fails to be coated with the pretreatment or any other area that is found to be unevenly
coated, dip the pretreatment roller in the agent again, and apply the agent evenly there.

T-shirt

Pretreatment roller

Uneven coating

X0093

(9) Weigh the T-shirt to check to see if the required amount of pretreatment has been applied to it.
<TIPS>

For reference guide for the amount of coating of pretreatment, refer to "6-3-3. Application of pretreatment >>P.120".

If the amount of coating is small, color reproduction of the white ink and color inks on the white ink will deteriorate.
Meanwhile, if the amount of coating is too large, it is likely that a T-shirt may harden, imprints of the pretreatment may
become noticeable or washing fastness may get worse and so on after the pretreatment is fixated.

Weighing instrument

T-shirt

X0094
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Maintenance of pretreatment roller

If you continue using the pretreatment roller under a state in which any fuzziness, yarn waste, dust, etc. remain attached

to its surface, you may not provide a uniform coating.

In such case, use a toothbrush or the like to brush off such fuzziness to remove it from the surface.

<CAUTION>

. Be sure to wear a pair of plastic gloves and protective glasses during the work operation.

° For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<NOTE>

. After the pretreatment roller is used, put it in a plastic bag or the like hermetically to prevent it from drying up, and keep it in a flat

place in an upright position.
Also, when it remains unused for two weeks or longer, wash it well with running water, and let it dry in a shaded area before using
it again.

Toothbrush, etc. Pretreatment roller

D\

X0095
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6-34. Fixation of pretreatment

<CAUTION>

. As the operation will generate mist, fully take care of the air ventilation.

. Be sure to wear a pair of plastic gloves, a mask and protective glasses (or goggles) designed to shield against liquid splash
during the work operation.

. For information on handling of the pretreatment, see the Material Safety Data Sheet issued by us.
http://sds.brother.co.jp/sdsapp/index.html

<TIPS>

. Because the pretreatment will not work best if it is dried through oven-based drying or air drying, be sure to use the heat press.

As the oven does not bind fuzziness, the agent may be applied unevenly on white print.

. When you put a T-shirt on the heat press, set it so as to flatten the T-shirt's surface, place a peel-off sheet on the entire press
area, and apply pressure.

. Note that any area in which the pretreatment is fixated may cause its effect to deteriorate or could cause the agent to be coated
there unevenly if such area gets wet once.

. Do not touch the treated area with your hand after the pretreatment is fixated.

. After the pretreatment is fixated, do not touch or place the T-shirts on top of each other.

. Avoid leaving the pretreatment as it is in any highly humid areas.

. If the agent is left unchecked for a long time, use the heat press to apply pressure to a T-shirt immediately before the printing in
order to dry it well.

Guidelines on fixation conditions of pretreatment

The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat

press. Be sure to perform the fixation after checking on the temperature and fixation results beforehand.

<TIPS>

. Prior to and during a fixation process, check the heat press's temperature. If the fixation is performed continuously, the heat
press's temperature will decrease, resulting in improper fixation of the pretreatment. In this case, the whiteness cannot be
reproduced because the white ink soaks into the fabric of a T-shirt.

. Such a pressure is required that is adequate enough to flatten the surface. As the fixation conditions differ by heat press, check
the ink fixation result in advance and adjust the pressure.

° If it is not dry enough after pressing for 35 seconds, extend the time while checking the dried condition of the pretreatment.

. The following values should be regarded as guidelines only, for the optimum fixation conditions depend on the amount of coating
of pretreatment.

Temperature Time
180°C (356°F) 35 seconds
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(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the pretreatment

properly.

<TIPS>

. Water droplets are generated around the heat press to evaporate water content of the pretreatment by the heat of heat
press. Keep your working space clean so that the surface to be coated with the agent will not get wet.

. A peel-off sheet should be used if needed, depending on the heat press you use.

Heat press

Peel-off sheet

Water droplets

Silicone foaM

T-shirt

X0096

(2) Remove the T-shirt from the heat press so that the steamy heat will escape from it.

Heat press

T-shirt

X0097
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6-4. Platen adjustment

Replace the currently used platen with another one that suits the medium to be printed.
<TIPS>

. In cases where such an optionally sized platen as 10X12 platen is used, ascertain that a proper "Platen size" has been selected
in the printer driver's setting menu. For details, refer to "5-3-1. Select the platen size >>P.86".
. If you are using the 16X21 platen, refer to "6-4-3. Using the 16X21 platen >>P.140".

6-4-1. Replacing the currently used platen with another one

(1) On the operation panel, press , and move the platen toward the front of the printer.
_

Platen

X0164

(2) Loosen the platen fixing lever by rotating it one to two turns.
<TIPS>

. Depending on the height of the platen, the platen fixing lever may strike against the platen, and prevent rotation. In that
case, move the platen fixing lever in the direction (a), draw the edge of the platen fixing lever forward as shown in (b), then
loosen it again.

Platen fixing lever

Platen

Platen fixing lever

X0257
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(3) Remove the platen moving it straight upwards by holding both ends of it.

X0258
(4) Putanother platen to be used in position directly from above.
| ‘ Platen
X0259
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(5) Tighten the platen fixing lever.

130
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6-4-2. Platen height adjustment

When constantly printing on thick material, the platen height can be lowered by up to 1.2 in. (30 mm) by adjusting the

platen bearing and collars.

<TIPS>

. Please refer to the table below for the platen's height adjustment range (height A, measured from the platen height adjustment
lever; with the standard parts installed).

. Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers.

o When using the 16X21 platen, it can be used only at the lowest position. Remove all the collars before mounting the platen. Also
note that the height adjustment range of the 16X21 platen is 0.4 in. (10 mm) at maximum.

. When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen bearing.

0to 0.4 in.
(0 to 10 mm)
e — ———— — :
| T 0.4t00.8in. Collars

\){][ u”’\ (10 to 20 mm) CL

Collars S Spacer

1 1J]
5 0| = 0.8t0 1.21n.
)P N\ (20 to 30 mm) . .
‘o) \\ﬁ% pacer

X0102
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Spacer

Rl S

X0165

As an example, the cases where the platen's height is set to the lowest position from the standard position and to the
middle position from the lowest position are described below.

From the standard to the lowest position
(1) Detach the platen.
(2) Remove the platen fixing lever, platen height adjustment lever, and collars.

The number of collars and the height adjustment range are as follows:

Position Height No. of collars
High "
ighest position 0to 10 mm 2
(standard)
Middle position 10 to 20 mm 1
Lowest position 20 to 30 mm None

Case of 16x21 platen

No. of collars
Lowest position 0to 10 mm None

<TIPS>

3 Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers.

Platen height adjustment lever

Collars

Platen fixing lever
X0261
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(3) Attach the platen height adjustment lever to the platen bearing.
<CAUTION>

e Attach the platen height adjustment lever to the position as illustrated in the figure below. The lever installed in
the wrong position will interfere with the stopper when the platen is attached.

<TIPS>
e When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen
bearing.
N
lever v ,@\J 4
> //
Platen bearing /
Y
Stopper
Platen height adjustment
lever
X0262
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(4) Check that the end position of the platen height adjustment lever is aligned with that of the platen bearing.

Platen height adjustment
lever

X0208

(5) Loosen the knob while holding the platen height adjustment lever and lower the platen bearing and the height

control lever.

Platen bearing

Platen height adjustment lever

X0263
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(6) Use the platen fixing lever to secure the platen temporarily.

~¥
Platen bearing \§ / g R

The number of collars and the position of screw hole for the platen bearing differ by the height of the platen

adjusted.

<TIPS>

e [fyou are setting the platen's height to the lowest position, remove all the collars and fix the platen bearing at
its highest screw hole temporarily.

e If you are setting the platen's height to the middle position, attach one collar and fix the platen bearing at its
middle screw hole temporarily.

e If you are setting the platen's height to the highest position, attach two collars and fix the platen bearing at its
lowest screw hole temporarily.

Platen bearing

<

T~
Platen fixing lever

X0264

(7) Tighten the knob to secure the platen bearing in place.

(8)

<TIPS>

e Align the center of platen fixing lever with the position as illustrated in the figure below, and secure the platen
bearing in place.

Platen bearing e A

Platen fixing lever Platen bearing

_ Center
) position
‘_J alignment

|
|
1
s
\
)

IS

Knob Platen fixing lever

1

1
\
\

&

X2
<

-

:

Knob
X0265

Insert the platen to be used and tighten the platen fixing lever.
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From the lowest position to the middle position

(1) Detach the platen.
(2) Remove the platen fixing lever, platen height adjustment lever.

The number of collars and the height adjustment range are as follows:

Position Height No. of collars
Highest position 0to 10 mm 2
(standard)

Middle position 10t0 20 mm 1
Lowest position 20 to 30 mm None

Case of 16x21 platen
Position Height No. of collars
Lowest position 0to 10 mm None

<TIPS>
. Spacers are installed on your printer so that the height can be the reference value. Do not change the number of spacers.

Platen height adjustment lever

Spacer

Platen fixing lever
X0266

(3) Loosen the knob while holding the platen bearing and lift the platen bearing to the top to tighten the knob again.

© Platen bearing
\_/

Knob
X0267
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(4) Attach the collar.

Collars

X0268

(5) Attach the platen height adjustment lever to the platen bearing.
<CAUTION>
. Attach the platen height adjustment lever to the position shown below. The lever installed in the wrong position will interfere
with the stopper when the platen is attached.
<TIPS>
3 When adjusting the height, put the latch of the platen height adjustment lever into the groove of the platen bearing.

N

Platen height adjustment

lever

Y,
Stopper
Platen height adjustment
lever
X0269
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(6) Check that the end position of the platen height adjustment lever is aligned with that of the platen bearing.

Platen height adjustment lever

X0208

(7) Loosen the knob while holding the platen height adjustment lever and lower the platen bearing and the height

control lever.

Platen bearing

Platen height adjustment lever

X0270
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(8) Use the platen fixing lever to secure the platen temporarily.
The number of collars and the position of screw hole for the platen bearing differ by the height of the platen
adjusted.
<TIPS>

3 If you are setting the platen's height to the lowest position, remove all the collars and fix the platen bearing at its highest
screw hole temporarily.

. If you are setting the platen's height to the middle position, attach one collar and fix the platen bearing at its middle screw
hole temporarily.

. If you are setting the platen's height to the highest position, attach two collars and fix the platen bearing at its lowest screw
hole temporarily.

@ Platen bearing
\\ / [~
\

N
- J
Platen fixing lever

X0271
(9) Tighten the knob to secure the platen bearing in place.
<TIPS>
3 Align the center of platen fixing lever with the position as illustrated in the figure below, and secure the platen bearing in
place.
Platen bearing e A
Platen fixing lever )
‘ Platen bearing
/f (o ... Center
} — 1/ ! o 1 position
; < % % N : ! alignment
¢ : i
> J
Knob Platen fixing lever
. J
Knob
X0272

(10) Insert the platen to be used and tighten the platen fixing lever.

139



Basic printing procedures

6-4-3. Using the 16X21 platen

<CAUTION>

. When using the 16X21 platen, handle it with care because it is heavy. Be sure not to touch the moving parts of the platen.
Otherwise you may be injured.

o When you slide the 16X21 platen manually, move it slowly.

When you place or remove a T-shirt, and when you replace the platen, manually slide the platen forward and draw it out

of the main unit completely to perform such operation. At this time, slide the platen while lifting it a little. When you
perform printing, slide the platen backward and return it to the printing position before starting the print process.

16X21 platen

When placing/removing T-shirt
and replacing the platen

Position for printing

X0158

<TIPS>
° When using the 16X21 platen, remove all the collars for height adjustment before using it. For information on platen height
adjustment, refer to "6-4-2. Platen height adjustment >>P.131".

i 1 Take off the collars

X0273
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(1) On the operation panel, press , and move the 16x21 platen toward the front of the printer.
_
(2) Slide the 16X21 platen while lifting it a little to draw it forward.

(3) Perform the work for placing or removing a T-shirt and replacing the platen in this condition.

<TIPS>
. For information on replacing the platen, refer to "6-4-1. Replacing the currently used platen with another one >>P.128".
. For information on placing or removing a T-shirt, refer to "6-5. Placing print medium in position >>P.142".

Replace the platen

Slide it forward

o
(=}

X0166

(4) When you finish placing or removing a T-shirt, and replacing the platen, slide the platen backward and return it to its
printing position.
<IMPORTANT>

. As the platen is positioned higher when it is slid forward, it is detected by the obstacle sensor, which prevents printing from

being performed. However, if the platen's height is set at the lowest position, the platen is not detected by the obstacle

sensor, and printing may be performed outside the print range of the platen.
Make sure to start printing after sliding the platen to the printing position.

16X21 platen

Slide it backward

X0168
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6-5. Placing print medium in position

In order to provide an optimum printing image quality when a print medium is placed in position, you need to adjust the
platen's height in accordance with the thickness of the T-shirt or other print medium.
<CAUTION>

Ensure there is adequate space left in front of the printer and avoid placing any objects that may hinder your movement or the
complete movement of the platen. The platen moves forward while operating and it can strike/damage anything set in its path of
movement.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and the covers, it may be
injured.

<IMPORTANT>

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

<TIPS>

™

)

Adjust the height of the platen corresponding to the print medium before using it. You can use the platen height adjustment lever
to adjust the height of the platen. As a rough indication, adjust the height so that it is lowered by one step from the limit height
detected by the obstacle sensor, and check that the platen is not detected by the sensor.

In the event that the platen's height is lowered excessively, ink mist will be scattered inside the printer, which may result in
staining of the printing surface, blurring of the printed image, and malfunction of the sensor and the main unit.

Use Uni-Directional Printing in the case where the platen's height needs to be lowered to avoid a hemmed (edge) and seam.

For details, refer to "8-1. Setting the print direction >>P.224".

You can specify the Uni-Directional Printing for each print data from the printer driver as well.

For details, refer to "5-3-11. Specify the print direction >>P.99".

When you print a thick printing material, you can always lower the platen's height by adjusting the platen bearing, collars.

For details, please refer to "6-4-2. Platen height adjustment >>P.131".

If you are using the 16X21 platen, refer to "6-4-3. Using the 16X21 platen >>P.140".

If the platen has not been moved forward, press on the operation panel.
—_

Use the platen height adjustment lever to adjust the height of platen.

<TIPS>

. Set the platen height adjustment lever to the position around "A" for a T-shirt, or to the position "C" for such thick material as
a sweatshirt.

. If the platen's height is lowered too much, the printing quality may deteriorate, the main unit may be soiled with ink mist and
SO on.

Platen

Platen height adjustment lever
S

S

X0274
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(3) Puta T-shirt onto the platen, with its printing side facing upward.

<IMPORTANT>

. If the 16X21 platen is mounted, slide it forward and place a T-shirt on it.

<TIPS>

. For the position alignment of white or pale-colored T-shirts, a grid to be printed out on the platen sheet is available from [All
Programs] in the Start menu, by selecting "Brother GTX-4 Tools" > "Useful Tools".
For details, refer to "5-4-4. Printing a grid pattern onto platen sheet >>P.102".

Platen

X0110

(4) Smooth down the creases in the T-shirt and remove lint and dust from it.

<TIPS>

. Seams on a hemmed (edge), neck portion, armhole, tucks and sleeves or the like are easily detected by the obstacle
Sensor.

. In particular, both ends of the T-shirt tend to be raised easily during the printing operation if not flattened properly and
detected by the obstacle sensor.

. Touching on the fixated pretreated surface should be avoided during the work.

. Do not pull the T-shirt with the pretreatment applied. Instead, flatten it in such a way that it will fit onto the platen surface
well.

3 When the surface of the T-shirt does not remain flattened properly, the obstacle sensor detects it.

. In the event that any T-shirt is placed on the platen by pulling it outward forcibly, there are instances in which ejection areas
of the white and color inks are misaligned and the white ink extends off its specified printing area. In particular, be careful
not to stretch a thin T-shirt outward on the platen.

Smooth out the wrinkles

T-shirt X0111
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(5) The T-shirt should be placed on the T-shirt tray, trying not to draw the excessive parts like sleeves and hems into

(6)

(7)

the printer.

T-shirt

T-shirt tray

X0112

On the operation panel, press , and move the platen toward the rear of the printer.
—_

Try moving the platen, and check on the gap between the T-shirt surface and the obstacle sensor over the entire print area.
<TIPS>

If this gap is too wide, adjust it by rotating the platen height adjustment lever.

Adjust the height so that it is lowered by one step from the limit height detected by the obstacle sensor, and check that the
platen is not detected by the sensor.

If the platen's height is too high, a print medium will strike against the print head during the printing process, which in turn
results in ink stains or malfunction.

If the 16X21 platen is mounted, manually slide it backward until it returns to the original position, then move the platen

toward the rear of the printer.

On the operation panel, press , and move the platen toward the front of the printer.
S

<TIPS>

Repeat the height adjustment until the platen will be positioned at a proper height.
After your desired height is determined, start the printing operation. For details, refer to "6-7. Executing a printing job
>>P.155".

T-shirt

T-shirt tray

X0113
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6-6. Sending/Loading Print Data

Print data can be loaded into the printer in the following ways:
e  Receive the print data from the PC connected with the USB or LAN cable.
e Load the print data from the USB flash.

For details, please refer to the chapters described later.

6-6-1. Sending print data from ARX4 file preview

(1) Open an ARX4 file.

<TIPS>
. Double click on the ARX4 file, or select [All Programs] > "Brother GTX-4 Tools" > "GTX-4 File Viewer", to select and open
the ARX4 file.

(2) The file's printing conditions and preview window will be displayed.

<TIPS>

. If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, the preview window will be displayed
against a "Black" background or a "Transparent color" background which has been specified in the Advanced settings.

. If you have selected [Color Ink Only] in the Select Ink operation, the preview window will be displayed against a "White"
background.

. When you press the Details button, those items that have been specified in the Advanced setting window of the printer
driver appear.

e When [Color+White Ink] or [White Ink Only] is selected

-
Gif' CAIMG_1404.arx4

Machine Mode GTX422
Job Name : IMG_1404
Date 06/25/2017 18:53
Platen Size : 14¢16
Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink
Highlight : h
Mask 3
Print Time : x1
Whiteness : 400 %
Use background black color ~ Off
Color Muttiple Pass Printing : ~ Off

Color Ink 097cc 100% [} 600%
White Ink : 865cc
Print : 1 piece
. . Present Layer 1 WsCMYK | [C] White Data
‘ Send to Printer |
—— swsgoraco [N
Browse... Close
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When [Color Ink Only] is selected

[Details]

Basic printing procedures

G C\2_ IMG_1404.anc4

Machine Mode : GTX-422
Job Name : IMG_1404
Date : 06/25/2017 21:54
Platen Size : 1416
Resolution : 1200dpi x 1200dpi
Select Ink Color Ink Only
Color Ink Volume : 10
Double Printing : 1
Color Muttiple Pass Printing : ~ Off
Color Ink 121ce 100z [} 600%
Print : 1 piece
E Sendto Printer |
[ Browse... ] [ Close ]
W CA2IMG_1404.anc4 %7 Details [ ) SRS
Machine Mode GTX-422| Item Value o 7.0
Machine Mode : GTX-422 ! o
Job Name : IMG_1 Job Name : Untitled B
Date : 17/10/2019 14:45
L= e Platen Size : 14x16
Mode : Normal
Platen Size : 14x16 Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink
Resolution : 1200dpi
esoltion o Highlight : 5
Mask : 3 =
Select Ink : Color Ink Print Time : x1
Color Ink Volume : 10 Whiteness : 400 %
2 Layer White : off
Double Printing : 1 Interval (sec.) : -
White/Color Pause : off
Color Multiple Pass Printing : ~ Off Interval (sec.) : .
Use background black color : Off s
Color Multiple Pass Printing :  Off = »
B s 121ce Transparent Color : off M 600%
Tolerance : -
Print : 1piece Minimum Whiteness : 1
Choke Width : 2
“Send o Printer Saturation : 5
Brightness : 5
G Contrast : 5
Cvan halance : n b
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If you have selected [Color+White Ink] or [White Ink Only] in the Select Ink operation, you can change the

background color of the preview window and preview the print image. Select [Change...] > [Define Custom Colors],

and enter RGB value.
<TIPS>

. When the [White Data] checkbox is marked, the preview window for white ink only will be displayed.

[ cuMG_1404ana = | &
Machine Mode : GTX422
Job Name : IMG_1404
Date - 06/25/2017 1853 e
Platen Size : 14x16
Resoltion - 1200dpi Basic colons:
. - EMEEEEEN
- lor+
il : ErEETEEN
Mask 3 EEEENENENN
P Time x1 ENEEENENEN
u“’:‘i‘“’:du*l ;‘;"” EEEEEENEN
jse background black color
Cote Mot Pas Prtrg - OF HEEEET T
D :
Custom colors:
|| | | =
Colr bk 057ce 600% HEEE ..
.
White Ink : 865cc [ i =
Defin ors ColoriSglid Lum: 0
-m -m Add to Custom Colors
"Example: Preview window for printing an image on a brown (R=128, G=64, B=64) T-shirt"
57 CAIMG_1404.arx4 [
Machine Mode : GTX-422 70
Job Name : IMG_1404 —
Date : 06/25/2017 18:53
Platen Size : 14¢16
Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink
Highlight - 5 3
Mask 3
Print Time : £al
Whiteness : 400 %
Use background black color ~ Off
Color Multiple Pass Printing :  Off L
Detals .. =
Color Ink : 097cc 600%
White Ink : 865¢cc
Print - 1 piece
Present Layer [ White Data
[ Sendto Printer ]
Background Color _ m"Chang i
[ Browse... ] [ Close ] B
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(4) For the print data that requires multiple cycles of platen reciprocate movement, print data of each layer can be
verified separately by selecting the desired layer to be displayed. From the [Present Layer], select a layer that you

want to bring into the view.

<TIPS>

. In the layer that is shown as [Total], the preview window of the final print result is displayed.

. When the [White Data] checkbox is marked, the preview window for white ink only will be displayed.

G557 CA3_IMG_1404.arxd [
Machine Mode : GTX422
Job Name : IMG_1404
Date : 06/25/2017 13:00
Platen Size : 1416
Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink
Highlight : 5
Mask : 3
Print Time : x2
Whiteness : 400 %
Use background black color ~ Off
Color Multiple Pass Printing :  Off

Color Ink 0.97cc 100% [} 600%
White Ink : 865cc
Print : 1 piece
Proset Layer e Data
| |

—
o

(5) Check the printing conditions and preview window, and click on [Send to Printer].
Then, the ARX4 file is sent to the printer.
<TIPS>
. Make sure that a connection of USB 2.0 cable or LAN cable is made between your PC and the printer.
. In the event that two or more GTX-4 printer drivers have been installed on your PC, select one of them and click [OK].

(=
357 CAIMG_1404.and [ [
Machine Mode : GTX422
Job Name : IMG_1404
Date : 06/25/2017 18:53
Platen Size : 1416
Resolution : 1200dpi x 1200dpi
Select Ink : Color+White Ink
Highlight : 5
Mask : 3
Print Time : x1
Whiteness : 400 %
Use background black color ~ Off
Color Multiple Pass Printing :  Off

Color Ink 097cc 100% [} 600%
White Ink : 865¢cc

Print : 1 piece

Present Layer 1 W-CMYK = | [C] White Data
———
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6-6-2. Sending print data from other applications

CorelDRAW

(1) Inthe menu bar, select [File] > [Print].

(2) Open the [Color] tab, and make the following settings:
e Place a checkmark in the [Use document color settings] checkbox.
e [Color conversions performed by]: "Brother GTX-4" or "Brother GTX-4 FileOutput"
e [Correct colors using color profile]: [SRGB IEC61966-2.1]
e [Rendering intent]: [Relative colorimetric]
Print X

| Gener&i| Color | Composite I Layout | Prepress I 7 No Issues|

(@ Print composite

(@ Print separations

@ Use document color settings

() Use color proof settings

Color conversions performed by: Brother GTX-4 FileQutput

Output colors as:

RGB

| Convert spot colors to RGB

Correct calors using color profile: I(Do:umcntj SsRGBIECE1966-2.1

Preserve RGB numbers

[¥] Preserve pure black

Rendering intent:

lRelativc colorimetric

) The color settings and preview available in this dialog box are set for the Windows Graphic device
printer that you selected on the General tab.

[ Print Preview ] l OK ][ Cancel H Apply H Help

(3) Open [General] tab and select "Brother GTX-4" from [Printer].
<TIPS>

° If the specified [Printer] is set to "Brother GTX-4", the print data will be sent to the printer.
If the specified [Printer] is set to "Brother GTX-4 FileOutput", the print data will be saved as an ARX4 file.

(4) On [Preferences], set up the printer driver and send the print data by clicking [OK] in the [Print] dialog box.
<TIPS>
3 For details, refer to "5-3. Set up the printer driver >>P.84".

. Clicking on [OK] will not start the print operation of the printer itself. The print button of the printer should be pressed to start
the printing operation.
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Adobe Photoshop
(1) Inthe menu bar, select [File] > [Print]. If the PC's default printer is either "Brother GTX-4" or "Brother GTX-4
FileOutput", the layout is set to the platen size.

(2) Make the settings as follows:
o [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

Photoshop Print Settings u

14in x 16in Printer Setup
Printer:  Brother GTX4 FileOutput

s: |1 Print Settings...

ayout: n 5 1

~ Color Management

A F.\:‘lru )

Document
Color Handling: ~ Printer Manages Colors
Printer Profile:
Normal Printing

Rendering Intent:  Relative Colorimetric

Description

Dong. f

(3) From [Printer], select "Brother GTX-4".
<TIPS>
. If [Printer] is set to "Brother GTX-4", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX-4 FileOutput", the print data will be saved as an ARX4 file.

(4) Inthe [Print Settings], set up the printer driver, and send the print data by clicking [Print].
<TIPS>
. For setting details, refer to "5-3. Set up the printer driver >>P.84".
. Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to

start the printing operation.
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Adobe lllustrator

(1) Inthe menu bar, select [File] > [Print] > [Color Management].

(2) Make the settings as follows:
e [Document Profile]: [sSRGB IEC61966-2.1]
e [Color Handling]: [Let lllustrator determine colors]
o [Printer Profile]: [sRGB IEC61966-2.1]
¢ [Rendering Intent]: [Relative Colorimetric]

Print

Print Preset: [Default]

Printer: Brother GTX-4 FleQutput

General Color Management
Marks and Bleed

£
Output Print Method

Graphics Document Profile: sRGB IEC61966-2.1

Color Management i —
Advanced Color Handling: | Let Tllustrator determine colors

5 / _
il Printer Profile: | sRGB IEC61966-2.1

Rendering Intent: Relative Colorimetric

Description

Document: 14 in x 16 in
Media: 14 in x 16in

Cancel

(3) From [Printer], select "Brother GTX-4".
<TIPS>
. If [Printer] is set to "Brother GTX-4", the print data will be sent to the printer.
If [Printer] is set to "Brother GTX-4 FileOutput", the print data will be saved as an ARX4 file.

(4) Inthe [Advanced], set up the printer driver, and send the print data by clicking [Print].
<TIPS>

. For setting details, refer to "5-3. Set up the printer driver >>P.84".

. Clicking on [Print] will not start the print operation of the printer itself. The print button of the printer should be pressed to
start the printing operation.
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Adobe Photoshop Elements

(1) Inthe menu bar, select [File] > [Print].
(2) Select [More Options] > [Color Management].

(3) Make the settings as follows:
o [Color Handling]: [Printer Manages Colors]
¢ [Rendering Intent]: [Relative Colorimetric]

uuMoce.Options X

Printing Choices Color Management
Custom Print Size

Color Handling: | Printer Manages Colors ¥ |

Image Space: sRGB IEC61966-2.1

Printer Profie: | Adobe RGB (1998) -

Rendering Intent: = Relative Colorimetric -

, Did you remember to enable color management
" in the printer preferences dizlog?

| Printer Preferences... |

| oK || Cancel || Help

(4) When selecting a printer, select "Brother GTX-4".
<TIPS>
. If the [Printer] is set to "Brother GTX-4", the print data will be sent to the printer.
If the [Printer] is set to "Brother GTX-4 FileOutput", the print data will be saved as an ARX4 file.

(5) In the [Printer Preferences], set up the printer driver, and send the print data by clicking [OK].
<TIPS>
. For setting details, refer to "5-3. Set up the printer driver >>P.84".

. Clicking on [OK] will not start the print operation of the printer itself. The print button of the printer should be pressed to start
the printing operation.
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6-6-3. Loading print data (ARX4 file) from USB flash memory

™

2

@)

Insert a USB flash memory into the insertion slot near the operation panel of the printer.

<IMPORTANT>

o Do not apply undue force to the USB flash memory when you insert it into the slot. Otherwise, it could be damaged.

<TIPS>

. Please use a FAT32-formatted USB flash memory of which storage capacity is 2 GB to 32 GB in total. You cannot use a
USB memory with security functions such as password lock function.

. Note that the data which can be loaded from the USB flash memory is only the data in the ARX4 format.

USB flash insertion

X0038

From the menu, select [Print Data Load], and press @ .

<TIPS>
e  The information on file is shown on the liquid crystal panel.

Menu

Head Cleaning
Test Print
Print Data Load

Receiving History

Maintenance

Select a filename to be printed out, and press @ .
<TIPS>

. Selecting D will display the file stored in D

. Folders in the USB flash memory are shown down to the 3rd layer. Folders created in the 4th layer or below are not

displayed
(7 Sample Foldert
(3 Sample Folder? 1 (3 Sample Folder?
— PO Sample Folder3 = [0 Sample Folder3
~3 Sample Datal.arx4 ‘ Sample Datal.arx4
Sample Data2.arx4 Sample DataZ.arx4
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(4) Check the printimage displayed in the preview window, and press @ .

<IMPORTANT>

. Never touch the USB flash memory when the print button is blinking. Otherwise, any already-saved data may be corrupted.

<TIPS>

3 Depending on data size, it may take several minutes before the loading process is completed.

. If any files of USB flash memory cannot be read out, please refer to "9-1. Troubleshooting instructions >>P.242" for details.

. If a folder contains more than one print data, you can use A .~ W buttons to switch the preview display screen.

. It is possible to change the direction of the preview display screen as well. For the change method, refer to "8-15. Preview
display settings >>P.232".

Sample Data

# 14 x 16 inch
® 545 cc

Data Load OK

The print data loading will be completed when the print button stops blinking and remains lit, while the electric chime sounds.
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6-7. Executing a printing job

6-7-1. Executing a print job once for a single print medium

(1) Receiving a print data file.
The print button blinks during reception of data. When the data reception is completed, an audible alarm is activated and the print
button illuminates.
As there are two types of audible alarms, make sure the mounted platen matches the platen size of the print data.
<TIPS>
. When data of the same platen size as the previous one was received: A notice sound of "ping-pong" is output.
. When data of a different platen size from the previous one was received: A notice sound of "ping-pong pan-pong" is output.

(2) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button

to start the printing.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.

<TIPS>

. If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the
printer, but no print job will be started. In this case, press the print button once again.

. Pressing @ causes the printing to be canceled.

e The printer may shift to low temperature operation mode, when the room temperature is less than 18°C
(64.4°F) and white ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. To
change the low temperature operation mode, refer to "8-6. Print Operation Settings Under Low Temperature >>P.227".

3 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
so as to conform with the print warranty scope with reference to "10-1. Apparatus >>P.331".
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6-7-2. Executing a print job several times for multiple print media

You can keep the identical print data and execute a print job several times for multiple print media.

<TIPS>

. When the power is turned off, the retained print data is erased.

. In the event that [ON] is selected from the [Auto Job Delete] in the [Printer Setting] window, the print data will be erased after the
printing of the specified number of print media is completed. To change the setting, refer to "8-12. Automatic deletion of print data
>>P.230".

(1) Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button

to start printing.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.

<TIPS>

. If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the
printer, but no print job will be started. In this case, press the print button once again.

. Pressing @ causes the printing to be canceled.

. The number of print media of which printing is completed is shown on the liquid crystal panel.

. The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white
ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. To
change the low temperature operation mode, refer to "8-6. Print Operation Settings Under Low Temperature >>P.227".

3 High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
so as to conform with the print warranty scope with reference to "10-1. Apparatus >>P.331".

(2) Replace the platen's printed medium (T-shirt) with the next one and repeat the procedure until the desired number

of print jobs are completed.
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6-7-3. Performing the printing from receiving history

>

You can print out such print data that you have received before.
<TIPS>

™

(2

The print data that can be retained are max. 100 pieces of them and 800 MB in total capacity, wherein each print data will be
erased in the order from the oldest to the latest.

When the power is turned off, the retained print data is erased.

In the event that [ON] is selected from the [Auto Job Delete] in the [Printer Setting] window, the print function in the [Receiving
History] is disabled. To change the setting, refer to "8-12. Automatic deletion of print data >>P.230".

From the menu, select a print data you want to print out in the [Receiving History].
<TIPS>
. Each of the pieces of print data is displayed in the order in which they are received from the newest to the oldest ones.

Make sure that the print data you want to print out is displayed on the liquid crystal panel, and press the print button

to start the printing.

When the printing is completed, the platen moves to the forward-most position and the sound of "pong" is heard.

<TIPS>

If the print button is pressed when the platen has not moved toward the front, the platen will move toward the front of the

printer, but no print job will be started. In this case, press the print button once again.
. Pressing @ causes the printing to be canceled.

° The printer may shift to low temperature operation mode, when the room temperature is less than 18°C (64.4°F) and white
ink is used.
During low temperature mode, it may take a longer time for print operation and maintenance before starting the print. To
change the low temperature operation mode, refer to "8-6. Print Operation Settings Under Low Temperature >>P.227".

. High-temperature and low-humidity environment may prolong the maintenance time after completion of printing. If any
warning message about temperature and humidity is displayed, be sure to control the temperature and humidity promptly
so as to conform with the print warranty scope with reference to "10-1. Apparatus >>P.331".
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6-8. Removing printed matter from platen

(1) Hold the shoulder portions of print medium with your hand, and pull it out slowly in the forward direction indicated.
<IMPORTANT>
. Because the printed surface is still wet with ink, avoid touching it.
. If any ink is attached to your hands, wash your hands with soap and water.
. Those inks that are attached to fabrics cannot be cleaned up, please handle the inks with utmost care.

<TIPS>
. The printed ink is not fixated at this point - therefore, handle the T-shirt with care to avoid the printed surface touching with

other objects.

T-shirt

X0114
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>

6-9. Fixation of ink

For fixation of ink, use the heat press or oven.

Heat press

It is useful because you can control its temperature and operating time with ease.
Oven

If the number of articles to be printed is high, it will improve the operational efficiency.

<CAUTION>

Please use the heat press and oven in a well-ventilated area. If your working area is not well ventilated, wear a protective mask.

<TIPS>

If the inks are fixated insufficiently, discoloring may occur due to washing and friction.

Keep the fixation surface of heat press and peel-off sheet clean.

Otherwise, the printing surface may be soiled with stains from the peel-off sheet.

If a printed material is rubbed with vinyl-chloride-based white or light-colored synthetic leather, color transfer may occur.

When a color-printed surface is rubbed strongly against a printed surface with only white ink, color transfer may occur in the
same fashion.

When a color transfer takes place, wipe the color-transferred area and clean off dirt with a soft and clean cloth or a toothbrush
that is moistened with a small amount of mild detergent for home use and/or alcohol.

Component of pretreatment remains on the T-shirt on which the ink was fixated after applying pretreatment. For this reason, it is
advisable to wash such T-shirts with water before wearing them.

Guidelines on fixation conditions of ink

The undermentioned fixation temperature/time serve as guidelines only, and optimum conditions vary with your heat
press or oven. Be sure to perform the fixation after checking on the temperature and fixation results beforehand.
<TIPS>

Because optimum conditions vary depending on the type of your heat press or oven, use the fixation conditions as a reference
guide. Be sure to adjust the conditions while checking on the temperature and ink fixation results beforehand.

Because some print media easily get scorched, please carefully check and see how the surface actually looks like.

In particular, the print media onto which the pretreatment has been applied will easily get scorched.

When using the heat press, adjust the pressure while checking the ink fixation result.

If it is not dry enough after processing for the period of the guideline, extend the time while checking the dried
condition of the ink.

Device Temperature Time
Heat press 180°C (356°F) 35 seconds
Oven Surface temperature: 160°C (320°F)*1 3 min. and 30 sec. to 5 min.

*1: Because a T-shirt may be discolored if this temperature increases too high, great care should be taken to exercise
temperature control.
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Ink fixation by means of heat press

(1) Place the silicone foam, T-shirt and peel-off sheet in position under the heat press first, and fixate the pretreatment

properly.

<TIPS>

. For the guidelines on fixation conditions of ink, please refer to "6-9. Fixation of ink >>P.159".

. For details, refer to the instruction manual of your heat press.

3 There is a tendency to bring the print result to an almost matte finish if a silicone-coated paper is used as a peel-off sheet or
to an almost bright finish if a fluororesin sheet is used as the same at the ink fixation stage. Selectively use either of them

according to your desired finish.

003))

Heat press ,

Peel-off sheet

R —
Silicone foam \/

T-shirt
X0115
Ink fixation by means of conveyor-type oven
(1) Fixate inks onto a T-shirt by means of the conveyor-type oven.
<TIPS>
3 For the guidelines on fixation conditions of ink, please refer to "6-9. Fixation of ink >>P.159".
3 For the conveyor-type oven, identify the oven's internal temperature, and check up on actual ink fixation result.
. For details, refer to the instruction manual of your conveyor-type oven.
T-shirt Convt7r—type oven
[ o
l I
@-------------------------@
out in
X0116
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Precautions to keep good printing quality/use printer over the long term

ADANGER

A Contact with high voltage sections may lead to a serious injury. Turn off the power, and remove the cover 5
minutes later.

A.CAUTION

Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your
fingers.

Do not disassemble the ink pouch. If the ink gets into your eyes or onto your skin, it may cause inflammation.
In case of contact with eyes, do not rub but immediately rinse the eyes with water.

Do not disassemble the ink cartridge.

Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They
may cause diarrhea or vomiting.

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution,
pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately
rinse the eyes with water.

Keep the liquids out of the reach of children.

QO O P

Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.

It can cause inflammation.

Do not drink or eat the grease. It may cause diarrhea or vomiting.

Keep the liquids out of the reach of children.

When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

(I)IMPORTANT

Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.

Ensure there is adequate space left in front of the printer and avoid placing any objects. The platen may be
hit and damaged.
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Precautions to keep good printing quality/use printer over the long term

7-1. Tasks to be performed regularly

7-1-1. Replacement of ink pouch with a new one

If the . is displayed in the remaining ink volume indication window on the operation panel screen, replace the ink

pouch which is marked with X with a new one.

<IMPORTANT>

o No cartridges can be refilled with any ink. Do not disassemble the ink pouch. In order to use the printer for a long period and to
take full advantage of its capabilities, we recommend to use the ink pouches that are specified by us.

. During the printing process or head cleaning operation, avoid replacing any ink pouch with a new one. Otherwise, the printer may
break down.

<TIPS>

o If you replace an ink pouch that still has much amount of remaining ink in the way of use, the remaining ink volume indication
window may not display the correct remaining volume.

. Any ink pouch has been designed to leave a small amount of ink in it when reading the end of its service life. This is required to
protect the printer and keep its good printing quality. Please keep this matter in mind.

% ERROR

No Ink Yellow

L EENNN

(1) Take out the ink cartridge displayed on the screen from the printer.
<CAUTION>
3 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

)
Cc v

W12 W34

Cartridge X0047
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Precautions to keep good printing quality/use printer over the long term >
(2) Open the cartridge's lid.
<IMPORTANT>
. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.
. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the lid.

Lid

Cartridge
N

| )
Latch G Lid
VA
L —=
X0042
(3) Pinch the latch at the front end of ink pouch, and draw out the depleted ink pouch from the cartridge.
<CAUTION>
. Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular
basis.
Ink pouch
Cartridge's tip end
\ Cartridge
Latch
X0119

(4) Unpack a new ink pouch from its shipping carton.
For the white ink pouch, shake it 100 times each in the side to side direction with its obverse side and reverse side facing upward
separately, as shown below.
<NOTE>
. Shake the pouch under the condition it remains contained in the inner box.

White ink pouch

X0048
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Precautions to keep good printing quality/use printer over the long term >
(5) Unpack a new ink pouch from its inner box.
<IMPORTANT>
. Do not place the ink pouch near the sharp edges. It could break the pouch and leak the contained ink.
. Handle the ink pouch with care. It could be damaged when bent, snagged by sharp objects, or dropped.

Ink pouch

X0143

(6) Puta new ink pouch in the cartridge.
Push the tip end of the ink pouch into the cartridge until it clicks into place.
Straighten the ink pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount in position by pulling
it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

Ink pouch

Stretch

\

Cartridge

X0049

(7) Putthe ink pouch in its correct position.
<CAUTION>
. Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

Place the pouch in a straight alignment with the cartridge

Align lines with
each other X0041
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(8) Close the lid, and put the ink cartridge in position inside the printer.

<IMPORTANT>

. Be sure to put a cartridge in its correct position. If a different ink cartridge is put by mistake, the applicable print head may be
adversely affected. If a cartridge of different color is placed, please set it into the right position. If colors are mixed on the
print result or within the ink pouch, please contact your dealer.

. When setting the cartridge, do not shake the cartridge with the ink pouch facing down with the aim of facilitating the winding
of the pouch.

Doing so will cause wrinkles, and the proper winding of the ink pouch will not be possible.

X0283
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
(9) Attach a shelf life seal included with ink pouch onto the front surface of the cartridge.
U
Uso antes de Uso prima di
09. 2015
@TX Serles et
/
Shelf life label X0144
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Precautions to keep good printing quality/use printer over the long term >

7-1-2. Cleaning the nozzle guard, wiper, exhaust cap, and suction cap

When a warning message appears in the warning message window, perform the cleaning.
In the event that maintenance has been performed inadequately, a printed material may be soiled with waste ink during
a print session or a printed surface quality may deteriorate.

(1

)

@)

O Warning

Cap/Wiper Cleaning
Please Clean Nozzle Guards

[ ]

Make the clean stick R, clean stick T, cleaning cup, gloves and cleaning solution, which come standard with the

printer, available for use.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve

the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink

from drying up.
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Precautions to keep good printing quality/use printer over the long term

(4) Open the front cover, and clean each of the nozzle guards, wipers, exhaust caps, and suction caps.

Two types of clean sticks are provided. Use either the clean stick T or R depending on what you want to clean.
<TIPS>

. For the cleaning method, refer to the description mentioned below.

. Exhaust cap
Locations to be / suction
. Exhaust cap
cleaned with (/ cap Front cover
cleanstick T —
On the white side
suction cap /\ ’
% Wiper
On the color side
Wiper
s N 7 X
Locations to be
cleaned with
clean stick R
Nozzle guard
h g X0275
(5) After the cleaning is completed, close the front cover.
(6) Turn on the power.

<NOTE>

. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.

<TIPS>

3 Then, a head cleaning will be performed to prevent any ink from drying up.
3 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
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Precautions to keep good printing quality/use printer over the long term

Cleaning of the nozzle guard, wiper and exhaust cap should be performed separately for the white side and color side.
For the way to perform cleaning, refer to the respective items.

1 Perform cleaning of the white side.

Prepare a new clean stick R and the cleaning solution.

Perform cleaning of the nozzle guard part and the resin part on the white side.

Nozzle guard
Refer to "Cleaning the nozzle guard (Use clean stick R) >>P.169".

Cleaning

Prepare a new clean stick T and the cleaning solution.

Perform cleaning of the wiper part on the white side.
Wiper Refer to "Cleaning wiper (Use clean stick T) >>P.172".

Cleaning

Perform cleaning of the exhaust cap part on the white side.
Exhaust cap Refer to "Cleaning exhaust cap (Use clean stick T) >>P.174".
Cleaning

. Perform cleaning of the suction cap part on the white side.
Cleaning Refer to "Cleaning suction cap (Use clean stick T) >>P.176".
suction cap

pB Perform cleaning of the color side.

Rinse the cleaning cup, and prepare a new clean stick R and the cleaning solution.

Nozzle guard Perform cleaning of the nozzle guard part and the resin part on the color side.
Cleaning Refer to "Cleaning the nozzle guard (Use clean stick R) >>P.169".

Rinse the cleaning cup, and prepare a new clean stick T and the cleaning solution.

Wi Perform cleaning of the wiper part on the color side.
ey Refer to "Cleaning wiper (Use clean stick T) >>P.172".

Cleaning

Perform cleaning of the exhaust cap part on the color side.
Exhaust cap Refer to "Cleaning exhaust cap (Use clean stick T) >>P.174".

Cleaning

Perform cleaning of the suction cap part on the color side.

Cleanin
9 Refer to "Cleaning suction cap (Use clean stick T) >>P.176".

suction cap
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Precautions to keep good printing quality/use printer over the long term

Cleaning the nozzle guard (Use clean stick R)

(1)
(2)

Put a proper amount of cleaning solution into the cleaning cup.

Moisten a new clean stick R with the cleaning solution.

<IMPORTANT>

3 Use a new clean stick R when you start cleaning.

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the wiper, it may resultin a
printer malfunction.

. Do not use other fluids (water, etc.), because they may damage the print heads.

3 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R
Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0246
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Precautions to keep good printing quality/use printer over the long term

(3) Wipe clean the sides of the nozzle guard with the clean stick R.
<IMPORTANT>

<TIPS>

Be sure not to touch the nozzle surface as well as the level surface and sidling surface of the nozzle guard.

Manually move the carriage to such a position that you can perform the cleaning with ease.

Nozzle guard

_——

)

(]

be

Side

Nozzle guard

Clean stick R

Nozzle surface

X0276
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Precautions to keep good printing quality/use printer over the long term >
(4) Wipe the resin part between the print head's nozzle surface and nozzle guard.
<IMPORTANT>
. Be sure not to touch the red-frame zone of the nozzle surface.
. For cleaning, be sure not to use any tool other than clean stick R.

Cleaning location
Between the nozzle surface and nozzle guard

Clean this part

Nozzle surface

Nozzle guard
X0237
Cleaning conditions
Pre-cleaning state Post-cleaning state

Cleaning location Cleaning location X0238

Between the nozzle surface and nozzle guard Between the nozzle surface and nozzle guard
<IMPORTANT>
. Be sure to use the clean stick R separately for white ink and color ink.
<TIPS>

. There may remain white ink in the black resin part, but it doesn't matter if the severity is small as shown in the photo. Wipe away
the white ink spreading out of the nozzle guard and nozzle surface.

171



Precautions to keep good printing quality/use printer over the long term

Cleaning wiper (Use clean stick T)

(1) Puta proper amount of cleaning solution into the cleaning cup.

(2) Moisten a new clean stick T with the cleaning solution.
<IMPORTANT>
3 Use a new clean stick T when you start cleaning.
. Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.
. Do not use other fluids (water, etc.), because they may damage the print heads.
3 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick T
Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0229

(3) Use clean stick T to wipe clean the surface of the wiper as well as the gap between the convex part and the wiper.
<IMPORTANT>
3 Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.
. Be sure to use the clean stick T separately for color ink and white ink.
. If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp
objects could damage the wiper, possibly resulting in failure to eject ink-jet droplets.
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Precautions to keep good printing quality/use printer over the long term >

(4) Use the clean side of clean stick T to wipe clean the back of the wiper.

(&

Front

Clean stick T

/ / Wiper

Convex part

Clean stick T

\ Wiper

Front

—

Back

J

X0230

(5) Rinse the clean stick T in the cleaning cup to use it for cleaning of the exhaust cap to be performed next.
<IMPORTANT>
Be sure to use the clean stick T separately for white ink and color ink.
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Precautions to keep good printing quality/use printer over the long term

Cleaning exhaust cap (Use clean stick T)

(1) Wipe clean the rubber seal of exhaust cap with the clean stick T.
<IMPORTANT>
Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a

printer malfunction.

The clean stick T used for cleaning the wiper should be rinsed in the cleaning cup before the next use. Be sure to use the

clean stick T separately for color ink and white ink.

If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp

objects could damage the exhaust cap and deteriorate its air tightness, possibly resulting in failure to eject ink-jet droplets.

(2) Use the clean stick T to soak up the ink accumulated in the exhaust cap, and remove it.
<IMPORTANT>
If there is any ink clot in the exhaust cap, move the clean stick T in the direction as illustrated below. If the stick is moved

toward yourself, any of the exhaust suction ports may be clogged with ink clot.

Clean stick T

Rubber seal

-~

Clean stick T

Exhaust suction ports

X0244

(3) Rinse the clean stick T in the cleaning cup to use it for cleaning of the suction cap to be performed next.
<IMPORTANT>

Be sure to use the clean stick T separately for white ink and color ink.

<TIPS>
Some cleaning solution may remain in the exhaust cap, but it will not cause any functional problem.
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Cleaning conditions

Precautions to keep good printing quality/use printer over the long term

Pre-cleaning state

Post-cleaning state

On the
white side

On the
color side

Exhaust cap rubber part

Exhaust cap rubber part

X0239
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Precautions to keep good printing quality/use printer over the long term >

Cleaning suction cap (Use clean stick T)

(1) Wipe the rubber seal and lip of the suction cap with one side of the tip portion of clean stick T in parallel with the

seal.
<IMPORTANT>

Clean the lip of the suction cap with clean stick T. The print head dries and causes an ejection failure if solidified ink
remains.

Do not touch the sponge of the suction cap. The sponge may come off.

Never touch the tip end of clean stick T with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.

The clean stick T used for cleaning the wiper and exhaust cap should be rinsed in the cleaning cup before the next use.
Be sure to use the clean stick T separately for color ink and white ink.

If ink clot floats on surface, remove it using the clean stick T. Do not use tweezers or other sharp objects. Using sharp
objects could damage the suction cap and deteriorate its air tightness, possibly resulting in failure to eject ink-jet droplets.
Be sure not to pinch the rubber seal. If it is damaged, its sealing property will be degraded, which in turn may lead to
non-ejection of ink-jet droplets from the print heads.

Clean stick T

Rubber seal

Sectional view

ter si
Outer S|de/\outer side %

The outer side of the suction cap does not need to

be cleaned.
A\

Lips

‘s )

11 i

Sponge

X0245

(2) Replace clean stick T with clean stick R, rinse the cleaning cup, and clean the nozzle guard on the color side head.
<IMPORTANT>

Be sure to use the clean stick T separately for white ink and color ink.

The used clean stick T should be disposed of, and should not be reused.

After cleaning the nozzle guard of the color side head, rinse the cleaning cup with pure water, let it dry sufficiently, and store
it so that dust does not get inside.
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>

Pre-cleaning state

Post-cleaning state
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Precautions to keep good printing quality/use printer over the long term

7-1-3. Replacing the wiper cleaner

When a warning message appears on the operation panel screen or in the warning message window, replace the

specified wiper cleaner with a new one.

<TIPS>

. When you replace the wiper cleaner, check the staining state inside the printer. If parts inside the printer (carriage guide shaft,
roller guide, and carriage roller) are stained, perform cleaning with reference to "7-1-5. Cleaning the internal area of printer
>>P.185".

O Warning

Wiper Cleaner Replacing Color
Wiper Cleaner Replacing White

[ ]

(1) Have the supplied gloves and wiper cleaner ready.

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(4) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order prevent the print heads from drying up.
. If the task takes more than 15 minutes to complete, after attaching the wiper cleaner, close the front cover and turn on the
power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be
performed to prevent any ink from drying up.

(5) Open the front cover.

(6) Raise the wiper cleaner and move it to its upright position, and remove it by moving it upward.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Wiper cleaner Front cover

r

X0055
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Precautions to keep good printing quality/use printer over the long term

(7) Take out the wiper cleaner from its packing bag, and remove it from its protector.

<IMPORTANT>

. As soon as it is unpacked, do not leave it as it is and put it in position.

/

Protector

Wiper cleaner

(8) Insert a new wiper cleaner into the printer from above, tip it leftward and put it in place.

<TIPS>

X0128

. First, insert the shaft from above. Then fold it to the left, press the area with the PUSH indication until a clicking sound is

heard, and get the latch into position.

Latch

(9) Close the front cover.

(10) Turn on the power.
<NOTE>

. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.

<TIPS>

e  Ahead cleaning will be performed to prevent ink from drying up.
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Precautions to keep good printing quality/use printer over the long term

7-14. Replacing the flushing foam

When a warning message appears on the operation panel screen or in the warning message window, replace the

specified flushing foam with a new one.

<TIPS>

. When you replace the flushing foam, check the staining state inside the printer. If parts inside the printer (carriage guide shatt,
roller guide, and carriage roller) are stained, perform cleaning with reference to "7-1-5. Cleaning the internal area of printer
>>P.185".

O Warning

Flushing Foam Replacing Color
Flushing Foam Replacing White

[ ]

(1) Make the clean stick R, gloves and flushing foam, which come standard with the printer, available for use.

<TIPS>
. For this cleaning, you can use an already-used dirty clean stick R.

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

3 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(3) Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, after attaching the flushing receiver, close the front cover and turn on
the power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be
performed to prevent any ink from drying up.

(4) Open the front cover.
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Precautions to keep good printing quality/use printer over the long term

(5) Remove the flushing receiver from the maintenance unit.
<IMPORTANT>
. Ink droplets will drop off from the hole on the bottom of flushing receiver. Press a waste cloth against the bottom surface,
and lift the flushing receiver vertically to remove it.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

4 \

Flushing receiver Waste cloth Front cover

r _

a4
7

Waste cloth V /
& J/
X0277
(6) From the flushing receiver, remove the flushing foam.
Flushing foam
Flushing receiver
X0278

(7) Puta proper amount of cleaning solution into the cleaning cup.
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Precautions to keep good printing quality/use printer over the long term

(8) Moisten a clean stick R with the cleaning solution.

<IMPORTANT>

3 Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the wiper, it may result in a
printer malfunction.

3 Do not use other fluids (water, etc.), because they may damage the print heads.

. Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

. Clean stick R
Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0246

(9) Use a waste cloth and wipe away any dirt from the outboard end portions of flushing receiver and any ink debris

accumulated therein.

<IMPORTANT>
. If any ink debris or dust is accumulated on the outboard end portions of flushing receiver, the print heads may come into
contact with such portions, which may result in poor ejection of ink-jet droplets.
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Precautions to keep good printing quality/use printer over the long term

(10) Use the clean stick R to clean off any ink debris attached to the hole on the bottom of flushing receiver.

Outboard end portions

Clean stick R

Flushing receiver

X0279

(11) Clean the ink discharge portion of the flushing receiver with a clean stick R.

<CAUTION>
. Clean the ink discharge portion of the flushing receiver using the clean stick R. Remove peeled ink with a waste cloth, etc. If
you drain ink into the ink discharge port below the wiper without removing peeled ink, ink clogging may occur.

Clean stick R

Ink discharge portion

X0248
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Precautions to keep good printing quality/use printer over the long term

(12) Mount the flushing receiver back to its original place in the maintenance unit.

<TIPS>
° Direct its orientation with a hole on the bottom to the front.

Flushing receiver

X0280

(13) Assemble a new flushing foam to the flushing receiver.

<IMPORTANT>

° After this assembly process is completed, make sure that no flushing foam extends off the outboard end portions of flushing
receiver. [f it sticks out of the end portions, it may interfere with any nozzles and may result in non-ejection of ink-jet
droplets.

(14) Close the front cover.

(15) Turn on the power.

<NOTE>

. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
<TIPS>

. The head cleaning will be performed to prevent ink from drying up.
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7-1-5. Cleaning the internal area of printer

When you replace the wiper cleaner and the flushing foam, check the staining state inside the printer. If parts inside the
printer (carriage guide shaft, roller guide, and carriage roller) are stained, perform cleaning.

(1) Prepare a clean stick R, cleaning cup, gloves, cleaning solution, and grease which come standard with the printer.

<IMPORTANT>
3 Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in a printer malfunction.

(2) From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .
<IMPORTANT>
. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(3) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.
° If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.

(4) Open the front cover.

Front cover

X0050
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(5) Remove three screws to remove the encoder cover.

<CAUTION>

3 Do not touch the latch under the encoder cover. Otherwise, the operator may get injured.
<IMPORTANT>

. Do not touch the encoder on the main unit.

Encoder cover

X0148

(6) Put a proper amount of cleaning solution into the cleaning cup.
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(7) Moisten a clean stick R with the cleaning solution.
<IMPORTANT>
. Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

: Clean stick R
Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0246
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(8) With the clean stick R, wipe away the ink mist on the carriage roller part.

(9) Move the carriage from side to side to rotate the roller part, and wipe all around the carriage roller.

e ™
Carriage roller

Carriage Clean stick R

X0249

(10) Clean the carriage guide shaft and the three sides (upper, front, and lower sides across which the roller rolls) of

roller guide.

<TIPS>

. Moisten a waste cloth (non-fuzzy cloth) with a small amount of alcohol, and use such cloth to wipe clean the internal
surface.

. Do not use alcohol on parts other than the carriage guide shaft and the roller guide.

(11) Apply a proper amount of the grease (which is included with the printer) onto the carriage guide shaft.

<CAUTION>
. When handling the grease, perform the work operation in such a manner that it will not get into your eyes or onto your skin.

Front cover

Roller guide

Carriage guide shaft
X0063
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(12) Insert the two latches under the encoder cover and fix the cover with three screws.
(13) Close the front cover.

(14) Turn on the power.
<NOTE>
. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>
. Then, a head cleaning will be performed to prevent any ink from drying up.
. Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.

(15) Adjust the carriage speed.
<TIPS>
° For details, refer to "7-4-1. CR (Carriage) speed adjustment >>P.212".

(16) Print out a nozzle check pattern.
<TIPS>
. For details, refer to "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.192".
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7-1-6. Replacing the fan filter

When a warning message appears in the warning message window, replace the fan filter with a new one.

(1)
()

@)
(4)

O Warning

Fan Filter To Be Replaced

_ BN

Make the gloves which come standard with the printer, as well as a new fan filter, available for use.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

. Pressing @ will not move the platen or head if the error and warning displayed are [Fan Filter To Be Replaced] only.

Follow the on-screen message and turn off the power.

Remove the fan filter from the main unit of printer.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Fan filter

X0061
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Precautions to keep good printing quality/use printer over the long term >
(5) Mount a new fan filter to the frame of filter case.
<IMPORTANT>
. Mount the fan filter properly in correct position in such a way that its coarse mesh surface faces toward the inner area of
printer.

Toward the inner area of printer

b S

Toward the fan

y

Fan filter

Filter case

Coarse mesh surface )
Fine-meshed surface

X0062

(6) Mount the assembled fan filter in the main unit of printer.

(7) Turn on the power.
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
<TIPS>
. Then, a head cleaning will be performed to prevent any ink from drying up.

191



7-2. Tasks to be performed when needed

7-2-1. Print out of the nozzle check pattern (checking on the print heads)

Precautions to keep good printing quality/use printer over the long term >

By printing out a nozzle check pattern, you can check on the printing quality.
It is recommended to always perform this procedure to verify the output.

1

(2)

©)

(4)

(5)

<TIPS>
. The serial number, firmware version, and print date (day/month/year) and time are printed at the bottom of the nozzle check
pattern.

The date and time will be printed in Coordinated Universal Time with "(UTC)" printed at the end if time adjustment as a
maintenance tool has not been made. You can print the date and time according to your environment by making time
adjustment. For details of time adjustment, refer to "7-4-6. Setting of the time displayed on the nozzle check pattern
>>P217".

Put the platen 14X16 in place, and position its level at "A".

<TIPS>
. For details, refer to "6-4-1. Replacing the currently used platen with another one >>P.128" and "6-4-2. Platen height
adjustment >>P.131".

As illustrated below, put the Ad-size or letter-size white paper on the platen in alignment with the right-hand corner

of the platen at its front edge.

When the paper is loosely fitted, fix its edge with a tape or the like.
AT-shirt can also be used instead.

<TIPS>

. When printing out a nozzle check pattern on the white side, print it on a pretreated black or dark color textile or black paper,
or a transparent sheet (such as OHP sheet).

Paper

Platen

\

X0043

From the menu, select [Test Print] > [Nozzle Check CMYK], and press @ .
Then, printing will begin.

After printing on the color side is completed, remove the printed paper and replace it with a paper for printing on the

white side.

From the menu, select [Test Print] > [Nozzle Check White], and press @ .
Then, printing will begin.
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(6) Check to see if the printed result of both sides are acceptable, and if no ink-jet droplets have been ejected, perform

a head cleaning for print heads.

<IMPORTANT>

. If the print result shows an intermittent line, non-ejection has occurred. A head cleaning should be performed on the print
head that has a poor nozzle check result.

. Even if the lines of the white-side printed result are light, since white ink is fired from more than one nozzle on the same
place, the quality is not affected.

<TIPS>

° For details, refer to "7-2-2. Head cleaning >>P.194".

On the color side On the white side

Non-ejection occurred at the arrowed area. Non-ejection occurred at the arrowed area.

Example: Example:

X0241
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7-2-2. Head cleaning

This printer has been designed to perform the Auto Cleaning every time 24 print jobs are printed after the previous Auto
Cleaning, or before starting the printing using the white ink when one hour or more elapses after the previous printing
that used the white ink.

<TIPS>

. The frequency and start timing of Auto Cleaning can be changed. For details, refer to "8-2. Auto Cleaning Setting >>P.225".

In the event that there is any faintly printed or missing portion on a printed material, head cleaning sometimes provides a
solution.

Pressing the head cleaning button to perform the head cleaning

(1) While the printer is in standby mode, press §\'=7 on the operation panel.

(2) Bypressing A / V¥, selectone of the options; [All Print Heads], [All Colors] or [All Whites], and press @ .

Then, a normal cleaning will be performed for the selected print heads.

<TIPS>

. Under the condition that the nozzle which has been confirmed with reference to "7-2-1. Print out of the nozzle check pattern
(checking on the print heads) >>P.192" is not ejecting ink-jet droplets, determine the print heads for which the head
cleaning should be performed.

. The cleaning operation cannot be canceled halfway.

3 After the procedures are completed, the current screen will go back to the standby mode screen.

Normal Cleaning
All Print Heads

All Colors

All Whites
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Precautions to keep good printing quality/use printer over the long term >

Selecting a type of head cleaning from the menu to perform the head cleaning

(1) While the printer is in standby mode press @ on the operation panel to bring the menu screen into the view.

()

©)

(4)

(S)

From the menu, select [Head Cleaning], and press @ .

Menu

Head Cleaning

Test Print
Print Data Load

Receiving History

Maintenance

By pressing A /¥, select one of the options: [Normal Cleaning], [Powerful Cleaning], [Super Cleaning] or [Flash
Firing],and press @ .

<TIPS>
3 For selecting a desired cleaning option, follow the instructions of each procedural step described in "9-2-1. Recovery action
to be taken for such a nozzle that is unable to eject ink-jet droplets >>P.251".

Head Cleaning
Normal Cleaning
Powerful Cleaning
Super Cleaning
Flash Firing

By pressing A /¥, select one of the options: [Normal Cleaning], [Powerful Cleaning], [Super Cleaning] or
[Flushing], and press @ .

<TIPS>

. Under the condition that the nozzle which has been confirmed with reference to "7-2-1. Print out of the nozzle check pattern
(checking on the print heads) >>P.192" is not ejecting ink-jet droplets, determine the color(s) of print heads for which the
head cleaning should be performed.

Normal Cleaning
All Colors

All Whites

All Print Heads
Black

Yel low Cyan Magenta

Then, the head cleaning will be performed for the specified print heads.

<TIPS>

. The cleaning operation cannot be canceled halfway.

. After the procedures are completed, the current screen will go back to the standby mode screen.
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7-2-3. White ink circulation

When whiteness is not enough, it may be solved by performing white ink circulation.

(1) While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.

(2) From the menu, select [Maintenance] > [White Ink Circulation], and press @ .
<TIPS>

. Time required for completing the white ink circulation varies depending on the ambient temperature. Generally it takes 6
minutes; however can take up to 15 minutes. If you are activating the printer after having had its power off for a long period,
it will take up to 40 minutes.

White Ink Circulation
All Whites

[ 1Imin[30]sec

Please Wait

(3) When the white ink circulation is completed, perform white ink refilling by reference to "6-2-3. Daily agitation of the

white ink >>P.112".

196



Precautions to keep good printing quality/use printer over the long term >

7-2-4. Set the scheduled time for white ink circulation

White ink circulation can be performed at a specified time. If not set, white ink circulation will be performed automatically
every seven hours.

(1) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.
(2) On the PC, from [All Programs] in the Start menu, select the "GTX-4 Maintenance" of "Brother GTX-4 Tools".

(3) After the window shown below appears, select [Set the scheduled time for white ink circulation] and click [Next].

&7 Brother GTX-4 Maintenance @

Confirm the printer is turned ON and connected to your PC.
Select the printer.,

Virtual printer hd ] [ Search

Select an item from the menu below and dick Next”.

~) Initial settings after head replacement
Perform this setting when replacing the head or when setting up the printer onby.

() Firing Adjustment
Adjust this setting when the edges of the print lock vague, solid areas are not even, or after 2 Print Head is replaced.

() Platen-rolling adjustment

Mzke adjustments when horizontal stripes {(banding) occur in the printed image. Use this adjustment as =
troubleshooting method when other items such as proper temperature and humidity have zlready been wverified,

~) White/Color Alignment
Adjust when white print does not align with color print.

(7) Set an IP Adrress
Assign a static IP address to the printer,

() Log Data Retrieval
Execute if thers was a request after troubleshooting service,

" Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulstion.
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Precautions to keep good printing quality/use printer over the long term >

(4) After the window shown below appears, select [Set the scheduled time for white ink circulation.] and click [Next].
§/ Brother GTX-4 Maintenance i

Step 1:
Set or cancel the scheduled time for white ink circulation,

(7 Cancel the scheduled time for white ink drculation.

- If the scheduled time of white ink droulation is not set, the white ink droulation is automatically turned ON every
seven hours.

- You cannot set the scheduled time in such @ manner that the length of the intervals of white ink draulation is
longer than seven hours,
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(5) Set the scheduled time for white ink circulation and click [Next].

<CAUTION>

. Confirm that the date and time of your PC are set correctly, and continue.

. Enter four or more start time settings.

3 You cannot set the scheduled time in such a manner that the length of the intervals of white ink circulation is longer than
seven hours.

. Input a time range of "0:00" to 23:59".

<TIPS>

. You can check on the main unit the scheduled time you set. To check the circulation schedule, refer to "8-24. Check

circulation schedule >>P.238".

(7 Brother GTX-4 Maintenance

==

Step 2:
Set the scheduled time for white ink circulation,

Current time 13:18

Start time for white ink droulation

1 @ @ M

5 ) @ ' &l

continue.

- Enter the start time for white ink droulation.

-Input a time range of "0:00" to 23:59%,
For example, when setting the time "8:00," either "800 or "8:00" can be input.

-Enter four or more start time settings.

longer than seven hours,

Confirm that the date and time of your PC is set for 2018 or later and

- You cannot set the scheduled time in such & manner that the length of the intervals of white ink droulation is
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Precautions to keep good printing quality/use printer over the long term

7-2-5. Cleaning the CR (carriage) plate

>

Clean the carriage plate when it is contaminated with ink.
<TIPS>

(1

(2)

©)

(4)

(5)

You can use an already-used clean stick R.

Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available

for use.
<IMPORTANT>

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in a printer malfunction.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

3 If any other error or message is displayed on the operation panel or warning message window, follow the message to solve

the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

° If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.

Open the front cover.

Front cover

X0050

Put a proper amount of cleaning solution into the cleaning cup.
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(6) Moisten a clean stick R with the cleaning solution.
<IMPORTANT>
. If you use an already-used clean stick R, do not use it for other purposes than cleaning the carriage plate.
. Do not use other fluids (water, etc.), because they may damage the print heads.
3 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.
<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R

Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0246
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(7)

(8)

(9)

Precautions to keep good printing quality/use printer over the long term >

With the clean stick R, wipe away the accumulated ink on the carriage plate of the left-side of the print head.
<IMPORTANT>

. Be sure not to touch the nozzle surface.

<TIPS>

3 Manually move the carriage to such a position that you can perform the cleaning with ease.

Clean stick R

Contaminated with ink

Clean the carriage plate on the left side of the other print head in the same manner.
<IMPORTANT>
3 The used clean stick R should be disposed of, and should not be reused.

Close the front cover.

(10) Turn on the power.

<NOTE>

. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>

3 Then, a head cleaning will be performed to prevent any ink from drying up.

3 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
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7-2-6. Replacing the platen sheet

When the platen sheet gets soiled, replace it with a new one.

(1) Remove the platen from the main unit of the printer.
<TIPS>
. For details, refer to "6-4-1. Replacing the currently used platen with another one >>P.128".

(2) Peel the platen sheet off the platen.
<TIPS>

. When it is hard to peel the platen sheet off, warm it using a hair dryer or the like and peel it off.

Platen sheet

Platen
X0064

(3) Wipe the surface of the platen with a clean cloth moistened with a mild detergent which is diluted with water, then
wipe the platen clean with a dry and soft clean cloth.

(4) Mount the platen in the main unit of the printer.
<TIPS>

. For details, refer to "6-4-1. Replacing the currently used platen with another one >>P.128".

(5) Peel the release paper (small in size) off a new platen sheet.

Platen sheet

Release paper (small)

X0157
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(6) Position the platen sheet to match the platen surface, and onto the platen, stick the portion of the platen sheet

where the release paper (small) was removed.
<TIPS>
. If the 16X21 platen is used, slide it forward before working on it.

Platen sheet

Positioning

Platen

X0065

(7) Peel off the rest of the release paper, and paste the whole platen sheet onto the entire platen.
<TIPS>
. Straighten the platen sheet, and stick it properly while pressing it with hands outward from the center to avoid making
wrinkles.

Platen sheet

Release paper

Platen

X0066

(8) As required, print a grid pattern onto the new platen sheet.
<TIPS>
. For details, refer to "5-4-4. Printing a grid pattern onto platen sheet >>P.102".
. After the printing is completed, press down the printed surface lightly with a dry cloth or a sheet of paper to dry the ink.
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>

7-3. What to do in the White Ink Pause Mode

7-3-1. Disabling white ink

If you do not plan to use the white ink for 1 month or longer, it is recommended to set the printer to white ink pause mode.
This eliminates the necessity to maintain the white ink, and saves its consumption.
<TIPS>

(1
()
(3)

(4)

Although the white ink pause mode can be activated even when the remaining volume of maintenance solution in the
maintenance solution pouch is running short, there may be a case where the pouch needs to be replaced with a new one in the
middle of the process depending on such remaining volume. If the remaining volume is 500 g (17.6 oz) or less, prepare a new
maintenance solution pouch, follow the instructions on the screen to replace the pouch, and activate the mode again.

From the menu, select [Maintenance] > [White Ink Pause Mode] > [Enable].
Check the waste ink tank for its availability and take a necessary measure for it, if any, then press @ .

Remove the white ink cartridge from the printer.

<CAUTION>
. The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

( N\

=
= =
=
=

White Ink Cartridge
X0039

Open the cartridge's lid.

<IMPORTANT>

. When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged.

. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Lid

Cartridge

X0042
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(5) Pinch the latch at the front end of the ink pouch, and draw out the white ink pouch from the cartridge.

<CAUTION>
. Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular

basis.

White ink pouch

Cartridge's tip end

TG

Cartridge

Latch

X0119

(6) Put the maintenance solution pouch in the cartridge.
Push the tip end of the maintenance solution pouch into the cartridge until it clicks into place.
Straighten the maintenance solution pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount
into position by pulling it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

Maintenance solution pouch
\ —
Stretch
Ve
C
%\ \ \
Cartridge

X0049

(7) Put the maintenance solution pouch in its correct position.

<CAUTION>
. Avoid touching portion (a) of the cartridge. Otherwise, you may cut your hand.

Place the pouch in straight alignment with the cartridge

Align lines with
each other X0041
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(8) Close the lid, and put the maintenance solution cartridge in position inside the printer.

(9) Repeat the same process to replace the other white ink cartridge with the maintenance solution pouch.

(10) On the operation panel, press @ .

Then, the white ink will be replaced with the maintenance solution.
<TIPS>

After the procedures are completed, the current screen will go back to the standby mode screen.

Always keep the maintenance solution cartridge placed in its position.

To restart printing with the white ink, perform the operations instructed in "7-3-2. Reusing White Ink >>P.208".
If the maintenance solution pouch runs out, replace the maintenance solution pouch with a new one.
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7-3-2. Reusing White Ink

Perform the following operations when you restart printing with the white ink after activating the white ink pause mode.
(1) From the menu, select [Maintenance] > [White Ink Pause Mode] > [Disable].
(2) Check the waste ink tank level and take a necessary measure for it, if any, then press @ .

(3) Remove the maintenance solution cartridge from the printer.

<CAUTION>
3 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

e N
1]

N

W12 W34

I\

Maintenance solution cartridge

X0039

(4) Open the cartridge's lid.
<IMPORTANT>
e  When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged.
. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Cartridge Lid

X0042
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(5) Remove the maintenance solution pouch from the cartridge, and put the white ink pouch in place.
Push the tip end of the ink pouch into the cartridge until it clicks into place.
Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of cartridge, and mount in position by
pulling it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

White ink pouch

Stretch
&
C
& I )
: Cartridge
X0049
(6) Make sure that the white ink pouch is set in its correct position, to close the lid.
<CAUTION>
° Avoid touching portion (a) of cartridge. Otherwise, you may cut your hand.
(a) Place the pouch in straight alignment with the cartridge
Align lines with
each other X0041

(7) Shake the cartridge 100 times side to side to stir the ink.

<IMPORTANT>

. The white ink cartridge should be held horizontally when shaking it.

. Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch.

<NOTE>

. Wear the provided gloves when performing this task.

. When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the
edge of the ink pouch slightly winded, to make the ink easier to stir.

Edge of the rib
White Ink Cartridge ge of the ri

emaining ink volume should
be approx. 5.9 in. (15 cm)

Shake 100 times (for approx. 50 seconds)
(Swing distance should be approx. 2 in. (5 cm). X0194
Increase the swing distance when the remaining

ink level becomes low.)
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(8) Open the lid of the cartridge and place the ink pouch in its correct position.

<IMPORTANT>

. Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow
into the wound section of the pouch when stirred, causing improper winding of the pouch.

3 When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge
downward and open the lid.

. When setting the ink pouch, avoid unevenness or wrinkles on the pouch.

e  When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

<NOTE>

3 If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid.

Cartridge Lid

X0182
|
]
Lid
/
| —
X0078
Ink pouch No wrinkles \
. B
Not sagged
X0142

(9) Close the lid, and put the white ink cartridge in position inside the printer.

<IMPORTANT>
. W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause
printer malfunction.

(10) Repeat the same process to replace the other maintenance solution cartridge with the white ink pouch.
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(11) On the operation panel, press @ .

Then, the white ink will be installed.
<TIPS>

When the white ink pouch runs low on its remaining volume of white ink, the Install Ink function can no longer get started.
Furthermore, there may be cases where the pouch needs to be replaced with a new one during the installation process of
white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow the instructions on the
screen to replace the pouch, and activate the mode again.

After the procedures are completed, the current screen will go back to the standby mode screen.
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7-4. Adjustment

7-4-1. CR (Carriage) speed adjustment

Carriage speed should be adjusted when the error message [Adjust CR] is displayed on the operation panel. Adjustment
should always be performed when carriage shaft cleaning or print head replacement tasks are carried out, or after
completing the setup procedures.

(1) While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.
(2) From the menu, select [Printer Setting] > [CR Speed Adjustment], and press @ .

(3) Select [Start] or [Start (after cleaning/setup)] and press @

e [Start]: If you cannot clean the internal area of the printer such as carriage shaft immediately after the head
replacement or when the error message is displayed.
o [Start (after cleaning/setup)]: After cleaning the carriage shaft.

Wait until the carriage stops moving and the sound of pong is heard.

It takes about 3 minutes to adjust the carriage speed.

CR Speed Adjustment
Auto Adjusting

Please Wait
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7-4-2. Initial settings after head replacement

Set V-rating after replacing the print head or completing the setup procedure.

(1) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.

(2) On the PC, from [All Programs] in the Start menu, select the "GTX-4 Maintenance" from "Brother GTX-4 Tools".
(3) After the window shown below appears, select [Initial settings after head replacement] and click [Next].

7 Brother GTX-4 Maintenance @

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Virtual printer hd ] [ Search

() Firing Adjustment
Adjust this setting when the edges of the print lock vague, solid areas are not even, or after a Print Head is replaced.

() Platen-olling adjustment

Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as 2
troubleshooting method when other items such as proper temperature and humidity have zlready been wverified,

) White/Color Alignment
Adjust when white print does not align with color print.

(7) Set an IP Adrress
Assign a static IP address to the printer.

*) Log Data Retrieval
Execute if thers was a request after troubleshooting service,

() Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulstion.

() Set the scheduled time for white ink circulation
Configure this setting to set or cancel the scheduled time for white ink circulation.

(4) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.

213



Precautions to keep good printing quality/use printer over the long term >

7-4-3. Firing adjustment

Because the ejection timing varies depending on the platen's height and properties of each print head, this function is
provided to adjust the ejection timing for each print head when any print head is replaced with a new one or after the
completion of the setup procedure, for instance. If you want to make adjustments after replacing the print head,
configure the initial settings after print head replacement before you do so.

(1) Make several sheets of Ad-size or letter-size paper (black paper or transparent sheet such as OHP sheet, and

white paper) available for use.

(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.

(3) On the PC, from [All Programs] in the Start menu, select the "GTX-4 Maintenance" from "Brother GTX-4 Tools".

(4) After the window shown below appears, select [Firing Adjustment] and click [Next].

@ Brother GTX-4 Maintenance

sl

Select the printer.

Confirm the printer is turned ON and connected to your PC.

Virtual printer

- ] [ Search

() Initial settings after head replacement

() Platen-rolling adjustment
) White/Color Alignment
(7) Set an IP Adrress

Assign a static IP address to the printer.

(7) Log Data Retrieval

() Set the scheduled time for white ink drculation

Select an item from the menu below and dick Next™.

Perform this setting when replacing the head or when setting up the printer onky.

when the edges of the print look vague, solid areas are not even, or after a Print Head is replaced.

Mzke adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as =
troubleshooting method when other items such as proper temperature and humidity have zlready been wverified,

Adjust when white print does not align with color print.

Execute if there was a request after troubleshooting service.

") Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulstion.

‘Configure this setting to s=t or cancel the scheduled time for white ink circulstion.

(5) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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7-44. Platen feed adjustment

Platen feed adjustment should be performed after replacing the print head or completing the set up procedure.
If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement
and adjust the firing timing before you do so.

(1) Make several sheets of Ad-size or letter-size white paper available for use.
(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.
(3) On the PC, from [All Programs] in the Start menu, select the "GTX-4 Maintenance" from "Brother GTX-4 Tools".

(4) When the window shown below is displayed, select [Platen-Rolling Adjustment] and click [Next].

&7 Brother GTX-4 Maintenance @

Confirm the printer is turned ON and connected to your PC.
Select the printer.,

Virtual printer hd ] [ Search

Select an item from the menu below and dick Next”.

~) Initial settings after head replacement
Perform this setting when replacing the head or when setting up the printer onby.

() Firing Adjustment
Adjust this setting when the edges of the print lock vague, solid areas are not even, or after 2 Print Head is replaced.

. Mzke adjustments when horizontal stripes {(banding) occur in the printed image. Use this adjustment as =
troubleshooting method when other items such as proper temperature and humidity have already been verified,

O e P
Adjust when white print does not align with color print.

(7) Set an IP Adrress
Assign a static IP address to the printer,

() Log Data Retrieval
Execute if thers was a request after troubleshooting service,

" Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulstion.

() Set the scheduled time for white ink drculation
Configure this setting to set or cancel the scheduled time for white ink circulation.

(5) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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Precautions to keep good printing quality/use printer over the long term

7-4-5. White/color alignment

This is the adjustment function to align the print position on the white side with the print position on the color side. Adjust
white/color alignment after replacing a print head or completing the setup procedure.

If you want to make adjustments after replacing the print head, configure the initial settings after print head replacement
and adjust the firing timing and platen feed before you do so.

(1) Prepare a sheet of black paper or a pretreated black or dark color T-shirt.
(2) Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.
(3) On the PC, from [All Programs] in the Start menu, select the "GTX-4 Maintenance" from "Brother GTX-4 Tools".

(4) After the window shown below appears, select the [White/Color Alignment] and click [Next].

7 Brother GTX-4 Maintenance @

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Virtual printer hd ] [ Search

Select an item from the menu below and dick Next”.

() Initial settings after head replacement
Perform this setting when replacing the head or when setting up the printer only.

~ Firing Adjustment
Adjust this setting when the edges of the print lock vague, solid areas are not even, or after 2 Print Head is replaced.

() Platen—olling adjustment
Make adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as 2
ure and humidity have already been verified.

loes not align with color print.

") Set an IP Adrress
Assign a static IP address to the printer.

(7) Log Data Retrieval
Execute if there was a request after troubleshooting service.

() Setting of the time displayed on the nozzle check pattern
This is not necessary if you have configured the scheduled time for white ink circulstion.

~) Set the scheduled time for white ink droulation
Configure this setting to set or cancel the scheduled time for white ink circulation.

(5) Perform the required operation by following the on-screen instructions in the dialog box.
After the adjustment is completed, the currently displayed screen will go back to the window mentioned above.
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Precautions to keep good printing quality/use printer over the long term

7-4-6. Setting of the time displayed on the nozzle check pattern

>

Set the time displayed on the nozzle check pattern.

(1)
()
©)

Make sure that a connection of USB 2.0 cable or LAN cable is made between the printer and your PC.
On the PC, from [All Programs] in the Start menu, select the "GTX-4 Maintenance" of "Brother GTX-4 Tools".

After the window shown below appears, select [Setting of the time displayed on the nozzle check pattern] and click

[Next].

@ Brother GTX-4 Maintenance

sl

Confirm the printer is turned ON and connected to your PC.
Select the printer.

Virtual printer hd ] [ Search

Select an item from the menu below and dick Next™.

() Initial settings after head replacement
Perform this setting when replacing the head or when setting up the printer cnky.

() Firing Adjustment

Adjust this setting when the edges of the print lock vague, solid areas are not even, or after 2 Print Head is replaced.

~ Platen-roliing adjustment
Mzke adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as =

troubleshooting method when other items such as proper temperature and humidity have zlready been wverified,

() White/Color Alignment
Adjust when white print does not align with color print.

(7) Set an IP Adrress
Assign a static IP address to the printer.

" Log Data Retrieval
Execute if there was a request after troubleshooting service.

- This is not necessary if you have configured the scheduled time for white ink circulstion.

() Set the scheduled time for white ink drculation
‘Configure this setting to s=t or cancel the scheduled time for white ink circulstion.

Close
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Precautions to keep good printing quality/use printer over the long term

(4) Perform the required operation by following the on-screen instructions in the dialog box.
<CAUTION>
. Confirm that the date and time of your PC are set correctly, and continue.

Y Brother GTX-4 Maintenance w

Step 1:
Set the time displayed on the nozzle check pattern,

Current time 17:48

Confirm that the date and tme of your PC is set for 2018 or later and
continue.

- Set to the above mentioned time.

[ <bace | hea> § [ concel |

(5) After the setting is completed, the currently displayed screen will go back to the Main screen.

GTX-4 Maintenance W

Time has been set.
Return to Main screen.
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Precautions to keep good printing quality/use printer over the long term

7-5. When Not Using for a Long Period of Time

When the printer will not be used for a prolonged period of time, take appropriate procedures before storing the printer

depending on storage period or condition.

<IMPORTANT>

. Do not turn the printer off. Otherwise, the printer may be damaged.

. If the power source to the printer cannot be sustained, please contact your dealer in advance.

<NOTE>

. If any error message is displayed on the screen, follow the instructions.

. When storing the printer for more than two weeks, cleaning of the nozzle guard, wiper and exhaust cap should be performed. For
details, refer to "7-1-2. Cleaning the nozzle guard, wiper, exhaust cap, and suction cap >>P.166".

7-5-1. When Not Using for a Long Period of Time: within 2 weeks

The printer can be used through normal procedure after the storage period, by performing the following maintenance
tasks.

(1) Check the amount of waste ink in the waste ink tank, and if the tank is filled with waste ink up to its one-half or

higher level, discard the ink.
<TIPS>
° Refer to "6-2-1. Confirmation and disposal of waste ink >>P.110".

(2) Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the

proper level.
<TIPS>
. Refer to "6-2-2. Confirmation and replenishment of cleaning solution >>P.111".

(3) Stir the white ink if a white ink cartridge stirring message is displayed on the operation panel screen.
<TIPS>
. Refer to "6-2-3. Daily agitation of the white ink >>P.112".

(4) As required, print out a nozzle check pattern.
<TIPS>
. For details, refer to "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.192".
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Precautions to keep good printing quality/use printer over the long term >

7-5-2. When Not Using for a Long Period of Time: more than 2 weeks

Perform the following maintenance every two weeks.

(1)

()

@)

(4)

(5)

Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or

higher level, discard the ink.
<TIPS>
. Refer to "6-2-1. Confirmation and disposal of waste ink >>P.110".

Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the

proper level.
<TIPS>
. Refer to "6-2-2. Confirmation and replenishment of cleaning solution >>P.111".

Stir the white ink if a white ink cartridge stirring message is displayed on the operation panel screen.
<TIPS>
. Refer to "6-2-3. Daily agitation of the white ink >>P.112".

Print out a nozzle check pattern and verify the result.
<TIPS>
. For details, refer to "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.192".

If a non-firing nozzle is found, perform head cleaning and run the nozzle check pattern print, and verify the result

again.
<TIPS>
. For details, refer to "7-2-2. Head cleaning >>P.194".

7-5-3. When Not Using for a Long Period of Time: within 2 weeks with white ink pause mode

The printer can be used through normal procedure after the storage period, by performing the following maintenance
tasks.

(1

()

©)

Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or

higher level, discard the ink.
<TIPS>
. Refer to "6-2-1. Confirmation and disposal of waste ink >>P.110".

Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the

proper level.
<TIPS>
. Refer to "6-2-2. Confirmation and replenishment of cleaning solution >>P.111".

As required, print out a nozzle check pattern for the color side.

<TIPS>

. For details, refer to "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.192".
. For the White ink pause mode, print the nozzle check patterns for the head only on the color side.
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7-5-4. When Not Using for a Long Period of Time: more than 2 weeks with white ink pause mode

Perform the following maintenance every two weeks.

(1)

()

@)

(4)

(5)

Check the amount of waste ink in the waste ink tank, and if the tank is filled with the waste ink up to its one-half or

higher level, discard the ink.
<TIPS>
. Refer to "6-2-1. Confirmation and disposal of waste ink >>P.110".

Check the amount of cleaning solution in the cleaning liquid tank, and refill the tank when its amount is below the

proper level.

<TIPS>

. Refer to "6-2-2. Confirmation and replenishment of cleaning solution >>P.111".

Print out a nozzle check pattern on the color side and verify the result.

<TIPS>

. For details, refer to "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.192".
. For the White ink pause mode, print the nozzle check patterns for the head only on the color side.

If a non-firing nozzle is found, perform head cleaning and run the nozzle check pattern print, and verify the result

again.
<TIPS>
. For details, refer to "7-2-2. Head cleaning >>P.194".

Perform the normal white head cleaning.
<TIPS>
. For details, refer to "7-2-2. Head cleaning >>P.194".

221



n What to do when needed

As required, make settings and adjustments as mentioned below.

About menu layer on the setting screen

Menu

[Printer Setting]

Setting screen Description
[Auto]
[Print Direction] [Always Bi-Directional]
[Always Uni-Directional]
[Light High]
[Back Light] [Light Medium]
[Light Low]

[No Auto Screen Erase]

[5 min]

[Auto Screen Erase Time] [10 min]
[15 min]
[30 min]
[1min]
[Menu TimeOut Setting] [Bmin]
[5min]
[Speaker Volume] Oto7
[Temperature] [Fahrenhett]
[Centigrade]
[Preview display settings] [display it upward]

[display it downward]

[File name display setting]

[Priority to file name display]

[Priority to job name display]

[Obstcl sensr settng during print]

[Check when platen is loading]

[Check during printing as well]

. [Check]
[Cartridge Attach/Remove Check]
[No check]
[Enable(Normal)]
[Low Temperature Mode] -
[Disable]
[Auto Cleaning Setting] 1t024
Conduct before Printin
[Auto Cleaning Start Timing] [ — 9]
[Conduct after Printing]
Start
[CR Speed Adjustment] ! ] :
[Start (after cleaning/setup)]0
- [Standard]
[Wiping frequency]

[High

[Flushing Interval Setting]

[every 40 lines]

[normal 22 lines]

[every 10 lines]

[every 6 lines]

[Flushing Volume Setting]

[More]

[Standard]

[Less]

[Auto Job Delete]

[OFF]

[ON]

[Revng Prnt Setting]

[Enable]

[Disable]
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Setting screen

Description

[Network filtering]

[Enable]

[Disable]

[IP Address Set]

[Manual setting]

[Automatic acquisition]

[Total Print]

[Temperature/Humidity Info]

[Confirm network setting]

[IP Address]

[Subnet Mask]

[Default Gateway]

[Host name]

[MAC address]

[CTG Attach/Remove History]

[Check circulation schedule]

[Language]

[English]

[Espariol]

[Frangais]

[Deutsch]

[Italiano]

GEXS

[Fx]

[Version]

[Firm Version]

[Data Info]

[Serial No.]
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What to do when needed >

8-1. Setting the print direction

(1) From the menu, select [Printer Setting] > [Print Direction], and press @ .

(2) Select your desired print direction of the print heads, and press @ .

<TIPS>

. The print direction is displayed here in the form of either bi-directional or the uni-directional icon

—>
-

. Note that the setting of the print direction gives priority to the printer's setting over the setting of the printer driver.

. The setting content will be kept intact until it is changed for the next printing job.
Print Direction
Auto

Always Bi-Directional

Always Uni-Directional
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8-2. Auto Cleaning Setting

Setting the Number of Printed Sheets for Auto Cleaning

Specify the number of printed sheets as the frequency of Auto Cleaning; where head cleaning is automatically
performed every time a predetermined number of sheets are printed in order to protect the printer and provide stable
printing quality. If the printing quality deteriorates in continuous printing, decrease the number of printed sheets for Auto
Cleaning. The default value is 24.

(1) From the menu, select [Printer Setting] > [Auto Cleaning Setting], and press @ )

(2) Press A ./ 'V tosetupthe number of sheets to be printed in the range between 1 and 24, and press @ .

<TIPS>

. The printing quality tends to deteriorate if the humidity is low.

° If the auto cleaning is performed more frequently, the Wiper cleaner and flushing foam will need to be replaced with a new one
earlier.

Auto Cleaning Setting

Y

Set to OK to Confirm

Auto Cleaning Start Timing
Specify your desired auto cleaning start timing.
(1) From the menu, select [Printer Setting] > [Auto Cleaning Start Timing], and press @ .

(2) Select your desired auto cleaning start timing, and press @ .

<TIPS>
o Even when [Conduct after Printing] is selected, Auto Cleaning may be performed before printing, depending on the state of use.

Auto Cleaning Start Timing
Conduct before Printing

Conduct after Printing
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8-3. Flushing Interval Setting

Perform this if the printing quality deteriorates during printing operations.
(1) From the menu, select [Printer Setting] > [Flushing Interval Setting], and press @ .

(2) Select the desired number of scanning operations until the flushing starts, and press @ .

<TIPS>

. The printing quality tends to deteriorate during the printing operation if the humidity is low.

o Setting shorter flushing intervals improves the printing quality, however, increases the ink consumption and increases the time
required for printing.

Flushing Interval Setting

every 40 |ines

normal 22 |ines
every 10 lines
every B. |ines

8-4. Flushing Volume Setting

Perform this if the printing quality deteriorates at the startup of the printing operation.
(1) From the menu, select [Printer Setting] > [Flushing Volume Setting], and press @ .

(2) Select your desired volume of ink to be ejected from the print heads during the flushing operation before the

printing operation starts, and press @ .

<TIPS>
° The printing quality tends to deteriorate at the startup of the printing operation if the humidity is low.
. Setting larger flushing volume improves the printing quality, however, increases the ink consumption.

Flushing Volume Setting
More

Standard

Less
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8-5. Wiping frequency settings

Perform this if the white printing quality deteriorates while printing.
(1) From the menu, select [Printer Setting] > [Wiping frequency], and press @ .

(2) Select the target [Wiping frequency] while printing, and press @ .

<TIPS>

o The printing quality tends to deteriorate while printing if the temperature is low.

. Frequent wipes will improve the printing quality, which, however, will take more time to print.

Wiping freguency
Standard
High

8-6. Print Operation Settings Under Low Temperature

Configure the printer with automatic switching to low temperature operation mode for ensuring print quality when [Temp
Low] is displayed on the liquid crystal panel. It is set to [Enable(Normal)], by default.

If the low temperature operation mode is enabled, the printer will automatically be switched to the low temperature
operation. Although it can assure print quality, it may take longer time for printing.

If the low temperature operation mode is disabled, print speed will not slow down; however, poor ejection may occur.

(1) From the menu, select [Printer Setting] > [Low Temperature Mode], and press @ .

(2) Select the print mode under low temperature and press @ .

<TIPS>
e  When [Disable] is selected, white ink injection may become unstable when trying to print a wide area.

Low Temperature Mode
Enable(Nomal)

Disable
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8-7. Screen back light adjustment

(1) From the menu, select [Printer Setting] > [Back Light], and press @ .

(2) Select your desired brightness of Liquid crystal panel, and press @ .

<TIPS>
. During this menu selection process, the screen is displayed with the selected brightness.

Back Light
Light High

Light Medium

Light Low

8-8. Setup of Auto Screen Erase Time

(1) From the menu, select [Printer Setting] > [Auto Screen Erase Time], and press @ .

(2) Select your desired time until the liquid crystal panel and print button become unlit, and press @ .
<TIPS>

. During this menu selection process, the currently selected set value is displayed.
Auto Screen Erase Time
No Auto Screen Erase

5 min

10 min
15 min
30 min
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8-9. Setting the menu timeout period

(1) From the menu, select [Printer Setting] > [Menu TimeOut Setting], and press @ .

(2) Select the time before the display screen returns to the standby mode screen, and press @ .

<TIPS>
. During this menu selection process, the currently selected set value is displayed.

Menu TimeOut Setting

Tmin
3min

Bmin

8-10. Speaker volume adjustment

(1) From the menu, select [Printer Setting] > [Speaker Volume], and press @ .

(2) Adjust the speaker volume in eight-step scale from 0 to 7, and press @ .

<TIPS>
. You can adjust the volume while checking it.

Speaker Volume

)

Set to OK to Confirm

8-11. Setup of temperature indication
(1) From the menu, select [Printer Setting] > [Temperature], and press @ .
(2) Select your desired unit of ambient temperature to be shown on the liquid crystal panel, and press @ .
Temperature
Fahrenheit

Centigrade
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8-12. Automatic deletion of print data

(1) From the menu, select [Printer Setting] > [Auto Job Delete], and press @ .
(2) Select the desired function of Auto Job Delete, and press @ .

Auto Job Delete

OFF

What to do when needed >

ON

8-13. Settings to start printing during reception of data

When sending created print data from your PC to the printer, you can press the print button to start printing before the
data reception is completed. In the initial setting, [Disable] is selected.

(1) From the menu, select [Printer Setting] > [Rcvng Prnt Setting], and press @ .
(2) Select the receiving print setting, and press @ .

<TIPS>

. Use the "Brother GTX-4 FileOutput" printer driver for file output to create print data (ARX4 file) in advance, and then use the
created print data in data sending operation from "GTX-4 File Viewer" to the printer.

o When sending any print data created during the operation directly to the printer without creating such ARX4 file, please select the
[Disable] in the [Revng Prnt Setting].

o When starting printing during reception of print data, if transferring of the print data from your PC is interrupted for a while
exceeding the specified time, the printer will get into error state. If such error occurs, with reference to "7-2-1. Print out of the
nozzle check pattern (checking on the print heads) >>P.192", print a nozzle check pattern to check the print head status.

As required, with reference to "7-2-2. Head cleaning >>P.194", perform the head cleaning.

Rcvng Prnt Setting
Enable

Disable
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>

8-14. Static IP address setting

In the [IP Address Set] window, select the manual setting or automatic acquisition, and set up the [IP Address], [Subnet
Mask] and [Default Gateway] when you select the manual setting.

From the menu, select [Printer Setting] > [IP Address Set], and press @ .

™
@)

@)
(4)
(5)

[P Address Set |P Address Set
IP Address Subnet Mask

0K to Subnet Mask Screen OK to Gateway Screen

192.168.000.001 255.255.255.000

Select either [Manual setting] or [Automatic acquisition] and press @ .
<TIPS>

. If you select [Automatic acquisition], the screen will go back to the standby mode screen after the settings are automatically

acquired.
IP Address Set
Automatic acquisition

Manual setting

To make manual settings, press 4 ./ P to move to and select your desired position.

To make manual settings, press A /¥ to specify your desired numeric value.

When the @ button is pressed, the selected value is accepted, and the display screen goes to the [IP

Address], [Subnet Mask] and [Default Gateway] in an orderly manner.
<TIPS>

. The display screen shown here has been taken as an example.
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8-15. Preview display settings

Set the display direction of the preview image.

(6) From the menu, select [Printer Setting] > [Preview display settings], and press @ .

(7) Select the display direction and press @ .
<TIPS>

. During this menu selection process, the currently selected set value is displayed.
Preview display settings
display it upward

display it downward

8-16. File name display setting

Make file name display settings of print data.

The display name you set is reflected in the selection screen of standby mode or receiving history or the USB memory
loading screen.

(1) From the menu, select [Printer Setting] > [File name display setting], and press @ i

(2) Select the display method and press @ .
<TIPS>

. The job name is set automatically by the image editing application.
File name display setting
Priority to file name display 0K
Priority to job name display
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8-17. Configuring the obstacle sensor to work during the printing process

Specify the detection mode of the obstacle sensor by selecting either [Check when platen is loading] or [Check during
printing as well].

(1) From the menu, select [Printer Setting] > [Obstcl sensr settng during print], and press @ .

(2) Select the obstacle sensor setting and press @ .

<TIPS>

During this menu selection process, the currently selected set value is displayed.

The obstacle sensor is intended to detect wrinkles of the print media or foreign object on it to prevent the print head from
contacting wrinkles or foreign matter or minimize the time during which the contact continues.

If the print head comes into contact with wrinkles or foreign object, a failure to eject ink-jet droplets or a mechanical failure may
occur.

If the obstacle sensor detects a foreign object, the printing process and the platen operation are immediately stopped.

If you select [Check when platen is loading], the obstacle sensor works only while the platen is moving from the front to the rear.
If you select [Check during printing as well], the obstacle sensor works during the period from when you press the print button to
when the printing process completes.

Obstcl sensr settng during print

Check when platen is loading

Check during printing as well
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8-18. Cartridge Attach/Remove Check

This check function prevents the agitation omission and insufficient agitation of the white ink cartridge.
Enable or disable this function when using the printer.

Agitate the white ink cartridge if the white ink cartridge stirring message is displayed.

<TIPS>

o Refer to "6-2-3. Daily agitation of the white ink >>P.112".

. It takes about 60 to 120 seconds to agitate the W12 or W34 cartridge.

. If the period in which each cartridge is removed is less than 60 seconds, you cannot move to the next screen by pressing @

while the white ink cartridge stirring message is displayed.

(1) From the menu, select [Printer Setting] > [Cartridge Attach/Remove Check], and press @ .
(2) Select either [Check] or [Uncheck] and press ® .

Cartridge Attach/Remove Check

Check

No check
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8-19. Display of total printed sheets

On this display screen, the total number of printed sheets is shown.
(1) From the menu, select [Total Print], and press @ .

(2) Then, the total number of printed sheets is displayed.

<TIPS>
. Only the number of printed sheets of which printing has succeeded is counted, in which the canceled number of sheets is
not included.

° All the printed sheets involved in printing operation, including test print, are counted.
. The display screen shown here has been taken as an example.

. The count of total number of printed sheets cannot be reset.

Total Print

530

Press OK to Return

8-20. Display of Temperature/Humidity Info

On this display screen, the ambient temperature and humidity are shown.

(1) From the menu, select [Temperature/Humidity Info], and press @ .

(2) Then, the ambient temperature and humidity are displayed.

<TIPS>
. Make the setting of temperature indication unit in the Temperature window.
. The display screen shown here has been taken as an example.

Temperature/Humidity Info

Temperature [ 25°C]

Humidity [ 78 %]

Press OK to Return
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8-21. Confirm network setting

In the [Confirm network setting] window, display the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and
[MAC address].

(1) From the menu, select [Confirm network setting], and press @ .

(2) Select one out of the [IP Address], [Subnet Mask], [Default Gateway], [Host name], and [MAC address], and press

S

Confirm network setting
|P Address
Subnet Mask

Default Gateway
Host name
MAC address

(3) Display [IP Address], [Subnet Mask], [Default Gateway], [Host name], or [MAC address].
<TIPS>

. The display screen shown here has been taken as an example.

IP Address Subnet Mask

192.168.000.001 255.255.255.000

Press OK to Return Press OK to Return

Default Gateway Host name

000.000.000.000 GTRA-XKXXXX

Press OK to Return Press OK to Return

MAC address

00:1B:A9:FD:BC:27

Press OK to Return
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8-22. Network filtering settings

This function will enhance LAN security. Enable or disable this function when using the printer. Setting this function to
[Enable] will allow access only from subnet mask to which LAN-connected GTX belongs. It is set to [Disable], by default.

(1) From the menu, select [Printer Setting] > [Network filtering], and press @ .
(2) Select [Enable] or [Disable] and press @ .

Network filtering

Enable
Disable

8-23. Cartridge Attach/Remove Check History

This function makes it possible to display records on the state of the white ink cartridge removed for 60 seconds or more.
You can use this function to check whether the agitation of the white ink cartridge is performed regularly.

(1) From the menu, select [Cartridge Attach/Remove Check History], and press @ .

(2) The cartridge attach/remove check history is displayed, and you can use the AV keys to see the records on
cartridge attachment and removal.
CTG Attach/Remove History
30/09 08:19 [W12] 199 Sec

30/09 08:19 [W34] 204 Sec

27/09 08:35 [W12] 105 Sec
27/09 08:35 [W34] 90 Sec
26/09 08:25 [W12] 237 Sec
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8-24. Check circulation schedule

White ink circulation can be performed at a specified time.

(1) From the menu, select [Check circulation schedule], and press ® .

(2) Display the circulation schedule.
<TIPS>

. If the scheduled time of white ink circulation is not set with the maintenance tool, the circulation schedule will not be displayed.

Check circulation schedule
Current time 13:00

00:00 06:30 10:00 12:00

15:00 18:00 -—-:— -—-—:--

Press OK to Return

8-25. Language setting

Select your desired language to be shown on the liquid crystal panel.

(1) From the menu, select [Language], and press @ .
(2) Select your desired language in the [Language] window, and finalize your setting by pressing @ .

(3) Follow the on-screen message, and turn off the power and on again.

Language
English

Espanol

Francais

Deutsch

[taliano
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What to do when needed >

8-26. Display of version

On this display screen, the firmware's version information, [Firm Version], as well as [Data Info] and [Serial No.], are
shown.

(1) From the menu, select [Version], and press @ .

(2) Inthe window shown below, select one of the [Firm Version], [Data Info] and [Serial No.], and press @ .

Version

Firm Version

Data Info

Serial No.

(3) Then, one of the [Firm Version], [Data Info] and [Serial No.] will appear.

<TIPS>
. Pressingthe <« button causes the currently displayed window to go back to the [Version] window.

. The display screen shown here has been taken as an example.

Firm Version Data Info
Main 0.52.0001 Message 0.19.0000
MNT  0.39.0000/ 0.39.0000 Font 1.00.0000

Serial No.

Serial No.  ABCDEFG1

LCD  0.08.0000 Test Print 0.00.0007

Head 0.32.0000/ 0.32.0000 Hardware ID 1.0
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What to do when needed

8-26-1. Updating of firmware

When a new firmware is released, please update the firmware.
<TIPS>

. To check any release information of a new firmware, please visit the website of Brother Industries, Ltd.

(1) Download the firmware's updated data from the website of Brother Industries, Ltd.
(2) Onthe PC, from [All Programs] in the Start menu, select the "GTX-4 Firmware Update" from "Brother GTX-4 Tools".
(3) Specify the firmware's updated data (.bwf).

'\ GTX-4 Firmware Update —

Select the Fimware Update Data (" bwf).

S

Back I Nead > J[ Cancel

(4) Make a connection of the USB 2.0 cable or LAN cable between your PC and the printer, and update your firmware

by performing the on-screen procedures.
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n Troubleshooting

A\CAUTION

Ensure there is adequate space left in front of the printer and avoid placing any objects. Otherwise your hand
may get caught between the platen and an object, which may result in injury.

Do not handle the platen while printing. If your hand gets caught between the platen or the T-shirt tray and
the covers, it may be injured.

Do not put your hands inside the covers while the printer's power is turned on. Otherwise your hands may
touch against moving parts and this may result in injury.

Be careful not to get your fingers caught when closing the front cover, otherwise it may result in injury to your
fingers.

When you mount or replace the head, be careful not to get your hands or fingers caught. Otherwise you may
be injured.

Do not drink liquids such as the ink, maintenance solution, cleaning solution, pretreatment, or waste. They
may cause diarrhea or vomiting.

Avoid causing your eyes or skin to make contact with the ink, maintenance solution, cleaning solution,
pretreatment or waste. It may cause inflammation. In case of contact with eyes, do not rub but immediately
rinse the eyes with water.

Keep the liquids out of the reach of children.

PP p

Be sure to wear protective goggles and gloves when handling the grease, so that it does not get into your
eyes or onto your skin.

It can cause inflammation. Do not drink or eat the grease. It may cause diarrhea or vomiting.

Keep the liquids out of the reach of children.

When replacing parts and installing optional accessories, be sure to use only genuine Brother parts. Brother
will not be held responsible for any accidents or problems resulting from the use of non-genuine parts.

When replacing parts or installing optional accessories, be sure to follow the procedures described in the
Instruction Manual. Incorrect procedures could cause injuries or problems.

(1)IMPORTANT

® Do not move the platen by hand. Otherwise the printer may be mechanically and electrically damaged.
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9-1. Troubleshooting instructions

Troubleshooting

With reference to the descriptions below, troubleshoot your problem.

No print data can be sent from PC

>

Probable Cause

Remedy

Have you selected an incorrect printer or not?

From the menu for printing, check your printer name.

Has a USB or LAN cable been connected
properly?

Ascertain that connection of the USB 2.0 cable or the LAN cable
has been made correctly.

Are you using such PC or OS that is outside the
specification?

With reference to "10-2. Software >>P.332", check your PC's
operating environment.

Are you using such a USB 2.0 cable that is outside
the specification?

With reference to "1-3. Other items you must make available for
use >>P.21", please use such a USB 2.0 cable that is compliant
with the specification.

Has any noise been produced between the printer
and your PC?

Remove the USB 2.0 cable/LAN cable first, then make a
connection of it once again in five seconds. If the problem
continues, power off the printer first, then reactivate it in five
seconds.

Does your PC function properly?

Restart the PC.

Has any other USB device been connected to your
PC?

Remove the other USB device, restart the PC, and check to see if
the printer functions properly.

Has the USB cable/LAN cable been damaged?

Use a different USB or LAN cable.

No printing job gets started even after pressing the print button

Probable Cause

Remedy

Is any error message displayed?

With reference to "9-3. Error message >>P.304", eliminate the
cause of the error, and perform printing once more.

Does the menu screen still appear on the screen,
or are you performing the maintenance operation
from the menu?

Please exit the menu. Alternatively, please wait until the
maintenance operation will come to an end.

Is the automatic head cleaning operation
underway?

Please wait until the ongoing head cleaning operation is
completed.

Is the printer in the white ink circulation stage?

Please wait until the ongoing white ink circulation is completed.

Is the room temperature suited to the usage
conditions?

With reference to "10-1. Apparatus >>P.331", check for your PC's
operating environment and adjust the room temperature.

Does the printer receive no print data, or is it in the
state to receive such data (the print button is not
illuminating)?

Send the print data to the printer. Alternatively, please wait until
the reception of print data is completed.

If you start the printing operation during the reception process of
print data, enable the [Rcvng Prnt Setting] by reference to "8-13.
Settings to start printing during reception of data >>P.230".

Do you find that the temperature of print heads is
becoming high, and [Color Head Getting Warm] or
[W Head Temp Rising] message appears?

There may be the possibility that the flat cables of print heads
have not been put in place and the temperature of print heads
has become high.

Turn off the power, make sure that the flat cable is in place, and
wait until the temperature decreases.
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The power cannot be turned on

Troubleshooting

>

Probable Cause

Remedy

Is the power cord connected to the printer?

Make sure that the power cord is connected to the printer.

Is the front cover closed firmly?

Close the front cover properly.

An error occurs immediately after activating the printer

Probable Cause

Remedy

Is any error message displayed?

With reference to "9-3. Error message >>P.304", check the
content of the error, and restart the printer. If the error is still not
eliminated, please contact your dealer or Brother.

No print data can be loaded from USB flash memory

Probable Cause

Remedy

Has the USB flash memory been inserted into its
insertion slot properly?

Insert the USB flash memory into the insertion slot firmly.

Is the applicable file ARP or ARS3 file?

This printer cannot print out the print data of
GT-541/GT-782/GT-3. Recreate the print data.

Is your USB flash memory suited to required
conditions?

Please use a FAT32-formatted USB flash memory of which
storage capacity ranges from 2 GB to 32 GB. You cannot use a
USB memory with security functions such as password lock
function.

Has your USB flash memory been broken?

Check to see if it functions properly using your PC or the like.

Neither uni-directional printing nor bi-directional printing can be performed

Probable Cause

Remedy

Do the settings of printer driver and printer agree
with each other?

Note that the setting of the printer's setting has priority over the
setting of printer driver. The printer driver's setup value takes
effect only if the printer's setting is [Auto].

For the printer configuration details, please refer to "8-1. Setting
the print direction >>P.224".

An empty state of an ink pouch cannot be detected

Probable Cause

Remedy

Is an ink pouch in its correct position?

If the ink pouch is in contact with the side of the ink cartridge
case, detection may not be performed correctly.

With reference to "7-1-1. Replacement of ink pouch with a new
one >>P.162", set the ink pouch once again correctly.

After stirring the white ink, is the lid of the ink
cartridge opened and the pouch placed in the
correct position?

Open the lid of the white ink cartridge and appropriately rewind
the ink pouch. Ink might have entered into the wound section of
the pouch when stirred, which could have caused improper
winding of the pouch. Refer to "6-2-3. Daily agitation of the white
ink >>P.112".
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Troubleshooting

"x" is displayed for the remaining ink level after replacing the ink pouch

>

Probable Cause

Remedy

Is a wrong color of an ink pouch installed?

Put an ink pouch in its correct position. If colors are mixed on the
print result or within the ink pouch, please contact your dealer.

Remaining volume indication of the ink pouch does not reflect the actual status

Probable Cause

Remedy

Didn't you replace an ink pouch in the way of use?

If you take out an ink pouch that still has much amount of
remaining ink in the way of use, then set a different ink pouch or
the original used ink pouch back to the printer, it can indicate a
different volume from the actual remaining volume. If you keep on
using it and the volume is reduced to some extent, the correct
remaining volume will be displayed again.
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Troubleshooting

>

9-2. Solutions to print quality problems

With reference to the descriptions below, troubleshoot your problem.

Print is too light

Probable Cause

Remedy

Is the setting of an image editing software
application made improperly, or is an image placed
in CMYK mode?

With reference to "5-2. Creating print data from other applications
>>P.63", edit the image.

Have the printing conditions been applied
improperly, or does your image data have
insufficient color saturation?

With reference to "5-3-9. Set up the image quality >>P.97", adjust
saturation or contrast on [Color Processing].

Is a sufficient amount of ink left in a cartridge?

With reference to "7-1-1. Replacement of ink pouch with a new
one >>P.162", replace the applicable ink pouch with a new one.

Is there any nozzle that does not eject ink-jet
droplets?

Press @ on the operation panel, or perform the head
cleaning by selecting [Head Cleaning] from the menu.

If this problem is still not remedied, follow the instructions of
"9-2-1. Recovery action to be taken for such a nozzle that is
unable to eject ink-jet droplets >>P.251".

Is initial settings after head replacement
configured?

With reference to "7-4-2. Initial settings after head replacement
>>P.213", configure the initial settings after head replacement.

Isn't the [Low Temperature Mode] set to [Disable]?

With reference to "8-6. Print Operation Settings Under Low
Temperature >>P.227", change the setting to [Enable(Normal)].

Horizontal stripe (banding) is found on printed material

Probable Cause

Remedy

Is there any nozzle that does not eject ink-jet
droplets?

Press \J|8 / on the operation panel, or perform the head
cleaning by selecting [Head Cleaning] from the menu.

If this problem is still not remedied, follow the instructions of
"9-2-1. Recovery action to be taken for such a nozzle that is

unable to eject ink-jet droplets >>P.251".

Do you print ink dots on a highly water-absorbing
print medium?

With reference to "8-1. Setting the print direction >>P.224", set the
print head's print direction to [Always Uni-Directional].

Also, with reference to "5-3-6. Specify whether or not to perform
Multiple Pass Printing >>P.92", combine the color multiple pass
printing with the printing.

Is the platen positioned at too low level?

With reference to "6-5. Placing print medium in position >>P.142",
adjust the height of the platen corresponding to the print medium
before using it. You can use the platen height adjustment lever to
adjust the height of platen. As a rough indication, adjust the height
so that it is lowered by one step from the limit height detected by
the obstacle sensor, and check that the platen is not detected by
the sensor.

Is the firing timing well-timed?

With reference to "7-4-3. Firing adjustment >>P.214", make the
firing adjustment again. It is likely that the setup value is
incorrectly set after replacing a print head or the platen with a new
one, or after adjusting the platen height.

Is platen feed adjusted?

With reference to "7-4-4. Platen feed adjustment >>P.215", adjust
the feed of the platen. It is likely that the setup value is incorrectly
set after replacing a print head or the platen with a new one.
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Probable Cause

Remedy

Isn't the [Low Temperature Mode] set to [Disable]?

With reference to "8-6. Print Operation Settings Under Low
Temperature >>P.227", change the setting to [Enable(Normal)].

Blurring is observed (when printed with [Color Ink Only])

Probable Cause

Remedy

Isn't the amount of ink excessive against the print
media?

With reference to "5-4-5. Printing ink volume >>P.103", print the
ink volume and check the blurring, and select appropriate set
value for [Ink Volume:].

For details of [Ink Volume:] setting procedure, refer to "5-3-7. Set
up the color ink >>P.93".

Blurring is observed (when printed with [Color+White Ink])

Probable Cause

Remedy

Is the [Highlight:] of [White Ink Settings:] too high?

With reference to "5-4-6. Print out of highlight check pattern
>>P.104", print the highlight check pattern to check the blurring,
and select appropriate set value for [Highlight:].

For details of [Highlight:] setting procedure, refer to "5-3-4. Set up
the white ink >>P.89".

By turning ON the [White/Color Pause] or [Color Multiple Pass
Printing] checkbox, extend time before the color ink settles onto
the white ink, to prevent blurring. Try this method to eliminate
blurring without weakening the highlight.

For details of [White/Color Pause] setting procedure, refer to
"5-3-8. Set up the white ink >>P.94".

For details of [Color Multiple Pass Printing] setting method, refer
to "5-3-6. Specify whether or not to perform Multiple Pass Printing
>>p.9o2".

Ink sticks to such an area where no print data exists (ink stain, horizontal stripe, etc.)

Probable Cause

Remedy

Is the area around the print heads soiled with waste
ink spilled from the wiper cleaner or head cap?

With reference to "7-1-2. Cleaning the nozzle guard, wiper,
exhaust cap, and suction cap >>P.166", clean the area around
the print heads and the suction cap.

Furthermore, by reference to "7-1-3. Replacing the wiper cleaner
>>P.178", replace the old wiper cleaner with a new one.

Is any lint attached to the nozzle surface?

With reference to "7-1-2. Cleaning the nozzle guard, wiper,
exhaust cap, and suction cap >>P.166", clean the nozzle guard.

Is the carriage plate contaminated?

With reference to "7-2-5. Cleaning the CR (carriage) plate
>>P.200", perform the cleaning on the carriage plate.

Do the print heads rub against a T-shirt?

With reference to "6-5. Placing print medium in position >>P.142",
flatten the surface of T-shirt, and adjust the platen's height as
required.

Has the flushing foam become dirty?

With reference to "7-1-4. Replacing the flushing foam >>P.180",
replace the dirty flushing foam with a new one.

Has the platen sheet become dirty?

With reference to "7-2-6. Replacing the platen sheet >>P.203",
replace the dirty platen sheet with a new one.
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Troubleshooting

>

Probable Cause

Remedy

Has any ink attached to the carriage that secures
the print heads in place or is it dripping off?

With reference to "7-2-5. Cleaning the CR (carriage) plate
>>P.200", perform the cleaning of the carriage plate and remove
the accumulated ink.

The edges of the image are blurred, characters and straight lines are doubly printed and printed

result appears too granular

Probable Cause

Remedy

Is the platen positioned at a level that is too low?

With reference to "6-5. Placing print medium in position >>P.142",
adjust the height of the platen corresponding to the print medium
before using it. You can use the platen height adjustment lever to
adjust the height of platen. As a rough indication, adjust the height
so that it is lowered by one step from the limit height detected by
the obstacle sensor, and check that the platen is not detected by
the sensor.

Is the firing timing correct?

With reference to "7-4-3. Firing adjustment >>P.214", make the
firing adjustment again. It is likely that the setup value is
incorrectly set after replacing a print head or the platen with a new
one, or after adjusting the platen height.

Is the image enlarged on the printer setting screen?

When a low resolution image is enlarged on the printer setting
screen, it may blur or angle the image. Pattern data should be
enlarged on an image editing application, and its roughness
should be checked.

Thin color cannot be printed out well gradually

Probable Cause

Remedy

Is the ambient atmosphere at a high temperature
and very dry, which in turn tends to cause the
nozzle surface to dry up?

With reference to "8-3. Flushing Interval Setting >>P.226",
perform the flushing more frequently. In addition, by reference to
"8-4. Flushing Volume Setting >>P.226", increase the flushing
volume.

White ink is not printed out evenly

Probable Cause

Remedy

Has the pretreatment been applied unevenly?

With reference to "6-3-3. Application of pretreatment >>P.120",
apply the recommended amount of pretreatment evenly to the
target area.

Has the pretreatment caused any change in
hardness or deformation of the pretreatment roller?
(This applies to the case where the pretreatment
roller is used.)

After the pretreatment roller is used, put it in a plastic bag or the
like hermetically to prevent it from drying up, and keep it in a flat
place in an upright position.

Also, when it remains unused for two weeks or longer, wash it
well with running water, and let it dry in a shaded area.

Is any water content attached to the pretreatment
roller after the pretreatment is fixated?

With reference to "6-3-4. Fixation of pretreatment >>P.126",
prevent water content from being attached to the roller after the
pretreatment is fixated.

Is there any lint, yarn waste, dust, etc. that are
attached to the surface of pretreatment roller? (This
applies to the case where the pretreatment roller is
used.)

With reference to "6-3-3. Application of pretreatment >>P.120",
clean the surface of the pretreatment roller.
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Troubleshooting

>

Probable Cause

Remedy

Did you shake the pretreatment after its dilution?

With reference to "6-3-2. Dilution of pretreatment >>P.118", shake
the pretreatment sufficiently.

Is the [Low Temperature Mode] set to [Disable]?

With reference to "8-6. Print Operation Settings Under Low
Temperature >>P.227", change the setting to [Enable(Normal)].

Has the pretreatment been fixated insufficiently?

With reference to "6-3-4. Fixation of pretreatment >>P.126",
check on an actual temperature of the heat press and its pressure
during the fixation stage.

Always keeping the lower iron (where media is placed) of the heat
press at heated temperature with a heating source may solve this
problem.

Whiteness of print result is insufficient

Probable Cause

Remedy

Has the pretreatment been applied insufficiently?

With reference to "6-3-3. Application of pretreatment >>P.120",
apply a proper amount of pretreatment.

Has the pretreatment been fixated insufficiently?

With reference to "6-3-4. Fixation of pretreatment >>P.126",
check on an actual temperature of the heat press and its pressure
during the fixation stage.

Is there any nozzle that does not eject ink-jet
droplets?

Press @ on the operation panel, or perform the head
cleaning by selecting [Head Cleaning] from the menu.

If this problem is still not remedied, follow the instructions of
"9-2-1. Recovery action to be taken for such a nozzle that is
unable to eject ink-jet droplets >>P.251".

Is the white ink circulated insufficiently?

From the menu, select [Maintenance] > [White Ink Circulation] to
circulate the white ink properly.

Do you perform white ink refilling?

With reference to "6-2-3. Daily agitation of the white ink >>P.112",
perform white ink refilling.

Is the white ink stirred insufficiently?

In the event that the white ink remains accumulated in the bottom
of the ink pouch, shake the pouch 100 times and additionally
shake it until the ink is stirred well.

Also, when the remaining ink level becomes approximately 5.9 in.
(15 cm), shake the cartridge with its cover open and with the edge
of the ink pouch slightly winded.

Is the [Low Temperature Mode] set to [Disable]?

With reference to "8-6. Print Operation Settings Under Low
Temperature >>P.227", change the setting to [Enable(Normal)].

Is the dilution rate of the pretreatment correct?

With reference to "6-3-2. Dilution of pretreatment >>P.118",
correctly dilute the pretreatment.

Is the [Highlight:] of [White Ink Settings:] too low?

With reference to "5-4-6. Print out of highlight check pattern
>>P.104", print the highlight check pattern to check the blurring,
and select appropriate set value for [Highlight:].

For details of [Highlight:] setting procedure, refer to "5-3-4. Set up
the white ink >>P.89".

Too much luster

Probable Cause

Remedy

Are you using Teflon-treated peel-off sheet for
fixation?

Use a silicon coated peel off sheet when curing the ink to reduce
the gloss.
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Troubleshooting

Too fuzzy

>

Probable Cause

Remedy

Did you touch the print media (T-shirt) just before
printing?

Excessively touching the media (T-shirt) on the platen by trying to
flatten the media before printing could cause fuzziness. Make
sure not to touch the media surface too much after the
pretreatment is fixated.

Does it take a long time before printing, after the
pretreatment fixation?

Leaving the print media (T-shirt) after fixing the pretreatment may
cause fuzziness, because the media would absorb water. Print
the pretreatment fixated media as soon as possible.

Is the upper iron on the heat press contaminated
during the pretreatment fixation process?

If the upper iron is contaminated, it could roughen the print media
(T-shirt) surface by a heat press process, to cause fuzziness.
Clean the upper iron of the heat press with a cloth.

If the condition persists, try using a peel-off sheet during the
pretreatment fixation process, to probably improve the condition.

Unevenly dried during the fixation process?

It may be solved by inserting a silicone foam between the heat
press lower iron and a print media (T-shirt) during ink fixation.

Background white ink spreads out when printed with [Color+White Ink]

Probable Cause

Remedy

[White/Color Alignment] misaligned?

Misalignment of white and color inks can occur when the media
thickness or the platen height is changed. Adjust the platen height
first, and align the white and color inks positions by referring to
"7-4-5. White/color alignment >>P.216".

Is the media easy to stretch when wet?

Print misalignment may occur between white and color inks when
the media stretches when wet with white ink. Increasing [Choke
Width:] can prohibit spreading of the background white ink.

For details of [Choke Width:] configuration, refer to "5-3-8. Set up
the white ink >>P.94".

249



Troubleshooting

Printed surface cracks after fixation

Probable Cause Remedy
Isn't the print surface folded before fixation is Try not to touch the print surface until the fixation process is
completed? completed.

The lower left side area of the printer's main unit is soiled with ink

Probable Cause Remedy
Is the waste ink tube dismounted from the For help, please contact your dealer.
maintenance unit?

The cleaning solution is leaked from the cleaning liquid tank
Probable Cause Remedy
Is the main body of printer put aslant? With reference to "4-1. Installation of printer >>P.38", place the
printer horizontally level.
If the problem is still not remedied, please contact your dealer.

Takes longer print time than before

Probable Cause Remedy
Is the ambient temperature under 18°C (64.4°F)? Adjust the room temperature to 18°C (64.4°F) or more.
If it is difficult to adjust the room temperature, refer to "8-6. Print
Operation Settings Under Low Temperature >>P.227" to [Disable]
the operational configuration under low temperature.
Is your printing under high-temperature and low Lower your room temperature below 30°C (86°F).
humidity environment? Raise your room humidity over 35%.
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9-2-1.

Troubleshooting

Recovery action to be taken for such a nozzle that is unable to eject ink-jet droplets

Please verify the followings when any nozzle is not ejecting ink droplets.

ltems to be checked

Description

Remedy

Document

Is the cap contaminated?

When the cap is contaminated, it cannot fully
contact the head, which would lead to
suction failure.

Clean the cap

Refer to "7-1-2. Cleaning
the nozzle guard, wiper,
exhaust cap, and suction
cap >>P.166".

Is there any deposit of ink
around the nozzle
surface?

When the surrounding area of nozzle
surface is contaminated, it could lead to
ejection failure since the wiper cannot clean
the nozzle surface properly. Or, it could
reduce the adhesion between the nozzle
and cap, thereby causing ink suction failure.

Cleaning the
surrounding area
of nozzle surface

Refer to "9-2-4. Cleaning
the surrounding area of
nozzle surface >>P.266"

Is the wiper contaminated?

When the wiper tip is contaminated, it could
lead to ejection failure since the wiper
cannot clean the nozzle surface properly.

Clean the wiper

Refer to "7-1-2. Cleaning
the nozzle guard, wiper,
exhaust cap, and suction
cap >>P.166".

Is there any indication of

When the wiper has any scar or

, deformation, it could lead to ejection failure | Replace the Refer to "9-2-7. Replacing
scar or deformation on the | . , , "
wiper? since the wiper cannot clean the nozzle wiper the Wiper >>P.298".
' surface.

If the wiper cleaner is contaminated, residual . ,

Is the wiper cleaner , P i o ) Replacing the Refer to "7-1-3. Replacing

, dirt on the wiper may prohibit the wipers ) )

contaminated? . . wiper cleaner the wiper cleaner >>P.178".
cleaning function.
If the wiper cleaner is dry, it may prohibit the | Replacing the Refer to "7-1-3. Replacin

Is the wiper cleaner dried? | . wip I | ) y prohibl ) placing ) pacing
wiper's proper function to wipe clean. wiper cleaner the wiper cleaner >>P.178".
If the flushing foam is not placed

Is the flushing foam g P Replace the Refer to "7-1-4. Replacing

floated?

appropriately, it may touch the nozzle
surface to stop ejection from the nozzle.

flushing foam

the flushing foam >>P.180".

Is the ink accumulated on
the flushing foam?

If an ink accumulates on the flushing foam,
the ink may touch the nozzle surface to
prevent ink from ejecting.

Replace the
flushing foam

Refer to "7-1-4. Replacing
the flushing foam >>P.180".

Is the waste ink tube bent

The bent waste ink tube will stop the waste
liquid flow, thereby disabling ink suction

Verify the waste

Refer to "6-2-1.
Confirmation and disposal

in the middle? ink tube
operation of the head cleaning function. of waste ink >>P.110".
If the tip of the waste ink tube immersed in
Is the tip of the waste ink | | . .p i . ) Refer to "6-2-1.
) liquid, it will prevent the smooth flow of liquid, | Verify the waste ) i
tube touching the waste , . , , , Confirmation and disposal
It can disable the ink suction operation of the | ink tube )
tank bottom? i , of waste ink >>P.110".
head cleaning function.
If they are loosely mated, it may allow air to | Verify connection Refer to "9-2-6
Is the tube correctly enter into the head section during the head | between the L
. . L Replacement of print head
connected to the head? cleaning operation, to cause non-ejection head and the S>P 27"
condition of the nozzle. tube Y
If the ink pouch is not properly installed, the ) Refer to "7-1-1.
Is the ink pouch properly i P p. p. y ) Install an ink )
i cartridge cannot fully wind it, and fails to Replacement of ink pouch
attached to the cartridge? pouch

supply enough ink to the head.

with a new one >>P.162".
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Items to be checked Description Remedy Document
If a large amount of air exists in the tube,
Is the tube filled with ink? | that air will go into the head to cause Re-install the ink
non-ejection condition of the nozzle.

Refer to "9-2-8. Re-install
the ink >>P.303".

After carrying out appropriate remedial measures listed above, make sure the non-firing nozzle has been recovered. If it
has not, perform the steps 1 to 5 to recover the non-firing nozzle.
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Step 1: Print out a nozzle check pattern

(1) Print out a nozzle check pattern (1st time).

<TIPS>

° For details of the printing method of nozzle check pattern, refer to "7-2-1. Print out of the nozzle check pattern (checking on

the print heads) >>P.192".

(2) Check the result of the printed nozzle check pattern (1st time), and carry out the following procedures.

<TIPS>

. To check the print result, refer to "7-2-1. Print out of the nozzle check pattern (checking on the print heads) >>P.192".
. Even if the white print result is weak, since the white ink is ejected on one same spot through multiple nozzles, a relatively
large amount of ink volume will be used, and the firing problem of a single nozzle will not affect the print quality so much.

Even in a condition with weak lines, the print is performed without a problem.

>

Existence or nonexistence of a
nozzle that does not eject any
ink-jet droplets

Recovery action

Such a nozzle does not exist that
does not eject any ink-jet droplets

If a number of non-firing of white head is observed in printing although such
non-firing problems do not occur in nozzle check pattern printing, please
contact your dealer.

If a number of non-firing of white head is observed in printing although such
non-firing problems do not occur in nozzle check pattern printing, replace
the filter. If non-firing cannot be resolved after replacing the filter, please
contact your dealer.

Such a nozzle exists that does not
eject any ink-jet droplets

Proceed to Step 2.

<TIPS>

. For information about replacing a filter, refer to "9-2-5. Replacing the color filter >>P.270".

Step 2: Perform the head cleaning

(1) Perform a normal cleaning.
<TIPS>

. For details of the head cleaning method refer to "7-2-2. Head cleaning >>P.194".

(2) Print out a nozzle check pattern (2nd time).
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(3) Check the result of the printed nozzle check pattern (2nd time), and carry out the following procedures.

Existence or nonexistence of a
nozzle that does not eject any Recovery action
ink-jet droplets

Such a nozzle does not exist that | Exit
does not eject any ink-jet droplets
Ten-or-less nozzles exist that do Perform the normal cleaning once again. Subsequently, proceed to (4).
not eject any ink-jet droplets

Ten-or-more nozzles exist that do | Perform the powerful cleaning. Subsequently, proceed to (4).
not eject any ink-jet droplets
More than half of the nozzles of Re-install the ink. Subsequently, proceed to (4).
the color heads have a problem
concerning firing of the print
heads.

More than half of the nozzles of Clean the white heads. Subsequently, proceed to (4).
the white heads have a problem
concerning firing of the print
heads.

<TIPS>
. For the ink re-installing method, please refer to "9-2-8. Re-install the ink >>P.303".
. For details of cleaning method of white heads, refer to "9-2-2. White head cleaning >>P.257".

(4) Print out a nozzle check pattern (3rd time).

(5) Check the result of the printed nozzle check pattern (3rd time), and carry out the following procedures.
Existence or nonexistence of a
nozzle that does not eject any Recovery action

ink-jet droplets

Such a nozzle does not exist that Exit

does not eject any ink-jet droplets

Such a nozzle exists that does not | Proceed to Step 3.

eject any ink-jet droplets
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Step 3: Check that no ink-jet droplets are ejected from the applicable nozzle
(1) Check locations of the non-ejecting nozzles on the result of the printed nozzle check pattern (1st to 3rd time), and

carry out the following procedures.

Comparison of non-ejection nozzle )
Recovery action

positions
The same nozzle always does not | Perform the super cleaning -> print out of nozzle check pattern for the third
eject ink-jet droplets time in a row.
A different nozzle does not eject Leave the printer as it is for about 30 minutes, and perform the normal
ink-jet droplets cleaning -> print out of nozzle check pattern for the third time in a row.

(2) Check a result of the resultant nozzle check patterns, and carry out the following procedures.

Existence or nonexistence of a
nozzle that does not eject any Recovery action
ink-jet droplets

Such a nozzle does not exist that Exit
does not eject any ink-jet droplets
Such a nozzle exists that does not | Proceed to Step 4.
eject any ink-jet droplets

Step 4: Clean the nozzle surface

(1) Clean the nozzle surface of the print heads.

<TIPS>
. For details of cleaning method of the head nozzle, refer to "9-2-3. Cleaning of head nozzle >>P.263".

(2) Print out a nozzle check pattern.
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(3) Check aresult of the resultant nozzle check patterns, and carry out the following procedures.
Existence or nonexistence of a
nozzle that does not eject any Recovery action

ink-jet droplets

Such a nozzle does not exist that | Exit

does not eject any ink-jet droplets

Such a nozzle exists that does not | Proceed to Step 5.

eject any ink-jet droplets

<IMPORTANT>

3 Even if the nozzles on the white side have a bit of problem concerning firing, since the white ink is ejected on one same
spot through multiple nozzles, relatively large amount of ink volume will be used, and firing problem of a single nozzle will
not affect the print quality so much. Even in a condition with a problem concemning firing as shown in (a), print is performed

without a problem as shown in (b).

(a) (b)

Step 5: Head Replacement

(1) Replace the print head with a new one.

<TIPS>
. For details of replacement method of print heads, refer to "9-2-6. Replacement of print head >>P.272".
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9-2-2. White head cleaning

If a problem concerning firing of the white head side is not cleared even after performing the head cleaning, perform the
white head cleaning.

After the white head cleaning is completed, conduct the Install White Ink After Cleaning.

<TIPS>

Although the white head cleaning can begin even when the remaining volume of maintenance solution in the maintenance
solution pouch is running short, there may be cases where the pouch needs to be replaced with a new one during the cleaning
depending on such remaining volume. If the remaining volume is 500 g (17.6 0z) or less, prepare a new maintenance solution
pouch.

When the white ink pouch runs low on its remaining volume of white ink, the Install White Ink After Cleaning function can no
longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the
installation process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch.

White Head Cleaning

(1

()
@)

From the menu, select [Maintenance] > [White Head Cleaning], and press @ .

<TIPS>

3 Perform the work operation by following the on-screen instructions.

After making sure that the waste ink tank is filled one-half or less full with waste ink, and press @ .

Take out the white ink cartridge from the printer.
<CAUTION>
3 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

White Ink Cartridge

X0039
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(4) Open the cartridge's lid.
<IMPORTANT>
. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.
. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Cartridge Lid

X0042

(5) Pinch the latch at the front end of ink pouch, and draw out the white ink pouch from the cartridge.
<CAUTION>
. Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular
basis.

White ink pouch

Cartridge's tip end

Cartridge

Latch

X0118

(6) Put the maintenance solution pouch in the cartridge.
Push the tip end of the maintenance solution pouch into the cartridge until it clicks into place.
Straighten the maintenance solution pouch in such a manner that it will be aligned with the gutter of the lid of the cartridge, and
mount in position by pulling it with your hand.
<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

Maintenance solution pouch
\ —
Stretch
&
C
%’\ \ \
) Cartridge

X0049
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(7) Put the maintenance solution pouch in its correct position.
<CAUTION>
. Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

(@) Place the pouch in a straight alignment with the cartridge

Align lines with
each other X0041

(8) Close the lid, and put the maintenance solution cartridge in position inside the printer.

(9) Repeat the same process to replace the other white ink cartridge with the maintenance solution pouch.

(10) On the operation panel, press ® .

Then, the white head cleaning will be performed.

<TIPS>

. White head cleaning will take approximately 25 minutes. Perform the "Install White Ink After Cleaning" operation by
following the on-screen instructions.
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Install White Ink After Cleaning

(1) Make sure the message [Install White Ink After Cleaning] is displayed on the liquid crystal panel.

<TIPS>
. Perform the work operation by following the on-screen instructions.

(2) Take out the maintenance solution cartridge from the printer.
<CAUTION>
. The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

Maintenance solution cartridge

(3) Open the cartridge's lid.
<IMPORTANT>
3 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.
. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Lid

Cartridge

Troubleshooting >

X0039
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(4) Take out the maintenance solution pouch from the cartridge, and put the white ink pouch in place.
Push the tip end of ink pouch into the cartridge until it clicks into place.

Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of the cartridge, and mount in position by

pulling it with your hand.
<NOTE>

. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

White ink pouch

%

(5) Put the white ink pouch in its correct position.
<CAUTION>

Cartridge

Stretch

X0049

° Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

(_?%a))
i

Align lines with
each other

Place the pouch in a straight alignment with the cartridge

X0041

(6) Shake the cartridge 100 times side to side to stir the ink.

<IMPORTANT>

. The white ink cartridge should be held horizontally when shaking it.

3 Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch.

<NOTE>

. Wear the provided gloves when performing this task.

. When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the

edge of the ink pouch slightly winded, to make the ink easier to stir.

White Ink Cartridge

Shake 100 times (for approx. 50 seconds)
(Swing distance should be approx. 2 in. (5 cm).
Increase the swing distance when the remaining
ink level becomes low.)

emaining ink volume should
be approx. 5.9 in. (15 cm)

X0194
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(7) Open the lid of the cartridge and place the ink pouch in its correct position.

<IMPORTANT>

. Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow
into the wound section of the pouch when stirred, which can cause improper winding of the pouch.

3 When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge
downward and open the lid.

. When setting the ink pouch, avoid unevenness or wrinkles on the pouch.

. When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

<NOTE>

3 If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid.

Cartridge Lid

X0182
Latch Q Lid
/
| | =—>
X0078
No wrinkles
Ink pouch Wi
X0142

(8) Close the lid, and put the white ink cartridge in position inside the printer.

<IMPORTANT>
. W12 and W34 cartridges should correctly be placed in their original locations. Wrongly placed cartridges could cause a
printer malfunction.

(9) Repeat the same process to replace the other maintenance solution cartridge with the white ink pouch.
(10) Check the waste ink tank level and take any necessary measure for it, if any, then press @ on the operation panel.

After the cleaning is completed, the Install White Ink After Cleaning function will get started.

<TIPS>

. The "Install White Ink After Cleaning" operation will take approximately 15 minutes. After the procedures are completed, the
current screen will go back to the standby mode screen.
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9-2-3. Cleaning of head nozzle

If a problem of non-ejection of ink-jet droplets is not cleared even after performing the head cleaning, perform the head
nozzle cleaning.
<IMPORTANT>

™

(2

@)

(4)

With reference to "7-1-2. Cleaning the nozzle guard, wiper, exhaust cap, and suction cap >>P.166", clean the nozzle guard first,
then clean the head nozzle.

Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available

for use.

<IMPORTANT>

3 Use a new clean stick R when you start cleaning.

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in the printer malfunction.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

° If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.

Open the front cover.

Front cover

X0050
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Troubleshooting >

Put a proper amount of cleaning solution into the cleaning cup.

Moisten a clean stick R with the cleaning solution.

<IMPORTANT>

. Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you
start cleaning.

. Do not use other fluids (water, etc.), because they may damage the print heads.

3 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R

Cleaning cup

Cleaning cup

&)

=

&

Cleaning solution

Do not drain waste ink.

X0246
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(7) With a clean stick R, clean the nozzle surface of print head.
Manually move the carriage to such a position that you can perform the cleaning with ease.

<IMPORTANT>
. Be sure not to bring corner edges of the clean stick R into contact with the nozzle surface.

3 Avoid roughly rubbing the nozzle surface.
. The used clean stick R should be disposed of, and should not be reused.

Clean stick R

Print head

Nozzle surface

X0251

(8) Close the front cover, turn on the power.

(9) From the menu, select [Head Cleaning] > [Powerful Cleaning] > [All Print Heads], and press @ .
<NOTE>
. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>

. Then, the head cleaning will be performed to prevent any ink from drying up.
3 Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
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9-2-4. Cleaning the surrounding area of nozzle surface

™

@)

@)

(4)

Make the clean stick R, cleaning cup, gloves and cleaning solution, which come standard with the printer, available

for use.

<IMPORTANT>

3 Use a new clean stick R when you start cleaning.

. Never touch the tip end of clean stick R with your hand. If any sebaceous matter is attached to the head nozzle, it may
result in the printer malfunction.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press ® .
<IMPORTANT>
. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve

the problem, then perform the cleaning.
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, close the front cover and turn on the power, and then select
[Maintenance Part Clean/Replace] again to restart the task. Then, the head cleaning will be performed to prevent any ink
from drying up.

Open the front cover.

Front cover

X0050
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Put a proper amount of cleaning solution into the cleaning cup.

Moisten a clean stick R with the cleaning solution.

<IMPORTANT>

. Be sure to use a different clean stick R separately for the color head and the white head. Use a new clean stick R when you
start cleaning.

. Do not use other fluids (water, etc.), because they may damage the print heads.

3 Do not return the cleaning solution which has been put in the cleaning cup to the cleaning solution bottle.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

Clean stick R

Cleaning cup

Cleaning cup

Cleaning solution

Do not drain waste ink.

X0246
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(7) With a clean stick R, clean the surrounding area of nozzle surface of print head.
Manually move the carriage to such a position that you can perform the cleaning with ease.
<IMPORTANT>
. Be sure not to bring the clean stick R into contact with the nozzle surface.
. The used clean stick R should be disposed of, and should not be reused.

Cleéning ;
prohibited ‘ Clean stick R
area 7@
surface Nozzle surface
. /

X0293

(8) Close the front cover, turn on the power.

(9) From the menu, select [Head Cleaning] > [Powerful Cleaning] > [All Print Heads], and press @ .
<NOTE>
. Dispose of any waste resulting from the cleaning in accordance with applicable laws and ordinances.
<TIPS>
3 Then, the head cleaning will be performed to prevent any ink from drying up.
. Because the cleaning cup will be reused, rinse it in clean cleaning solution and store it in a safe place.
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Pre-cleaning state

Post-cleaning state

X0253
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9-2-5. Replacing the color filter

If a number of non-firing color head nozzles is observed after printing, the filter should be replaced.

<IMPORTANT>

o When replacing multiple filters, filters for individual colors should be replaced one by one. Replace the filter for the first color and
install ink, then replace the next filter. Removing multiple filters at the same time might damage the print head.

<TIPS>

° Ink installation should be performed after replacing the filters. If the ink level is low, make a new ink pouch available for use.

(1) Prepare the supplied gloves and optional filter.
(2) From the menu, select [Maintenance] > [Exchange Filter], and press @ .

(3) From [Black], [Yellow], [Cyan], and [Magenta] select non-firing color and press @
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(4) Follow the on-screen message and turn off the power.

(5) Open the front cover.

Front cover

X0050

(6) Lay a waste cloth under the filter to be replaced.
<TIPS>
. Non-fuzzy, clean cloth should be used.

e N Waste cloth

N L\ Filter

\‘\\
S~ \
Filter

Color print head X0169
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(7) Rotate the nut of the tube on the head side and remove the filter.

(8) Place a new filter on the head side tube and fasten the nut.

<IMPORTANT>
. Install the filter with no stamp facing the tube. Pay attention to this installation orientation.

<NOTE>
. For a proper work operation, be sure to wear the printer-provided gloves.

Filter

5 Nt — ©
\

New filter

Head side tube

Without stamp

X0175

(9) Rotate the nut of the tube on the cartridge side to remove the old filter.

(10) Attach the cartridge side tube to a new filter and fasten the nut.

<IMPORTANT>
3 Make sure to install the filter with the stamped side facing the cartridge side tube.

Old filter
\ Cartridge side tube
) A / ) .
Nut
Xy Nut. ? V3 u @
New filter New filter
Stamped side
& J
X0176

(11) Remove the waste cloth from under the filter.

(12) Close the front cover, turn on the power.

<NOTE>

. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
(13) Perform the [Filter exchange after ink Load] operation by following the on-screen instructions.

<TIPS>
. When replacing multiple filters, go back to the beginning of the procedure to start replacing the next filter.

. After the procedures are completed, the current screen will go back to the standby mode screen.
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9-2-6. Replacement of print head

If a problem of non-ejection of ink-jet droplets is not cleared even after cleaning the head nozzle, replace a print head
with a new one.

The replacement procedures vary from the color heads to the white heads. According to each of the replacement
procedures, replace each print head with a new one separately.

<TIPS>

. Ink needs to be re-installed after replacing the print head. If the ink level is low, make a new ink pouch available for use.

Replacement procedures for print head on the color side

(1) From the menu, select [Maintenance] > [Head Replacement] > [Color], and press @ .
<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

(2) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

(3) Open the front cover.

Front cover

X0050
(4) Remove the upper case of a new print head.
(5) Remove four caps from the new print head.
Upper case
Cap
Print head é/
X0068
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(6) Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled.

<IMPORTANT>

o Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink.

. Be careful not to confuse it with the tube for the print head on the white side.

. When you replace the print head, be sure to move the carriage manually to the position of platen at the center of the printer
before starting the replacement. If you perform the mounting of the head when the carriage is directly above the
maintenance unit, it may damage the maintenance unit or the heads.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

Tube

7

H-»(E—=
- {(E—
SH-»E—

X0070
(7) Remove the resin cover which are placed on the top of the carriage board.
(8) Open the hold-down clip for the cable, and remove the flat cable.

Resin cover
I
/v/\ Flat cable
Hold-down clip for cable
X0071
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(9) Unlock the print head, and remove the print head.
<IMPORTANT>
. When removing the print head in position, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off
the dripping ink.

Lock

Print head

X0131

(10) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case.
<IMPORTANT>
3 When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause
poor printing.
<TIPS>
° Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both
hands to remove it.

Print head

(a) part

X0069
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(11) By following the procedures mentioned below, mount a new print head on the carriage.

@ Insert the rearward end of the print head into the carriage.

(@ Push with force in direction 2) so that the illustrated part (a) makes contact with the side of the metal plate of the print head.

(® Lock the print head in place.

<IMPORTANT>

. Make sure the illustrated (a) part is in contact with the side of the metal plate.

. When re-installing the print head with ink refilled, care must be taken not to mistake white for color.

. When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught
in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them.

. When you mount 3), push it down from the top. Otherwise, you may get your finger caught in it and get injured.

<TIPS>

3 If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which
in turn may result in poor printing. Please insert the print head as far as it can go.

( N\

Print head

(D¢
/= —==_

Carriage

X0132

X0133
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(12) Connect the flat cable to the carriage board.

Flat cable

X0074

(13) Place the resin cover back onto the carriage board, and engage the two latches properly.
(14) Make the wiring arrangement of flat cable as illustrated in (b), and secure it in place with the hold-down clip for the

cable.

Hold-down clip for cable

Resin cover

X0130
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(15) Remove every cap from each tube, and connect them to the print head.
<IMPORTANT>
. To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make a
connection of the rest of the tubes.

. Be sure to connect each tube with its correct position.

(16) Tighten the nut firmly until it stops so that each tube is fixed to the print head.

N

*Remove the ink clot.,

/

M4 oer{E= M
GOo+(E= C
Y2 O«=(E= Y y,
Bk1 O+{E= K

Print head
/
. J

X0281

(17) Close the front cover, turn on the power.

(18) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [Color], and press @ .
Perform the work operation by following the on-screen instructions.
<TIPS>
3 After the procedures are completed, the current screen will go back to the standby mode screen.

(19) Adjust the carriage speed.
<TIPS>
. For details, refer to "7-4-1. CR (Carriage) speed adjustment >>P.212".

(20) Perform the initial settings after head replacement configuration.
<TIPS>
. Please refer to "7-4-2. Initial settings after head replacement >>P.213".

(21) Adjust the ejection timing of print head.
<TIPS>
. For details, refer to "7-4-3. Firing adjustment >>P.214".

(22) Perform the platen feed adjustment.
<TIPS>
. Refer to "7-4-4. Platen feed adjustment >>P.215".

(23) Make the position adjustment between the white head and the color head.
<TIPS>
. For details, refer to "7-4-5. White/color alignment >>P.216".
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Replacement procedures for print head on the white side (if you use a capping pouch)
<IMPORTANT>

™
@)

@)

(4)

When you replace a print head on the white side, you can minimize ink consumption by installing a capping pouch (optionally
available) in addition to a print head. Instead of the capping pouch, a white ink pouch at its empty level before its expiry date can
also be used.

From the menu, select [Maintenance] > [Head Replacement] > [White], and press @ .

Make available a capping pouch, select [Yes], and press @

<IMPORTANT>

. Instead of the capping pouch, a white ink pouch at its empty level before its expiry date can also be used.
<TIPS>

. Perform the work operation by following the on-screen instructions.

. Pressing @ causes the platen to start moving. Do not put anything around the platen.
Remove the white ink cartridge from the printer.

<CAUTION>
. The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

( A

|

|
|

W12 W34

White Ink Cartridge

X0039

Open the cartridge's lid.

<IMPORTANT>

3 When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Lid

Cartridge

X0042
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(5) Pinch the latch at the front end of ink pouch, and draw out the white ink pouch from the cartridge.
<CAUTION>
. Remove the accumulated ink at the tip of the cartridge with a waste cloth (non-fuzzy cloth). Clean the printer on a regular
basis.

White ink pouch

Cartridge's tip end

™~

Cartridge
Latch
X0119
(6) Put the capping pouch in the cartridge.
< New capping pouch>
Push the tip end of capping pouch into the cartridge until it clicks into place.
New capping pouch
Cartridge X0294

< Old capping pouch>

Push the tip end of capping pouch into the cartridge until it clicks into place.

Straighten the capping pouch in such a manner that it will be aligned with the gutter of lid of cartridge, and mount in position by
pulling it with your hand.

<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

Old capping pouch

Stretch
A

\

Cartridge =

X0049
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Put the capping pouch in its correct position.

< New capping pouch>

<CAUTION>

. Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

<NOTE>

e  After closing the lid, the winding is complete when the latch of the cartridge side is raised.

X0295

[ Latch

Cartridge

X0296
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< Old capping pouch>

<CAUTION>

e  Avoid touching the portion (a) of cartridge. Otherwise, you may cut your hand.

<NOTE>

. Close the lid while holding the slack of the capping pouch by hand.

. After closing the lid, confirm that the capping pouch has been taken up to the end. When the latch of the cartridge side is
raised, the winding is complete.

(a) Place the pouch in a straight alignment with the cartridge

Align lines with
each other X0041

—
I‘ I> Latch ’ \

—_—

L Cartridge
X0201
(8) Close the lid, and put the capping cartridge in position inside the printer.
(9) Repeat the same process to replace the other white ink cartridge with the capping pouch.
(10) Follow the on-screen message and turn off the power.
<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.
(11) Open the front cover.
Front cover
X0050

(12) Remove the upper case of a new print head.
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(13) Remove four caps from the new print head.

Upper case

Cap

Print head é/

[//
/

X0068

(14) Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled.

<IMPORTANT>

° Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink.

° Be careful not to confuse it with the tube for the print head on the color side.

. Be sure not to tighten the nut for part (a) by mistake. It could remove the tube and leak the contained ink.

. When you replace the print head, be sure to move the carriage manually to the position of the platen at the center of the
printer before starting the replacement. If you perform the mounting of the head when the carriage is directly above the
maintenance unit, it may damage the maintenance unit or the heads.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

( Capéﬂ Tube
EH-»(E—
S~ (5=
EH-»(E—
Tube

X0134

(15) Remove the resin cover which is placed on the top of the carriage board carriage board.
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(16) Open the hold-down clip for cable, and remove the flat cable.

~

Flat cable \\ J;/
1/

r Resin cover

<

Hold-down clip for cable

X0135
(17) Unlock the print head, and remove the print head.
<IMPORTANT>
. When removing the print head, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off the dripping
ink.
( 2\
Lock
Print head
\ J
X0072
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(18) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case.

<IMPORTANT>

. When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause
poor printing.

<TIPS>

. Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both
hands to remove it.

Print head

(a) part

X0068
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(19) By following the procedures mentioned below, mount a new print head on the carriage.

@ Insert the rearward end of print head into the carriage.

(@ Push with force in direction 2) so that the illustrated part (a) makes contact with the side of the metal plate of the print head.

(® Lock the print head in place.

<IMPORTANT>

. Make sure the illustrated (a) part is in contact with the side of the metal plate.

. When re-installing the print head with ink refilled, care must be taken not to mistake white for color.

. When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught
in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them.

. When you mount 3), push it down from the top. Otherwise, you may get your finger caught in it and get injured.

<TIPS>

3 If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which
in turn may result in poor printing. Please insert the print head as far as it can go.

( N\

Print head

R <.

Carriage

X0073

Print head

X0129
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(20) Connect the flat cable to the carriage board.

Flat cable

X0136

(21) Make the wiring arrangement of flat cable as shown here, and secure it in place with the hold-down clip for the
cable.

(22) Place the resin cover back onto the carriage board, and engage the two latches properly.

Hold-down clip for cable
Resin cover

X0137

286



Troubleshooting >
(23) Remove every cap from each tube, and connect them to the print head.
<IMPORTANT>

. To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make the
connection of the rest of the tubes.

. Be sure to connect each tube with its correct position.

(24) Tighten the nut firmly until it stops so that each tube is fixed to the print head.
<IMPORTANT>
. Be sure not to tighten the nut for part (a) by mistake.

p < Tube - N
M4~ oer(E= 4 *Remove the ink clot.
3 Oo+(E= 3 Nut
Y2 o+(E= 2
Bkl O+{B= 1 =
& J
Print head
g / /
X0282

(25) Close the front cover, turn on the power.
(26) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [White], and press @ .
Perform the work operation by following the on-screen instructions.
<TIPS>
3 When the white ink pouch runs low on its remaining volume of white ink, the Install Ink after Replacing Head function can
no longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the
installation process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow
the instructions on the screen to replace the pouch, and activate the mode again.

(27) Take out the capping cartridge from the printer.
<CAUTION>
3 The bottom of the cartridge may be soiled with ink. Clean the printer on a regular basis.

( 7\

L
-

W12 W34
U

Capping cartridge

X0039
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(28) Open the cartridge's lid.
<IMPORTANT>
. When opening the lid, be sure not to touch portion (a). Otherwise, it could be damaged.
. Place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge downward and open the
lid.

Cartridge Lid

X0042

(29) Take out the capping pouch from the cartridge, and put the white ink pouch in place.
Push the tip end of the ink pouch into the cartridge until it clicks into place.
Straighten the ink pouch in such a manner that it will be aligned with the gutter of the lid of cartridge, and mount in position by
pulling it with your hand.

<NOTE>
. If the edge of the ink pouch is bent or undulating significantly, make it straight with your hand.

White ink pouch

Stretch
&
C
%’\ \ \
0 /
Cartridge 0049
(30) Put the white ink pouch in its correct position and close the lid.
<CAUTION>
e  Avoid touching portion (a) of the cartridge. Otherwise, you may cut your hand.
(a) Place the pouch in straight alignment with the cartridge
=)
’ ' Align lines with
each other X0041
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(31) Shake the cartridge 100 times side to side to stir the ink.
<IMPORTANT>

. The white ink cartridge should be held horizontally when shaking it.

. Holding the white ink cartridge upside down or shaking it too roughly could break the ink pouch.
<NOTE>

e  Wear the provided gloves when performing this task.

. When the remaining ink level becomes approximately 5.9 in. (15 cm), shake the cartridge with its cover open and with the
edge of the ink pouch slightly winded, to make the ink easier to stir.

Edge of the rib
White Ink Cartridge georhero ™~

Ink pouch /

:‘:‘/‘ ’/@&/
'\'J”' . emaining ink volume should
be approx. 5.9 in. (15 cm)

Shake 100 times (for approx. 50 seconds)
(Swing distance should be approx. 2 in. (5 cm). X0194
Increase the swing distance when the remaining

ink level becomes low.)
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(32) Open the lid of the cartridge and place the ink pouch in its correct position.

<IMPORTANT>

. Always open the cartridge lid and properly rewind the ink pouch. If the pouch is placed without opening the lid, ink can flow
into the wound section of the pouch when stirred, and cause improper winding of the pouch.

3 When opening the lid, place the entire cartridge on a flat surface, push the latches on the bottom surface of the cartridge
downward and open the lid.

. When setting the ink pouch, avoid unevenness or wrinkles on the pouch.

e  When opening the lid, be sure not to touch the portion (a). Otherwise, it could be damaged.

<NOTE>

3 If the remaining ink level is low, hold the sagged part of the ink pouch and close the lid.

Cartridge Lid

X0182
|
]
Lid
/
!_I ' ] =—
X0078
Ink pouch No wrinkles \
B
X0142
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(33) Close the lid, and put the white ink cartridge in position inside the printer.

<IMPORTANT>
. W12 and W34 cartridges should correctly be placed at their original locations. Wrongly placed cartridges could cause a
printer malfunction.

(34) Repeat the same process to replace the other capping cartridge with the white ink pouch.

(35) On the operation panel, press @ .

Then, the white ink will be installed after the head is replaced with a new one.

<TIPS>
3 After the procedures are completed, the current screen will go back to the standby mode screen.

(36) Adjust the carriage speed.
<TIPS>
. For details, refer to "7-4-1. CR (Carriage) speed adjustment >>P.212".

(37) Perform the initial settings after head replacement configuration.
<TIPS>
. Please refer to "7-4-2. Initial settings after head replacement >>P.213".

(38) Adjust the ejection timing of the print head.
<TIPS>
3 For details, refer to "7-4-3. Firing adjustment >>P.214".

(39) Perform the platen feed adjustment.
<TIPS>
. Refer to "7-4-4. Platen feed adjustment >>P.215".

(40) Make the position adjustment between the white head and the color head.
<TIPS>
° For details, refer to "7-4-5. White/color alignment >>P.216".
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Replacement procedures for print head on the white side (if you do not use a capping pouch)
<IMPORTANT>

™
)

@)

(4)

(5)
(6)

When you replace a print head on the white side, you can minimize ink consumption by installing a capping pouch (optionally
available) in addition to a print head. Instead of the capping pouch, a white ink pouch at its empty level before its expiry date can
also be used.

From the menu, select [Maintenance] > [Head Replacement] > [White], and press @ .
Select [No] and press @ .

<TIPS>
. Perform the work operation by following the on-screen instructions.

. Pressing @ causes the platen to start moving. Do not put anything around the platen.
Follow the on-screen message and turn off the power.

<IMPORTANT>
. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

Open the front cover.

Front cover

X0050
Remove the upper case of a new print head.
Remove four caps from the new print head.
Upper case
Cap
Print head g/
RN
X0068
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(7) Remove each tube from the print head to be replaced with a new one, then attach each of the new caps which are

removed from a new print head to each tube, while exercising care to prevent any ink from being spilled.

<IMPORTANT>

o Care is needed in preventing any ink from being spilled from each tube. If the ink is dripping, wipe off the dripping ink.

. Be careful not to confuse it with the tube for the print head on the color side.

. Be sure not to tighten the nut for part (a) by mistake. It could remove the tube and leak the contained ink.

. When you replace the print head, be sure to move the carriage manually to the position of the platen at the center of the
printer before starting the replacement. If you perform the mounting of the head when the carriage is directly above the
maintenance unit, it may damage the maintenance unit or the heads.

<NOTE>

. For a proper work operation, be sure to wear the printer-provided gloves.

( Capéﬂ Tube
EH-»(E—
EH-»>(E—
EH-»(E—
Tube

X0134
(8) Remove the resin cover which is placed on the top of the carriage board carriage board.
(9) Open the hold-down clip for cable, and remove the flat cable.
Flat cable
r Resin cover
<
Hold-down clip for cable
X0135

293



Troubleshooting

(10) Unlock the print head, and remove the print head.

<IMPORTANT>
. When removing the print head, be careful not to drip the ink on the carriage plate. If the ink is dripping, wipe off the dripping
ink.
( 2\
Lock
Print head
\ J

X0072

(11) Release the lock by pulling (a) part toward yourself, and take out the new print head from its case.
<IMPORTANT>
3 When removing the print head, be careful not to touch the nozzle surface at the bottom of the head. Otherwise it may cause
poor printing.
<TIPS>
° Sometimes, you may find it hard to remove the print head when you try to open the lock of (a) part. If it is hard, use both
hands to remove it.

Print head

(a) part

X0069
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(12) By following the procedures mentioned below, mount a new print head on the carriage.

@ Insert the rearward end of print head into the carriage.

(@ Push with force in direction 2) so that the illustrated part (a) makes contact with the side of the metal plate of the print head.

(® Lock the print head in place.

<IMPORTANT>

. Make sure the illustrated (a) part is in contact with the side of the metal plate.

. When re-installing the print head with ink refilled, care must be taken not to mistake white for color.

. When placing the print head in position, be careful not to move the carriage as much as possible. Your hand may be caught
in the carriage and injured. In addition, the tubes may be rolled together possibly damaging them.

. When you mount 3), push it down from the top. Otherwise, you may get your finger caught in it and get injured.

<TIPS>

3 If the print head is not inserted sufficiently, the part as illustrated in (b) could come into contact with its bottom surface, which
in turn may result in poor printing. Please insert the print head as far as it can go.

( N\

Print head

R <.

Carriage

X0073

Print head

X0129
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(13) Connect the flat cable to the carriage board.

Flat cable
%

X0136

(14) Make the wiring arrangement of flat cable as shown here, and secure it in place with the hold-down clip for the
cable.

(15) Place the resin cover back onto the carriage board, and engage the two latches properly.

Hold-down clip for cable
Resin cover

X0137

(16) Remove every cap from each tube, and connect them to the print head.
<IMPORTANT>
. To prevent the tubes from being entangled with each other, connect the innermost tube to the print head first, and make the
connection of the rest of the tubes.

3 Be sure to connect each tube with its correct position.
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(17) Tighten the nut firmly until it stops so that each tube is fixed to the print head.
<IMPORTANT>
. Be sure not to tighten the nut for part (a) by mistake.

e N Tube h
M4~ owr{E= 4 *Remove the ink clot.
3 O+(E= 3 Nut
Y2 o+{E= 2 u
Bk1 O+{E= 1
| )

Print head
\ J /

X0282

(18) Close the front cover, turn on the power.
(19) From the menu, select [Maintenance] > [Install Ink after Replacing Head] > [White], and press @ .

Perform the work operation by following the on-screen instructions.

<TIPS>

. When the white ink pouch runs low on its remaining volume of white ink, the Install Ink after Replacing Head function can
no longer get started. Furthermore, there may be cases where the pouch needs to be replaced with a new one during the
installation process of white ink. If the remaining volume is 400 g (14.1 oz) or less, prepare a new white ink pouch, follow
the instructions on the screen to replace the pouch, and activate the mode again.

(20) On the operation panel, press @ .

Then, the white ink will be installed after the head is replaced with a new one.

<TIPS>
. After the procedures are completed, the current screen will go back to the standby mode screen.

(21) Adjust the carriage speed.
<TIPS>
3 For details, refer to "7-4-1. CR (Carriage) speed adjustment >>P.212".

(22) Perform the initial settings after head replacement configuration.
<TIPS>
3 Please refer to "7-4-2. Initial settings after head replacement >>P.213".

(23) Adjust the ejection timing of the print head.
<TIPS>
. For details, refer to "7-4-3. Firing adjustment >>P.214".

(24) Perform the platen feed adjustment.
<TIPS>
3 Refer to "7-4-4. Platen feed adjustment >>P.215".

(25) Make the position adjustment between the white head and the color head.
<TIPS>
. For details, refer to "7-4-5. White/color alignment >>P.216".
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9-2-7. Replacing the Wiper

™
(2

@)

(4)
(5)

Have the supplied gloves and wiper ready.

From the menu, select [Maintenance] > [Maintenance Part Clean/Replace], and press @ .

<IMPORTANT>

. If any other error or message is displayed on the operation panel or warning message window, follow the message to solve
the problem, then perform the cleaning.

<TIPS>

. Pressing @ causes the platen to start moving. Do not put anything around the platen.

Follow the on-screen message and turn off the power.

<IMPORTANT>

. Please complete the task within 15 minutes, in order to prevent the print heads from drying up.

. If the task takes more than 15 minutes to complete, after attaching the flushing receiver, wiper cleaner, and wiper, close the
front cover and turn on the power, and then select [Maintenance Part Clean/Replace] again to restart the task. Then, the
head cleaning will be performed to prevent any ink from drying up.

Open the front cover.

Raise the wiper cleaner and move it to its upright position, and remove it by moving it upward.
<IMPORTANT>

. Removed wiper cleaner should be placed with the cleaner side facing up.

<NOTE>

3 For a proper work operation, be sure to wear the printer-provided gloves.

Wiper cleaner Front cover

r _

X0055
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(6) Remove the flushing receiver from the maintenance unit.

<IMPORTANT>

Troubleshooting >

. Ink droplets will drop off from the hole on the bottom of flushing receiver. Press a waste cloth against the bottom surface,

and lift the flushing receiver vertically to remove it.

Flushing receiver

X
SaSxv
<~

Waste cloth

N\

(7) Remove the spring under the wiper from the maintenance unit latch.

Latch

299

Front cover

r _

X0277

Spring

X0149



(8) Remove the wiper from the maintenance unit.
<IMPORTANT>
. There are two protruded parts underneath. Thoroughly remove the wiper not to damage these parts.

Protrusion Protrusion
J

X0150

X0151
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(10) Place the spring under the wiper on the maintenance unit latch.

Wiper

Spring

Latch
X0152
(11) Insert a wiper cleaner into the printer from above, tip it leftward and put it in place.

<TIPS>
. During this process, it is recommended to also replace the wiper cleaner with a new one.
. First, insert the shaft from above. Then fold it to the left, press the area with the PUSH indication until a clicking sound is

heard, and get the latch into position.

( N\

Latch

Wiper cleaner

\ J
X0056
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(12) Mount the flushing receiver back to its original place in the maintenance unit.
<TIPS>
3 Direct its orientation with a hole on the bottom to the front.

(13) Close the front cover.

(14) Turn on the power.
<NOTE>
. Dispose of any waste resulting from the replacement in accordance with applicable laws and ordinances.
<TIPS>
. Then, the head cleaning will be performed to prevent any ink from drying up.
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9-2-8. Re-install the ink

Ink should be re-installed when an entrance of air into the print head prevents proper ink-jet operation and remedial
measure cannot improve the condition.

(1) While the printer is in standby mode, press @ on the operation panel to bring the menu screen into view.
(2) Press A / V¥, select [Maintenance] > [Initial Ink Installation], and press @ .

(3) Press A /¥ toselectone of the options; [All Colors], [All Whites], [All Print Heads], [Black], [Yellow Cyan
Magenta], [White-1], or [White-2-4], and press @ .

Initial Ink Installation
All Colors

All Whites

All Print Heads

Black

Yel low Cyan Magenta

(4) According to the message displayed on the operation panel, press @ .

Initial ink installation will be operated.

<TIPS>

. Estimated time to complete the process is; 15 minutes for [White-1] and [White-2-4], and 10 minutes for [Black] and [Yellow
Cyan Magenta). After the procedures are completed, the current screen will go back to the standby mode screen.
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9-3. Error message

What is shown below is the error message list of the GTX-4 printer. Any error message is displayed on the liquid crystal

panel.

Please try to solve any error according to the resolution strategy.

Error code Error message Description Remedy
The printer is currently under
) pr 'S el yu With reference to "Environmental requirements” of
high-temperature and . .
L i "10-1. Apparatus >>P.331", adjust the surrounding
. low-humidity environment, o ,
[Temperature & Humidity ) . temperature and humidity of the printer so that
— , thereby prolonging the time L
Warning] , , both of the temperature and humidity may be
required for automatic o ) i
) , within the print warranty coverage with room left for
maintenance operation after
) L the coverage.
completion of printing.
, , . , With reference to "6-2-2. Confirmation and
[Cleaning Solution Low - | The remaining cleaning , , ,
1000 . , replenishment of cleaning solution >>P.111",
Add More] solution is running low. , ) )
replenish the cleaning solution.
With reference to "6-2-2. Confirmation and
[Cleaning Solution Out- | The cleaning solution has ) ) )
1001 replenishment of cleaning solution >>P.111",
Add More] been depleted. ) ) .
replenish the cleaning solution.
It is the warning about Please wait until the temperature decreases.
[Color Head Getting . 9 . . . P
1030 Warm] temperature increase in the | If the problem still persists, please contact your
color heads. dealer.
It is the warning about Please wait until the temperature decreases.
1031 | [W Head Temp Rising] temperature increase in the | If the problem still persists, please contact your
white heads. dealer.
The ambient temperature
decreases below the scope | With reference to "10-1. Apparatus >>P.331",
1060 | [Temp Low] SIOW pe | pparai
covered by its warranty for increase the room temperature.
the best print result.
The ambient temperature
rises above the scope With reference to "10-1. Apparatus >>P.331",
1061 | [Temp High] ! Ve P ' ppara
covered by its warranty for decrease the room temperature.
the best print result.
The humidity decreases
below the scope covered b With reference to "10-1. Apparatus >>P.331",
1064 | [Humidity too Low] _ P ) L PR
its warranty for the best print | increase the room's humidity.
result.
The humidity level is higher
than the scope covered by its | With reference to "10-1. Apparatus >>P.331",
1065 | [Humidity too High] P o L Aep
warranty for the best print decrease the room's humidity.
result.
Make note of their error code and error message,
1070 |[Battery To Be Replaced] |Battery needs to be replaced. ) I_ g
and please notify it to your dealer.
The built-in clock has not Make note of their error code and error message,
1080 |[RTC Not Adjusted] ui o 9
been set up. and please notify it to your dealer.
The built-in clock has not Make note of their error code and error message,
1085 |[RTC Not Adjusted] ui e 9
been set up. and please notify it to your dealer.
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, With reference to "7-1-2. Cleaning the nozzle
i ) Cap and wiper need to be . .
1090 |[Cap/Wiper Cleaning] cleaned guard, wiper, exhaust cap, and suction cap
' >>P.166", clean the cap and wiper.
. With reference to "7-1-2. Cleaning the nozzle
. . Cap and wiper need to be . .
1091 |[Cap/Wiper Cleaning] guard, wiper, exhaust cap, and suction cap
cleaned. R ,
>>P.166", clean the cap and wiper.
i .| The wiper cleaner on the With reference to "7-1-3. Replacing the wiper
iper Cleaner Replacin
1092 V[\C/hie] P g white side needs to be cleaner >>P.178", replace the old wiper cleaner
replaced with a new one. with a new one.
i , The wiper cleaner on the With reference to "7-1-3. Replacing the wiper
er Cleaner Replacin
1093 \l)lvvflie] pacing white side needs to be cleaner >>P.178", replace the old wiper cleaner
replaced with a new one. with a new one.
i .| The wiper cleaner on the With reference to "7-1-3. Replacing the wiper
iper Cleaner Replacin
1095 gzl)l‘())r] P g color side needs to be cleaner >>P.178", replace the old wiper cleaner
replaced with a new one. with a new one.
i , The wiper cleaner on the With reference to "7-1-3. Replacing the wiper
er Cleaner Replacin
1096 Cﬂ)/ZIIZr] pacing color side needs to be cleaner >>P.178", replace the old wiper cleaner
replaced with a new one. with a new one.
1100 [Pump Tube To Be Pump tube needs to be Make note of the error code and error message,
Replaced] replaced. and please notify it to your dealer.
Because the white head
) cleaning is performed, the With reference to "9-2-2. White head cleaning
Install White Ink After
1125 [Cleanin ] I Install White Ink After >>P.257", conduct the Install White Ink After
g Cleaning function needs to be | Cleaning.
put into execution.
With reference to "6-2-3. Daily agitation of the
hite ink >>P.112", stir the white ink.
1oop |[REMOVe the White Ink | The white ink needs to be whten sirihewhiein
Cartridge and shake it] stirred. Pressing @ after the stirring causes the White
Ink Refilling function to be put into execution.
The exhaust fan is not Make note of the error code and error message,
1210 |[Exhaust Fan Stop] ) xhad ! . g
working. and please notify it to your dealer.
1501 [Fan Filter To Be The fan filter needs to be With reference to "7-1-6. Replacing the fan filter
Replaced] replaced with a new one. >>P.190", replace the fan filter with a new one.
. The flushing foam on the With reference to "7-1-4. Replacing the flushing
[Flushing Foam L : .
1601 . . white side needs to be foam >>P.180", replace the flushing foam with a
Replacing White] ,
replaced with a new one. new one.
) The flushing foam on the With reference to "7-1-4. Replacing the flushing
[Flushing Foam o " i ;
1602 . , white side needs to be foam >>P.180", replace the flushing foam with a
Replacing White] )
replaced with a new one. new one.
, The flushing foam on the With reference to "7-1-4. Replacing the flushing
[Flushing Foam ) . .
1605 . color side needs to be foam >>P.180", replace the flushing foam with a
Replacing Color] ,
replaced with a new one. new one.
, The flushing foam on the With reference to "7-1-4. Replacing the flushing
[Flushing Foam ) " i ;
1606 , color side needs to be foam >>P.180", replace the flushing foam with a
Replacing Color] ,
replaced with a new one. new one.
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With reference to "7-1-2. Cleaning the nozzle
[Nozzle Guard Cleaning | The nozzle guard needs to be ! , ng , i
1700 . guard, wiper, exhaust cap, and suction cap
Timing] cleaned.
>>P.166", clean the nozzle guard.
With reference to "7-1-2. Cleaning the nozzle
[Nozzle Guard Cleaning | The nozzle guard needs to be : g )
1701 Timing] cleaned guard, wiper, exhaust cap, and suction cap
9 ' >>P.166", clean the nozzle guard.
Because the white head
[None after head change replacement is made, the With reference to "9-2-6. Replacement of print
1801 W] g Install Ink after Replacing head >>P.272", conduct the Install Ink after
Head function needs to be Replacing Head for the white head.
put into execution.
Because the color head
replacement is made, the With reference to "9-2-6. Replacement of print
[None after head change , R
1802 (KYCM)] Install Ink after Replacing head >>P.272", conduct the Install Ink after
Head function needs to be Replacing Head for the color head.
put into execution.
With reference to "9-2-8. Re-install the ink
[Perform Initial Ink The ink installation has not e ,
1901 ) >>P.303", perform the initial ink installation
Installation] been performed yet. ,
operation.
An operation to temporarily | "7-3-1. Disabling white ink >>P.205" or "7-3-2.
1905 |[Exit Disable White Ink] stop the use of white ink is Reusing White Ink >>P.208" should be performed
stopped in the middle. to its end.
2000 [[Cartridge Not Set Black] | No black ink cartridge exists. |Place the black ink cartridge in position.
Cartridge Not Set No magenta ink cartridge
2001 : g , g ! d Place the magenta ink cartridge in position.
Magenta] exists.
2002 |[Cartridge Not Set Cyan] |No cyan ink cartridge exists. | Place the cyan ink cartridge in position.
2003 [[Cartridge Not Set Yellow] | No yellow ink cartridge exists. | Place the yellow ink cartridge in position.
Cartridge Not Set No white 12 ink cartrid
2004 : a. riage ot >e 9W fie 12 ink cartriage Place the white ink cartridge in position.
White-12] exists.
[Cartridge Not Set No white 34 ink cartridge L , , ..
2005 Place the white ink cartridge in position.
White-34] exists. geinp
2020 |[[No Ink Black] The black ink pouch is empty. | Replace the old black ink pouch with a new one.
2021 |[No Ink Magenta] The magenta ink pouch is Replace the old magenta ink pouch with a new
empty. one.
2022 |[No Ink Cyan] The cyan ink pouch is empty. | Replace the old cyan ink pouch with a new one.
The yellow ink pouch is
2023 |[No Ink Yellow] empt’; P Replace the old yellow ink pouch with a new one.
The white 12 ink hi
2024 | [No Ink White-12] emit"; e 12 INKPOUCN IS | R eplace the old white ink pouch with a new one.
The white 34 ink hi
2025 |[No Ink White-34] emi:’; e S INKPOUENS | Replace the old white ink pouch with a new one.
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Put a proper ink pouch in its correct position.
Put an identifiable ink pouch in position inside the
The black ink pouch cannot ] P P
2030 |[Ink Pouch Error Black] ) ] printer.
be identified properly. ) i
If the problem still persists, please contact your
dealer.
Put a proper ink pouch in its correct position.
Put an identifiable ink hi ition inside th
2031 [Ink Pouch Error The magenta ink pouch :ijntzr: aentiiable ink potich in posifion Inside the
Magenta] cannot be identified properly. P ' ) i
If the problem still persists, please contact your
dealer.
Put a proper ink pouch in its correct position.
) Put an identifiable ink pouch in position inside the
The cyan ink pouch cannot ,
2032 |[Ink Pouch Error Cyan] , ) printer.
be identified properly. ) i
If the problem still persists, please contact your
dealer.
Put a proper ink pouch in its correct position.
Put an identifiable ink pouch in position inside the
The yellow ink pouch cannot u ! " i pouch In postlion Ins!
2033 |[Ink Pouch Error Yellow] . ) printer.
be identified properly. ) i
If the problem still persists, please contact your
dealer.
Put a proper ink pouch in its correct position.
Put an identifiable ink pouch in position inside the
so4 | (nk Pouch Error White | The white 12 ink pouch rli’nter centifiable Ink potch In postion Insi
12] cannot be identified properly. P ' _ _
If the problem still persists, please contact your
dealer.
Put a proper ink pouch in its correct position.
Put an identifiable ink hi ition inside th
sozs | Ik Pouch Error White | The white 34 ink pouch ;ntzrr] centiable ik polich In postion inside fe
34] cannot be identified properly. P ' ) .
If the problem still persists, please contact your
dealer.
It is the read-out trouble of an | Make note of their error code and error message,
2036 |[Machine Error] ) ! uiirou ) ) I_ g
ink pouch on the color side. | and please notify it to your dealer.
It is the read-out trouble of an | Make note of their error code and error message,
2037 |[Machine Error] . o - 9
ink pouch on the white side. | and please notify it to your dealer.
[No Wiper Cleaner There is no wiper cleaner on . . . )
2041 Place a wiper cleaner in position on the color side.
(CMYK)] the color side. Wi N Postl !
No Wiper Cleaner There is no wiper cleaner on
2042 ! , P . P Place a wiper cleaner in position on the white side.
(White)] the white side.
The ambient temperature
decreases below the With reference to "10-1. Apparatus >>P.331",
2050 | [Temp Low] ! W o ppara
operation assurance range increase the room temperature.
for the best print result.
The ambient temperature
rises above the operation With reference to "10-1. Apparatus >>P.331",
2051 |[Temp High] P PP
assurance range for the best | decrease the room temperature.
print result.
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The obstacle sensor has Remove such obstacle from the platen, flatten its
2070 |[Obstacl the Plat detected bstacl
[Obstacle on the Platen] electe some.o S ac.e on surface, and press @ to clear the error.
the platen or print medium.
Take out the white 12 cartridge, open the cover,
and have the ink pouch winded properly. Close the
[White 12 Check The | The white 12 ink pouch may Ve i ink polich winded properly
2084 ) . cover, set the ink pouch back to the printer, and
Cartridge] not be winded properly.
press @ to clear the error.
Take out the white 34 cartridge, open the cover,
and have the ink pouch winded properly. Close the
[White 34 Check The | The white 34 ink pouch may ve The Ink potich winced properly
2085 , , cover, set the ink pouch back to the printer, and
Cartridge] not be winded properly.
press @ to clear the error.
An error has been detected in
2090 |[Ink Pouch Error Black] , ! In that case, replace with a new ink pouch set.
the black ink pouch.
Ink Pouch E A has been detected i
2091 [ink Pouch Error n erornas .een eleciedin In that case, replace with a new ink pouch set.
Magenta] the magenta ink pouch.
An error has been detected in
2092 |[Ink Pouch Error Cyan] ) ! In that case, replace with a new ink pouch set.
the cyan ink pouch.
An error has been detected in
2093 |[Ink Pouch Error Yellow] ) ! In that case, replace with a new ink pouch set.
the yellow ink pouch.
Ink Pouch Error White An error has been detected in
2094 ! . ! ] , ! In that case, replace with a new ink pouch set.
12] the white 12 ink pouch.
Ink Pouch Error White An error has been detected in
2095 ! . ! ] , ! In that case, replace with a new ink pouch set.
34] the white 34 ink pouch.
Insert a USB flash memory into the slot, wait for a
couple of seconds, and perform the operation.
Insert a USB flash memory into the slot again.
[USB flash drive Not No USB flash memory been , , V! ga
2100 . o ; If the problem still persists, check on the format
Ready] inserted into its insertion slot.
and type of the USB flash memory.
For details, refer to "9-1. Troubleshooting
instructions >>P.242".
At the writing stage to the Use your PC to check free space on the USB flash
USB flash memory thereis | memory.
2101 Not Enough Area
[ g ] not enough free space to Insert the USB flash memory that has enough free
store the data. space into the insertion slot.
Connect the USB flash memory to your PC for
checking the information stored in it.
! No valid file exists ina USB | If the ARX4 file has been saved to it, check its
2105 |[No Files] )
flash memory. content by means of the file viewer.
For details, refer to "9-1. Troubleshooting
instructions >>P.242".
After the power is turned on, it
Receiving History W/O
2110 EE:SSI]Vmg story is found that there is no print | Press @ to clear the error.
data received.
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Because the Print Data Auto
Press to clear the error.
2120 [Print Data Auto Delete Delete Enable function ®
Enable] remains active, no receiving | When you use the receiving history, disable the
history is available. Auto Job Delete option.
Because the White Ink Pause | Press to clear the error.
[White Ink Pause Mode... , , ®
2130 Mode remains active, no L
Non-performable] white ink can be installed When you use the white ink, do not make the
' White Ink Pause Mode active.
Although an ink pouch is
Maintenance Pouch Set | needed, a maintenance , ,
2200 Mai ! , ! , Set an ink pouch to the black cartridge.
Black] solution pouch is set to the
black cartridge.
Although an ink pouch is
Maintenance Pouch Set | needed, a maintenance , )
2201 : , , Set an ink pouch to the magenta cartridge.
Magenta] solution pouch is set to the
magenta cartridge.
Although an ink pouch is
Maintenance Pouch Set |needed, a maintenance ) i
2202 ! , , Set an ink pouch to the cyan cartridge.
Cyan] solution pouch is set to the
cyan cartridge.
Although an ink pouch is
Maintenance Pouch Set | needed, a maintenance , .
2203 : ) ) Set an ink pouch to the yellow cartridge.
Yellow] solution pouch is set to the
yellow cartridge.
Although an ink pouch is
Maintenance Pouch Set |needed, a maintenance , ) ,
2204 [ , ) ) Set the ink pouch to the white 12 cartridge.
White12] solution pouch is set to the
white 12 cartridge.
Although an ink pouch is
Maintenance Pouch Set | needed, a maintenance , ) ,
2205 : ,I ! , ! , Set the ink pouch to the white 34 cartridge.
White34] solution pouch is set to the
white 34 cartridge.
Although a maintenance
solution pouch is needed, an | Set the maintenance solution pouch to the white
2214 | [Ink Pouch Set White12] |0 0" PoUch! _ mal tfion pou wh!
ink pouch is set to the white | 12 cartridge.
12 cartridge.
Although a maintenance
solution pouch is needed, an | Set the maintenance solution pouch to the white
2215 | [Ink Pouch Set White34] |0 0" PoUch ! _ mal tfion pou wh!
ink pouch is set to the white | 34 cartridge.
34 cartridge.
Make sure that your PC is connected to the printer,
and resend the print data. If you have trouble in
sending the data, restart your PC and the printer.
[PC Communication Data reception from PC has i g i you .p I
3000 This error will also occur "when the cable is
Error] suspended. . .
removed during data reception" or "when the
ongoing operation is canceled on the PC during
data reception”.
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Make sure that your PC is connected to the printer,
and start operating the PC tool over from the
beginning. If you have trouble in sending the data,
3001 [PC Communication Data transmission to PC has |restart your PC and the printer.
Error] suspended. This error may also occur "when the cable is
removed during data transmission" or "when the
PC tool is caused to stop running on the PC during
data transmission".
, Make sure that your PC is connected to the printer,
The GT has received an
3002 |[PC Data Error] and resend the print data. If you have trouble in
unsupported data. ) .
sending the data, restart your PC and the printer.
The version of printer driver
Update the firmware of the PC's printer driver as
3003 |[PC Data Error] disagrees with the firmware's P ) P ,
) well as firmware of the printer to the latest version.
version.
Ascertain whether the updated data of firmware
you try to send is correct or not.
) L Make sure that your PC is connected to the printer,
Itis the communication error and start communication between your PC and the
3004 |[PC Data Error] between your PC and the i i .y i
rinter printer once again. If the problem is still not
P ' remedied, restart your PC and the printer.
If the problem still persists, please contact your
dealer.
Make sure that your PC is connected to the printer,
) L and start communication between your PC and the
Itis the communication error rinter once again. If the problem is still not
3005 |[PC Data Error] between your PC and the P , gamn. P i
rinter remedied, restart your PC and the printer.
P ' If the problem still persists, please contact your
dealer.
Make sure that your PC is connected to the printer,
, L and start communication between your PC and the
Itis the communication error rinter once again. If the problem is still not
3010 |[PC Data Error] between your PC and the P , gain. P i
rinter remedied, restart your PC and the printer.
P ' If the problem still persists, please contact your
dealer.
Make sure that your PC is connected to the printer,
, L and start communication between your PC and the
Itis the communication error rinter once again. If the problem is still not
3013 |[PC Data Error] between your PC and the P , gamn. P i
rinter remedied, restart your PC and the printer.
P ) If the problem still persists, please contact your
dealer.
Make sure that your PC is connected to the printer,
, L and start communication between your PC and the
Itis the communication error rinter once again. If the problem is still not
3014 |[PC Data Error] between your PC and the P , gamn. P i
rinter remedied, restart your PC and the printer.
P ' If the problem still persists, please contact your
dealer.
) Too many print data has been ) )
Can no longer receive Number of the print data should be up to 99 durin
3015 || g sent from the PC during the _ P P g
data] i ) any print operation.
print operation.
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Such print data that uses the On fthe setting sc.reen of printer driver, verify that
) o the ink selection is set to [Color Ink Only].
3100 [PC_ Data Error (with wh|te ink v.vas_sent o th_e While the white ink pause mode remains active,
White)] printer which is placed in the , , . .
white ink pause mode. any print data |r.1 which the white ink is included
cannot be received.
Check on the ARX4 file by means of "GTX-4 File
In the print data, some Viewer".
3400 |[PC Data Error] command in incorrect Create the print data once again.
command length is included. | If the problem still persists, please contact your
dealer.
Check on the ARX4 file by means of "GTX-4 File
In the print data, some Viewer".
3401 | [PC Data Error] undefined command is Create the print data once again.
included. If the problem still persists, please contact your
dealer.
Check on the ARX4 file by means of "GTX-4 File
It is the sequence error in the Viewer". i )
3402 |[PC Data Error] orint data. Create the print data once again.
If the problem still persists, please contact your
dealer.
- The print data for blank page
is received from PC.
- When performing the
printing, you have selected a
totally white image pattern Check on the ARX4 file by means of "GTX-4 File
portion as a printing range in | Viewer".
3407 |[Blank Data] your software application, and | For example, please confirm the print range and
sent it to the printer. paper size for your software application through
- You have created a larger | the Print Preview function, etc. of Photoshop.
image than the specified
paper size, and tried to print
out a part of it in the printer,
among others.
3408 | [PC Data Error (too large)] The print data capacity is too | Make note of tlf.leir. error code and error message,
large. and please notify it to your dealer.
Check on the ARX4 file by means of "GTX-4 File
Viewer".
) L Make sure that your PC is connected to the printer,
It is the communication error L
3410 | [PC Data Error] between your PC and the an.d start commtfnlcatlon between your PC and the
orinter. printer once again. .
Restart your PC and the printer.
If the problem still persists, please contact your
dealer.
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3411

[PC Data Error]

It is the communication error
between your PC and the
printer.

Check on the ARX4 file by means of "GTX-4 File
Viewer".

Make sure that your PC is connected to the printer,
and start communication between your PC and the
printer once again.

Restart your PC and the printer.

If the problem still persists, please contact your
dealer.

3412

[PC Data Error]

It is the communication error
between your PC and the
printer.

Check on the ARX4 file by means of "GTX-4 File
Viewer".

Make sure that your PC is connected to the printer,
and start communication between your PC and the
printer once again.

Restart your PC and the printer.

If the problem still persists, please contact your
dealer.

4100

[USB flash drive Access

Error]

No file can be opened.

Check on the content of USB flash memory.

Insert a USB flash memory into the slot again, and
perform the required operation once more.

If the problem is still not remedied, restart the
printer and try to operate it once again.

For details, refer to "9-1. Troubleshooting
instructions >>P.242".

4101

[USB flash drive Access

Error]

No file can be created.

Check on the content of USB flash memory.

Insert a USB flash memory into the slot again, and
perform the required operation once more.

If the problem is still not remedied, restart the
printer and try to operate it once again.

For details, refer to "9-1. Troubleshooting
instructions >>P.242".

4103

[USB flash drive Access

Error]

File search has ended up in
failure.

Check on the content of USB flash memory.

Insert a USB flash memory into the slot again, and
perform the required operation once more.

If the problem is still not remedied, restart the
printer and try to operate it once again.

For details, refer to "9-1. Troubleshooting
instructions >>P.242".

4104

[USB flash drive Access

Error]

The system has failed to read
the file.

Check on the content of USB flash memory.

Insert a USB flash memory into the slot again, and
perform the required operation once more.

If the problem is still not remedied, restart the
printer and try to operate it once again.

For details, refer to "9-1. Troubleshooting
instructions >>P.242".
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4105

[USB flash drive Access
Error]

The system has failed to write
the file.

Check on the content of USB flash memory.

Insert a USB flash memory into the slot again, and
perform the required operation once more.

If the problem is still not remedied, restart the
printer and try to operate it once again.

For details, refer to "9-1. Troubleshooting
instructions >>P.242".

4106

[llegal Format]

There is something wrong
with the file's data.

Check on the content of USB flash memory.

Insert a USB flash memory into the slot again, and
perform the required operation once more.

If the problem is still not remedied, restart the
printer and try to operate it once again.

For details, refer to "9-1. Troubleshooting
instructions >>P.242".

4108

[USB flash drive Access
Error]

The system has failed to
obtain the file size.

Check on the content of USB flash memory.

Insert a USB flash memory into the slot again, and
perform the required operation once more.

If the problem is still not remedied, restart the
printer and try to operate it once again.

For details, refer to "9-1. Troubleshooting
instructions >>P.242".

4200

[Machine Error]

Abnormal indication is found
in the language data on the
LCD screen.

In the event that this error is displayed after
suspending the updating of firmware, please start
the updating operation over from the beginning.

If the problem still persists, please contact your
dealer.

4201

[Machine Error]

Abnormal indication is found
in the language data on the
LCD screen.

In the event that this error is displayed after
suspending the updating of firmware, please start
the updating operation over from the beginning.

If the problem still persists, please contact your
dealer.

4202

[Machine Error]

Abnormal indication is found
in the language data on the
LCD screen.

In the event that this error is displayed after
suspending the updating of firmware, please start
the updating operation over from the beginning.

If the problem still persists, please contact your
dealer.

4400

[Test print data Error]

An error is detected in the
print data for test print menu.

In the event that this error is displayed after
suspending the updating of firmware, please start
the updating operation over from the beginning.

If the problem still persists, please contact your
dealer.

4401

[Test print data Error]

An error is detected in the
print data for test print menu.

In the event that this error is displayed after
suspending the updating of firmware, please start
the updating operation over from the beginning.

If the problem still persists, please contact your
dealer.
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In the event that this error is displayed after
suspending the updating of firmware, please start
, An error is detected in the P .g P , 9 P o
4402 |[Test print data Error] ) ) the updating operation over from the beginning.
print data for test print menu. , ,
If the problem still persists, please contact your
dealer.
Press @ to clear the error.
The network interface was Contact your network setup manager and network
4500 |[Machine Error] , . Y P 9
unable to be activated. administrator.
If the problem still persists, please contact your
dealer.
An error has been detected in | Press @ to clear the error.
4501 |[IP Address Setting Error] |the static IP address setting , i
Use the maintenance tool to set up a correct static
and subnet mask value. )
IP address and subnet mask value once again.
Press @ to clear the error.
The network interface setting | Contact your network setup manager and network
4502 | [Machine Error] e 9 - Y P J
has ended up in failure. administrator.
If the problem still persists, please contact your
dealer.
An error was found in the Press @ to clear the error.
4503 | [Machine Error] static IP address of the , ,
Use the maintenance tool to set up a correct static
default gateway. ,
IP address of default gateway once again.
, ) Press ® to clear the error.
, It is the error of static IP
4504 | [IP Address Setting Error] , ,
address setup value. Use the maintenance tool to set up a correct static
IP address and subnet mask value once again.
No data can be restored
) Make note of the error code and error message,
4506 |[No Enable Restore Data] | because its backup copy was e
and please notify it to your dealer.
not made.
Atimeout has occurred at the | Make note of the error code and error message,
5001 |[Machine Error] . e e I 9
time of initialization. and please notify it to your dealer.
) ) Press @ to clear the error.
5010 |[PC Data Error] An error is detected in the
current print data being run. | Create the print data again on the PC to load it to
the printer, and try the print operation again.
The carriage movement was | If the problem still persists even after restarting the
5020 |[Machine Error] g , P P g
not completed. printer, please contact your dealer.
If the problem still persists even after restarting the
5021 |[Machine Error] Head operation is incomplete. | P P g
printer, please contact your dealer.
If the problem still persists even after restarting the
5022 |[Machine Error] Head operation is incomplete. | P P g
printer, please contact your dealer.
Maintenance unit operation is | If the problem still persists even after restarting the
5080 |[Machine Error] , P , P P g
incomplete. printer, please contact your dealer.
Maintenance unit operation is | If the problem still persists even after restarting the
5081 |[Machine Error] , P , P P g
incomplete. printer, please contact your dealer.
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The platen cannot be moved | Make note of the error code and error message,
5094 |[Machine Error] P . = 9
toward the rear of the printer. |and please notify it to your dealer.
The platen cannot be moved | Make note of the error code and error message,
5095 |[Machine Error] P . e 9
toward the front of the printer. | and please notify it to your dealer.
Make note of the error code and error message,
5096 |[Machine Error] The platen cannot be rolled. o g
and please notify it to your dealer.
, L Check to see if there is any source near the printer
It is the communication error that produces a loud noise
5200 |[Machine Error] between the main board and P ) S )
i ) If the problem still persists even after restarting the
the maintenance unit. )
printer, please contact your dealer.
, o Check to see if there is any source near the printer
It is the communication error that produces a loud noise
5201 |[Machine Error] between the main board and P . o .
i ) If the problem still persists even after restarting the
the maintenance unit. )
printer, please contact your dealer.
) L Check to see if there is any source near the printer
It is the communication error that produces a loud noise
5230 |[Machine Error] between the main board and P ) o i
i ) If the problem still persists even after restarting the
the maintenance unit. .
printer, please contact your dealer.
, L Check to see if there is any source near the printer
It is the communication error that produces a loud noise
5231 |[Machine Error] between the main board and P ) o i
i ) If the problem still persists even after restarting the
the maintenance unit. ,
printer, please contact your dealer.
, L Check to see if there is any source near the printer
It is the communication error that produces a loud noise
5232 |[Machine Error] between the main board and P ) o i
i ) If the problem still persists even after restarting the
the maintenance unit. ,
printer, please contact your dealer.
, L Check to see if there is any source near the printer
It is the communication error that produces a loud noise
5233 |[Machine Error] between the main board and P ) o .
. ) If the problem still persists even after restarting the
the maintenance unit. ,
printer, please contact your dealer.
, L Check to see if there is any source near the printer
It is the communication error that produces a loud noise
5240 |[Machine Error] between the main board and P } o .
i ) If the problem still persists even after restarting the
the maintenance unit. )
printer, please contact your dealer.
, o Check to see if there is any source near the printer
It is the communication error that produces a loud noise
5241 |[Machine Error] between the main board and P . o .
i ) If the problem still persists even after restarting the
the maintenance unit. )
printer, please contact your dealer.
As it is likely that the firmware's file is corrupted,
The program data of the , Y L. P
, .. | obtain a proper file of the firmware which is not
, firmware of maintenance unit,
5250 |[Machine Error] ) corrupted.
which you try to update, has . . :
) If the problem still persists even after restarting the
been found to be defective. ,
printer and your PC, please contact your dealer.
In the event that this error is displayed after
Aversion of the firmware of | suspending the updating of firmware, please start
5260 |[Machine Error] maintenance unit is the updating operation over from the beginning.
incompatible. If the problem still persists, please contact your
dealer.
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It is the communication error | Check to see if there is any source near the printer
between the main board and | that produces a loud noise.

5301 |[Machine Error] . ) P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and | that produces a loud noise.

5302 |[Machine Error] . ) P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and |that produces a loud noise.

5303 |[Machine Error] . ) P . . :
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and | that produces a loud noise.

5304 |[Machine Error] . . P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and |that produces a loud noise.

5305 |[Machine Error] . ) P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and | that produces a loud noise.

5306 |[Machine Error] i ) P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and | that produces a loud noise.

5307 |[Machine Error] . ) P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and | that produces a loud noise.

5311 |[Machine Error] . ) P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and |that produces a loud noise.

5312 |[Machine Error] . ) P . . :
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and | that produces a loud noise.

5313 |[Machine Error] . ) P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the main board and | that produces a loud noise.

5314 |[Machine Error] . ) P . . .
the maintenance unit (on the | If the problem still persists even after restarting the
color side). printer, please contact your dealer.
The cam of the maintenance If the problem still persists even after restarting the

5320 |[Machine Error] unit (on the color side) ) P P g

, printer, please contact your dealer.

malfunctions.
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The cam of the maintenance If the problem still persists even after restarting the
5321 | [Machine Error] unit (on the color side) ,
) printer, please contact your dealer.
malfunctions.
5322 | [Machine Error] I:E (T;Th‘: ::ZTOT;:SM”CE If ’fhe problem still persists even after restarting the
. printer, please contact your dealer.
malfunctions.
The cam of the maintenance If the problem still persists even after restarting the
5323 |[Machine Error] unit (on the color side) ,
) printer, please contact your dealer.
malfunctions.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5330 |[Machine Error] unit (on the color side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5331 [[Machine Error] unit (on the color side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5332 |[Machine Error] unit (on the color side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5333 |[Machine Error] unit (on the color side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5340 |[Machine Error] unit (on the color side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5341 | [Machine Error] unit (on the color side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5342 |[Machine Error] unit (on the color side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
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Error code Error message Description Remedy
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper

5343 |[Machine Error] unit (on the color side) cleaner.

malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.

It is an internal error of the Check to see if there is any source near the printer

maintenance unit (on the that produces a loud noise.

5350 |[Machine Error] color side), which is Restart the printer and update the firmware again.
associated with updating of | If the problem still persists, please contact your
firmware. dealer.

It is an internal error of the Check to see if there is any source near the printer
maintenance unit (on the that produces a loud noise.

5351 |[Machine Error] color side), which is Restart the printer and update the firmware again.
associated with updating of | If the problem still persists, please contact your
firmware. dealer.

It is an internal error of the Check to see if there is any source near the printer
maintenance unit (on the that produces a loud noise.

5352 | [Machine Error] color side), which is Restart the printer and update the firmware again.
associated with updating of | If the problem still persists, please contact your
firmware. dealer.

It is an internal error of the Check to see if there is any source near the printer
maintenance unit (on the that produces a loud noise.

5353 |[Machine Error] color side), which is Restart the printer and update the firmware again.
associated with updating of | If the problem still persists, please contact your
firmware. dealer.

It is the communication error , , ,
) Check to see if there is any source near the printer
between the main board and )
the maintenance unit (on the that produces a loud noise.
5354 | [Machine Error] color side), which is Restart the printer and update the firmware again.
o ) If the problem still persists, please contact your
associated with the updating
dealer.
of firmware.
It is the communication error , , ,
) Check to see if there is any source near the printer
between the main board and ,
the maintenance unit (on the that produces a loud noise.
5355 |[Machine Error] color side), which is Restart the printer and update the firmware again.
0 . If the problem still persists, please contact your
associated with the updating
dealer.
of firmware.
It is the communication error , . .
) Check to see if there is any source near the printer
between the main board and ,
the maintenance unit (on the that produces a loud noise.
5356 |[Machine Error] color side), which is Restart the printer and update the firmware again.
o ) If the problem still persists, please contact your
associated with the updating
dealer.
of firmware.
It is the communication error , , ,
) Check to see if there is any source near the printer
between the main board and )
the maintenance unit (on the that produces a loud noise.
5357 |[Machine Error] color side), which is Restart the printer and update the firmware again.
o . If the problem still persists, please contact your
associated with the updating
dealer.
of firmware.
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Itis an internal error of the

maintenance unit (on the Restart the printer and update the firmware again.
5358 |[Machine Error] color side), which is If the problem still persists, please contact your

associated with updating of | dealer.

firmware.

It is an internal error of the

maintenance unit (on the Restart the printer and update the firmware again.
5359 |[Machine Error] color side), which is If the problem still persists, please contact your

associated with updating of | dealer.

firmware.

When the solenoid is in

operation, there is a Restart the printer and update the firmware again.
5361 |[Machine Error] mismatch between the main | If the problem still persists, please contact your

board and the maintenance |dealer.

unit (on the color side).

It is the internal error of the Restart the printer and update the firmware again.
5391 |[Machine Error] maintenance unit (on the If the problem still persists, please contact your

color side). dealer.

It is the communication error | Check to see if there is any source near the printer
5401 | [Machine Error] betwee.n the main b9ard and |that produces a !oud n?ise. '

the maintenance unit (on the | If the problem still persists even after restarting the

white side). printer, please contact your dealer.

It is the communication error | Check to see if there is any source near the printer
5402 | [Machine Error] betwee.n the main b?ard and |that produces a !oud n?ise. .

the maintenance unit (on the | If the problem still persists even after restarting the

white side). printer, please contact your dealer.

It is the communication error | Check to see if there is any source near the printer
5403 | [Machine Error] betwee.n the main b?ard and |that produces a !oud nc.)lse. -

the maintenance unit (on the | If the problem still persists even after restarting the

white side). printer, please contact your dealer.

It is the communication error | Check to see if there is any source near the printer
5404 |[Machine Error] betwee.n the main b9ard and |that produces a !oud n?ise. -

the maintenance unit (on the | If the problem still persists even after restarting the

white side). printer, please contact your dealer.

It is the communication error | Check to see if there is any source near the printer
5405 |[Machine Error] betwee.n the main b9ard and |that produces a Foud n?ise. -

the maintenance unit (on the | If the problem still persists even after restarting the

white side). printer, please contact your dealer.

It is the communication error | Check to see if there is any source near the printer
5406 | [Machine Error] betwee.n the main b?ard and |that produces a Foud n?ise. '

the maintenance unit (on the | If the problem still persists even after restarting the

white side). printer, please contact your dealer.

It is the communication error | Check to see if there is any source near the printer
5407 | Machine Error] betwee.n the main b9ard and |that produces a !oud n?ise. '

the maintenance unit (on the | If the problem still persists even after restarting the

white side). printer, please contact your dealer.
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It is the communication error | Check to see if there is any source near the printer
5411 | [Machine Error] betwee.n the main bt.)ard and |that produces a !oud n?ise. .
the maintenance unit (on the | If the problem still persists even after restarting the
white side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
5412 | Machine Error] betwee.n the main b?ard and |that produces a !oud n?ise. .
the maintenance unit (on the | If the problem still persists even after restarting the
white side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
5413 |[Machine Error] betwee.n the main b9ard and |that produces a !oud n?ise. -
the maintenance unit (on the | If the problem still persists even after restarting the
white side). printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
5414 |[Machine Error] betwee.n the main b?ard and |that produces a !oud n?ise. .
the maintenance unit (on the | If the problem still persists even after restarting the
white side). printer, please contact your dealer.
The cam of the maintenance If the problem still persists even after restarting the
5420 |[Machine Error] unit (on the white side) ,
) printer, please contact your dealer.
malfunctions.
The cam of the maintenance If the problem still persists even after restarting the
5421 | [Machine Error] unit (on the white side) ,
) printer, please contact your dealer.
malfunctions.
The cam of the maintenance If the problem still persists even after restarting the
5422 |[Machine Error] unit (on the white side) ,
, printer, please contact your dealer.
malfunctions.
The cam of the maintenance If the problem still persists even after restarting the
5423 | [Machine Error] unit (on the white side) ,
) printer, please contact your dealer.
malfunctions.
Check to see if the wiper cleaner is properly
The wiper cleaner of the installed and there is no obstacle around the wiper
5430 |[Machine Error] maintenance unit (on the or wiper cleaner.
white side) malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper cleaner is properly
The wiper cleaner of the installed and there is no obstacle around the wiper
5431 |[Machine Error] maintenance unit (on the or wiper cleaner.
white side) malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper cleaner is properly
The wiper cleaner of the installed and there is no obstacle around the wiper
5432 |[Machine Error] maintenance unit (on the or wiper cleaner.
white side) malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper cleaner is properly
The wiper cleaner of the installed and there is no obstacle around the wiper
5433 |[Machine Error] maintenance unit (on the or wiper cleaner.
white side) malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
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Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5440 |[Machine Error] unit (on the white side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5441 | [Machine Error] unit (on the white side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper
5442 |[Machine Error] unit (on the white side) cleaner.
malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the wiper is properly installed and
The wiper of the maintenance | there is no obstacle around the wiper or wiper

5443 |[Machine Error] unit (on the white side) cleaner.

malfunctions. If the problem still persists even after restarting the
printer, please contact your dealer.

It is an internal error of the Check to see if there is any source near the printer

maintenance unit (on the that produces a loud noise.

5450 |[Machine Error] white side), which is Restart the printer and update the firmware again.
associated with updating of | If the problem still persists, please contact your
firmware. dealer.

It is an internal error of the Check to see if there is any source near the printer
maintenance unit (on the that produces a loud noise.

5451 |[Machine Error] white side), which is Restart the printer and update the firmware again.
associated with updating of | If the problem still persists, please contact your
firmware. dealer.

It is an internal error of the Check to see if there is any source near the printer
maintenance unit (on the that produces a loud noise.

5452 | [Machine Error] white side), which is Restart the printer and update the firmware again.
associated with updating of | If the problem still persists, please contact your
firmware. dealer.

It is an internal error of the Check to see if there is any source near the printer
maintenance unit (on the that produces a loud noise.

5453 |[Machine Error] white side), which is Restart the printer and update the firmware again.
associated with updating of | If the problem still persists, please contact your
firmware. dealer.

It is the communication error , , ,
) Check to see if there is any source near the printer
between the main board and ,
the maintenance unit (on the that produces a loud noise.
5454 | [Machine Error] white side), which is Restart the printer and update the firmware again.

) o . If the problem still persists, please contact your

associated with the updating
dealer.

of firmware.
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It is the communication error , , ,
) Check to see if there is any source near the printer
between the main board and )
the maintenance unit (on the that produces a loud noise.
5455 | [Machine Error] white side), which is Restart the printer and update the firmware again.
) T ) If the problem still persists, please contact your
associated with the updating
dealer.
of firmware.
It is the communication error ) , ,
) Check to see if there is any source near the printer
between the main board and ,
i , that produces a loud noise.
. the maintenance unit (on the . .
5456 |[Machine Error] white side), which is Restart the printer and update the firmware again.
) T . If the problem still persists, please contact your
associated with the updating
dealer.
of firmware.
It is the communication error , . .
) Check to see if there is any source near the printer
between the main board and )
the maintenance unit (on the that produces a loud noise.
5457 |[Machine Error] white side), which is Restart the printer and update the firmware again.
) T ) If the problem still persists, please contact your
associated with the updating
dealer.
of firmware.
It is an internal error of the
maintenance unit (on the Restart the printer and update the firmware again.
5458 |[Machine Error] white side), which is If the problem still persists, please contact your
associated with updating of | dealer.
firmware.
Itis an internal error of the
maintenance unit (on the Restart the printer and update the firmware again.
5459 | [Machine Error] white side), which is If the problem still persists, please contact your
associated with updating of | dealer.
firmware.
When the solenoid is in
operation, there is a , ,
9 Restart the printer and update the firmware again.
5461 |[Machine Error] mismatch between the state If the problem still persists, please contact your
of the main board and that of P P P y
. . dealer.
the maintenance unit (on the
white side).
It is the communication error | Check to see if there is any source near the printer
between the maintenance that produces a loud noise.
5471 | [Machine Error] ) o P . . :
unit (on the white side) and If the problem still persists even after restarting the
the cartridge sensor. printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the maintenance that produces a loud noise.
5472 | [Machine Error] ) o P . . :
unit (on the white side) and If the problem still persists even after restarting the
the cartridge sensor. printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the maintenance that produces a loud noise.
5473 | [Machine Error
[ ] unit (on the white side) and If the problem still persists even after restarting the
the cartridge sensor. printer, please contact your dealer.
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It is the communication error | Check to see if there is any source near the printer
between the maintenance that produces a loud noise.
5474 | [Machine Error] ) o P . . .
unit (on the white side) and | If the problem still persists even after restarting the
the cartridge sensor. printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the maintenance that produces a loud noise.
5475 | [Machine Error] | oI prociices @ bie o |
unit (on the white side) and If the problem still persists even after restarting the
the cartridge sensor. printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the maintenance that produces a loud noise.
5476 |[Machine Error] , ainie produices & foud not .
unit (on the white side) and If the problem still persists even after restarting the
the cartridge sensor. printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the maintenance that produces a loud noise.
5477 Machine Error
[ ] unit (on the white side) and If the problem still persists even after restarting the
the cartridge sensor. printer, please contact your dealer.
It is the communication error | Check to see if there is any source near the printer
between the maintenance that produces a loud noise.
5478 |[Machine Error
[ ] unit (on the white side) and If the problem still persists even after restarting the
the cartridge sensor. printer, please contact your dealer.
) , Check to see if there is any source near the printer
It is the internal error of the that produces a loud noise
5491 |[Machine Error] maintenance unit (on the P , o .
white side) If the problem still persists even after restarting the
' printer, please contact your dealer.
The sub tank of black ink is
5501 |[Machine Error] not filled with black ink. Check the ink pouch (black) for any abnormalities.
The sub tank of magenta ink | Check the ink pouch (magenta) for an
5502 | [Machine Error] _he subtank of magenta | > ink pouch (magenta) for any
is not filled with magenta ink. | abnormalities.
The sub tank of cyan ink is
5503 |[Machine Error] ) y. Check the ink pouch (cyan) for any abnormalities.
not filled with cyan ink.
The sub tank of yellow ink is | Check the ink pouch (yellow) for an
5504 | [Machine Error] b aniof yellow Ink > ink pouch (yellow) for any
not filled with yellow ink. abnormalities.
Ink pouch was identified with If the problem still persists even after restarting the
5600 |[Machine Error] abnormal timing at the time of | P P g
e s printer, please contact your dealer.
initialization.
Check if the ink pouch is seated on the ink
cartridge correctly.
An abnormality was detected Ens;rg that the ir}:k cartridge is correctly placed on
5601 |[Machine Error] when tried to check the ink ) g yp
ouch the printer.
P ’ If the problem still persists even after restarting the
printer, please contact your dealer.
Check if the ink pouch is seated on the ink
cartridge correctly.
An abnormality was detected Ensurg that the i:k cartridge is correctly placed on
5602 |[Machine Error] when tried to check the ink ) g yp
ouch the printer.
P ’ If the problem still persists even after restarting the
printer, please contact your dealer.
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Check if the ink pouch is seated on the ink
cartridge correctly.
An abnormality was detected Ensurg that the ir}:k cartridge is correctly placed on
5603 |[Machine Error] when tried to check the ink . 9 yPp
ouch the printer.
P ’ If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if there is any source near the printer
) L that produces a loud noise.
It is the communication error iy , ,
, If a USB flash memory is inserted into the printer,
, between the main board and
5801 |[Machine Error] remove the memory first, and then restart the
the panel board or the head ,
board printer.
’ If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if there is any source near the printer
) L that produces a loud noise.
It is the communication error i , ,
) If a USB flash memory is inserted into the printer,
, between the main board and
5802 |[Machine Error] remove the memory first, and then restart the
the panel board or the head ,
board printer.
’ If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if there is any source near the printer
) L that produces a loud noise.
It is the communication error . . .
) If a USB flash memory is inserted into the printer,
, between the main board and
5803 |[Machine Error] remove the memory first, and then restart the
the panel board or the head ,
board printer.
’ If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if there is any source near the printer
) L that produces a loud noise.
It is the communication error . . .
) If a USB flash memory is inserted into the printer,
, between the main board and
5804 |[Machine Error] remove the memory first, and then restart the
the panel board or the head ,
board printer.
’ If the problem still persists even after restarting the
printer, please contact your dealer.
Check to see if the obstacle sensor is covered with
It indicates some error in the | something.
6004 | [Obstacle on the Platen] o _
obstacle sensor. If the problem still persists even after restarting the
printer, please contact your dealer.
The system failed to write the | Make note of their error code and error message,
6010 |[PC Data Error] y ) . g
EEPROM of the main board. |and please notify it to your dealer.
The system failed to erase
Make note of the error code and error message,
6011 |[Machine Error] the FLASH ROM of the main o g
and please notify it to your dealer.
board.
The system failed to write the
Make note of the error code and error message,
6012 |[Machine Error] FLASH ROM of the main . 9
and please notify it to your dealer.
board.
The battery of the real-time | Make note of the error code and error message,
6021 | [No Battery] arery e g
clock is fully exhausted. and please notify it to your dealer.
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Platen button is out of Ascertain whether or not something is placed on
6031 |[Machine Error] working order. the operation panel.
For help, please contact your dealer.
Print button is out of working Ascertain whether or not something is placed on
6032 |[Machine Error] order the operation panel.
For help, please contact your dealer.
Stop button is out of working Ascertain whether or not something is placed on
6033 |[Machine Error] order. the operation panel.
For help, please contact your dealer.
Back button is out of working Ascertain whether or not something is placed on
6034 |[Machine Error] order. the operation panel.
For help, please contact your dealer.
) ) ) Ascertain whether or not something is placed on
6035 |[Machine Error] (F){:gz:.button 's out of working the operation panel.
For help, please contact your dealer.
Down button is out of working Ascertain whether or not something is placed on
6036 |[Machine Error] order. the operation panel.
For help, please contact your dealer.
Up button is out of working Ascertain whether or not something is placed on
6037 | [Machine Error] order. the operation panel.
For help, please contact your dealer.
Head cleaning button is out of Ascertain whether or not something is placed on
6038 |[Machine Error] working order. the operation panel.
For help, please contact your dealer.
, Ascertain whether or not something is placed on
6039 |[Machine Error] xs’:ﬁ;%}: dZL:don 's out of the operation panel.
For help, please contact your dealer.
6101 | [Machine Error] It indicates the carriage's If the problem still persists even after reactivating
malfunction. the printer, please contact your dealer.
Check to see if something gets caught in the
carriage or any foreign object exists inside the
, printer.
6102 |[Machine Error] ;:iﬁ:g:iizizgonés atan With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.
If the problem still persists, please contact your
dealer.
Check to see if something gets caught in the
carriage or any foreign object exists inside the
) printer.
6103 |[Machine Error] ;Z:jp can be locked in With reference to "7-1-5. Cleaning the internal area
' of printer >>P.185", perform the cleaning.
If the problem still persists, please contact your
dealer.
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Troubleshooting >

Error code

Error message

Description

Remedy

6104

[Machine Error]

Carriage does not move.

Check to see if something gets caught in the
carriage or any foreign object exists inside the
printer.

With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.

If the problem still persists, please contact your
dealer.

6105

[Machine Error]

The carriage's home position
return initialization has ended

up in failure.

Check to see if something gets caught in the
carriage or any foreign object exists inside the
printer.

With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.

If the problem still persists, please contact your
dealer.

6106

[Machine Error]

The carriage has bumped
against the frame.

Check to see if something gets caught in the
carriage or any foreign object exists inside the
printer.

With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.

If the problem still persists, please contact your
dealer.

6107

[Machine Error]

The carriage's reverse
rotation has been detected.

Check to see if something gets caught in the
carriage or any foreign object exists inside the
printer.

With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.

If the problem still persists, please contact your
dealer.

6108

[Machine Error]

Abnormal decrease in the
speed of carriage has been
detected.

Check to see if something gets caught in the
carriage or any foreign object exists inside the
printer.

With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.

If the problem still persists, please contact your
dealer.

6109

[Machine Error]

The carriage has stopped
abnormally within the print
range.

Check to see if something gets caught in the
carriage or any foreign object exists inside the
printer.

With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.

If the problem still persists, please contact your
dealer.

6110

[Machine Error]

The carriage cannot move out

of its locked position.

Check to see if something gets caught in the
carriage or any foreign object exists inside the
printer.

With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.

If the problem still persists, please contact your
dealer.
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Troubleshooting >

Error code Error message Description Remedy
Check to see if something gets caught in the
carriage or any foreign object exists inside the
Carriage cannot perform printer.
6111 | [Machine Error] capping. With reference to "7-1-5. Cleaning the internal area
of printer >>P.185", perform the cleaning.
If the problem still persists, please contact your
dealer.
6119 | [Machine Error] The carriage movement does | If ’fhe problem still persists even after restarting the
not come to a full stop. printer, please contact your dealer.
With reference to "7-1-5. Cleaning the internal area
It indicates an abnormal of printer >>P.185", perform the carriage cleaning.
6130 |[Machine Error Adjust CR] | decrease in the speed of With reference to "7-4-1. CR (Carriage) speed
carriage. adjustment >>P.212", perform the carriage speed
adjustment.
With reference to "7-1-5. Cleaning the internal area
It indicates an excessive of printer >>P.185", perform the carriage cleaning.
6131 | [Machine Error Adjust CR] | increase in the speed of With reference to "7-4-1. CR (Carriage) speed
carriage. adjustment >>P.212", perform the carriage speed
adjustment.
With reference to "7-1-5. Cleaning the internal area
The carriage stops at an of printer >>P.185", perform the carriage cleaning.
6132 |[Machine Error Adjust CR] incorrect position, With reference to "7-4-1. CR (Carriage) speed
adjustment >>P.212", perform the carriage speed
adjustment.
Check to see if something gets caught in the
carriage or any foreign object exists inside the
It indicates an error in the printer.
6133 |[Machine Error] carriage speed adjustment With reference to "7-1-5. Cleaning the internal area
(reverse motion). of printer >>P.185", perform the cleaning.
If the problem still persists, please contact your
dealer.
Check to see if something gets caught in the
carriage or any foreign object exists inside the
It indicates an error in the printer.
6134 |[Machine Error] carriage speed adjustment With reference to "7-1-5. Cleaning the internal area
(forward motion). of printer >>P.185", perform the cleaning.
If the problem still persists, please contact your
dealer.
Ascertain whether or not the cable for the heads is
6220 |[Machine Error] The (?olor heads' temperature | disconnected. . . -
level is abnormal. If the problem still persists even after restarting the
printer, please contact your dealer.
Ascertain whether or not the cable for the heads is
6221 |[Machine Error] The v.vhite heads' temperature | disconnected. . . -
level is abnormal. If the problem still persists even after restarting the
printer, please contact your dealer.
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Troubleshooting

>

Error code Error message Description Remedy
Ascertain whether or not the cable for the heads is
It refers to abnormal voltage | disconnected.
6230 |[Machine Error] ) g ) i
in the color heads. If the problem still persists, please contact your
dealer.
Ascertain whether or not the cable for the heads is
It refers to abnormal voltage | disconnected.
6231 | [Machine Error] . ) vorag I . .
in the white heads. If the problem still persists, please contact your
dealer.
Ascertain whether or not the cable for the heads is
It refers to FFC failure in the | disconnected.
6240 | [Machine Error] et ' o _
color heads. If the problem still persists even after restarting the
printer, please contact your dealer.
Ascertain whether or not the cable for the heads is
It refers to FFC failure in the | disconnected.
6241 | [Machine Error] _ et ' . -
white heads. If the problem still persists even after reactivating
the printer, please contact your dealer.
Make note of the error code and error message,
7000 |[Machine Error] It is the system call error. o g
and please notify it to your dealer.
i i If the problem still persists even after restarting the
. Firmware internal error . .
7012 | [Machine Error] occurred printer, please contact your dealer after noting the
' error code and message displayed.
It is the general program Make note of the error code and error message,
7013 | [Machine Error] g Prog v 9
error. and please notify it to your dealer.
Because the ongoing print
operation remains unfinished, | Send any print data to the printer while the printer
7015 | [Machine Error] P . . yP . . P , P
the next print data cannot be |is not performing the printing operation.
printed out.

In the event that other error codes than those that are mentioned above are displayed or that any of the
above-mentioned errors cannot be remedied even by following the troubleshooting procedures, please contact your
dealer for help.
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Troubleshooting

9-4. Acquisition of log file

In cases where the printer malfunctions, you may be required by our service personnel to obtain your printer's log file.
For this reason, please save your printer's log file to a file.
<TIPS>

. To the resultant file, such filename (.log) that automatically identifies your printer will be given.

Fetch a log file from USB flash memory

(1) Insert a USB flash memory into the insertion slot of the printer.

(2) Press @ on the operation panel located on the left side of printer to go to the menu.

(3) Press A /¥, select [Maintenance] > [Log copy to USB], and press @ .

Log copy to USB

Set USB flash drive

Press OK to Start

(4) Then, the print button stops blinking, and the log file writing operation will be completed when you hear the sound of

pong.

<IMPORTANT>

. Never remove the USB flash memory from the printer when the print button is blinking. Otherwise, the USB flash memory
may be damaged, rendering its internal data to be unreadable.

(5) Obtain the log file saved to the USB flash memory, and send such file to our service personnel.
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Troubleshooting

Fetch a log file via USB/LAN connection

(1) On the PC, from [All Programs] in the Start menu, select the "GTX-4 Maintenance" from "Brother GTX-4 Tools".

(2) After the window shown below appears, select the [Log Data Retrieval] and click [Next].

@ Brother GTX-4 Maintenance lﬂ

Confirm the printer is turned OM and connected to your PC.
Select the printer,

Virtual printer hd ] [ Search

Select an item from the menu below and dick "Next".

*) Initial settings after head replacement
Perform this sstting when replacing the head or when sstting up the printer cnhy.

(7 Firing Adjustment
Adjust this setting when the edges of the print look vagus, solid aress are not even, or after 2 Print Head is replaced.

() Platen-roliing adjustment

Mzke adjustments when horizontal stripes (banding) occur in the printed image. Use this adjustment as a
troubleshooting methed when other items such as proper temperature and humidity have already been verified.

~) White/Color Alignment
Adjust when white print does not align with coler print.

() Setan IP Adrress
Assign a static IP address to the printer.

Execute if there was 2 request after troubleshooting service.

") Setting of the time displayed on the nozzle check pattern
This i not necessary if you have configured the scheduled time for white ink circulzstion,

() Set the scheduled time for white ink drculation
Configure this setting to set or cancel the scheduled time for white ink circulation,

(3) Perform the required operation by following the on-screen instructions in the dialog box.
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10-1. Apparatus

External dimensions | 55.1 in. (width) x 51.2 in. (depth) x 21.7 in. (height) (1400 mm (width) x 1300 mm (depth) x 550

mm (height))
Basic machine 120 kg (264 Ib)
weight (including
platen)

Max. printable area | 16.0in. x 21.0in. (406.4 mm x 533.4 mm)

Printing resolution 1200 dpi x 1200 dpi

Power Single-phase 100 to 240 V
Power supply 50/60 Hz
frequency
Power 0.8 A (Actual value) (Reference: 0.3 A when circulating)
Consumptions
Operation assurance range: Temperature: 10 to 35°C (50 to 95°F)
(Environmental range where the printer can | Humidity: 20 to 85% (No condensation should
be operated.) occur.)
Printing-guaranteed range: Temperature: 18 to 30°C (64.4 to 86°F)
(Environmental range where sufficient Humidity: 35 to 85% (No condensation should
printing quality can be secured.) occur.)
Temperature: 0 to 40°C (32 to 104°F)
Keeping your printer: Humidity: 20 to 85% (No condensation should
occur.)

B Printing-guaranteed range
B Operating your printer

Keeping your printer

Humidity (%)
Environmental 85 =
requirements 80 =

70 =

I i I I I I Temperature (°C)
10 15 1820 25 2930 35 40

(50 59 68 77 86 95 104 (°F))
X0210
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10-2. Software

Windows 7 (32 bit/64 bit), Windows 8.1 (32 bit/64 bit), Windows 10 (32 bit/64
Compatible OS bit) and macOS 10.13 High Sierra, macOS 10.14 Mojave "', macOS 10.15
Catalina

USB 2.0, LAN (10 BASE-T and 100 BASE-TX), USB flash memory (Please
use a FAT32-formatted USB memory of which storage capacity is 2 GB to 32

Interface GB in total, and a USB memory without security functions such as password
lock function).

Min. operating environment CPU Wl_th 2 GHz or above
RAM with 4 GB or above

Display resolution XGA (1024 x 768) or higher

Recommended application software | CoreIDRAW X7/X8, Adobe Photoshop CS6/CC,

for high-level image editing Adobe lllustrator CS6/CC, and Adobe Photoshop Elements 14/15

. In the case of macOS 10.14 Mojave, the result of printing may differ from the user’s expectation if any Apple printing
application is used. If there is a printing problem, use one of the following applications: Adobe lllustrator CC, Adobe
Photoshop CC, or Adobe Photoshop Elements.
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10-3. Ink, maintenance solution, cleaning solution, pretreatment

10-3-1. Ink

Name Black / Magenta / Cyan / Yellow ink pouch

Use expiration date Expiration date on the pouch pack (supposing storage at normal temperature)

Storage temperature 0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.

Cautions for storage - Keep them out of the reach of children.
- Store them away from fire, heat and oxidized substance.
Content 350 ml, 500 ml, 700 ml
External 1-piece set 20.3 in. (width) x 5.2 in. (depth) x 1.8 in. (height) (518 mm (width) x 133 mm
dimensions in (depth) x 48 mm (height)) (common to 350 ml, 500 ml and 700 ml)
transport 12-piece set 21.1 in. (width) x 11.4 in. (depth) x 14.8 in. (height) (538 mm (width) x 290 mm
condition (depth) x 378 mm (height)) (common to 350 ml, 500 ml and 700 ml)
Name White ink pouch

Use expiration date

Expiration date on the pouch pack (supposing storage at normal temperature)

Storage temperature

0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.

Cautions for storage - Keep them out of the reach of children.

- Store them away from fire, heat and oxidized substance.
Content 500 ml, 700 ml
External 2-piece set 20.3 in. (width) x 5.2 in. (depth) x 3.4 in. (height) (518 mm (width) x 133 mm
dimensions in (depth) x 87 mm (height))
transport 12-piece set 21.1in. (width) x 11.4 in. (depth) x 11.6 in. (height) (538 mm (width) x 290 mm
condition (depth) x295 mm (height))

10-3-2. Maintenance solution

Name

Maintenance solution pouch

Use expiration date

Expiration date on the pouch pack (supposing storage at normal temperature)

Storage temperature

0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.

Cautions for storage - Keep them out of the reach of children.

- Store them away from fire, heat and oxidized substance.
Content 700 mi
External 1-piece set 20.3 in. (width) x 5.2 in. (depth) x 1.8 in. (height) (518 mm (width) x 133 mm
dimensions in (depth) x 48 mm (height))
transport 12-piece set 21.1in. (width) x 11.4 in. (depth) x 14.8 in. (height) (538 mm (width) x 290 mm
condition (depth) x 378 mm (height))
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10-3-3. Cleaning solution

Name

Cleaning solution

Use expiration date

Expiration date on the container (supposing storage at normal temperature)

Storage temperature

0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
- Keep them out of the reach of children.

Cautions for storage - Store them away from fire, heat and oxidized substance.

- Cap the container tightly, and keep it in a cool, dark place with good ventilation.
Content 1.9kg (4.21b)
External
dimensions in 6-piece set 18.9 in. (width) x 13.3 in. (depth) x 13.5 in. (height) (480 mm (width) x 340 mm
transport (depth) x 345 mm (height))
condition

10-3-4. Pretreatment

Name

Pretreatment

Use expiration date

Expiration date on the outer case (supposing storage at normal temperature)

Storage temperature

0 to 40°C (32 to 104°F)

- Store them in a place where they are not exposed to direct sunlight.
- Keep them out of the reach of children.

Cauttions for storage - Store them away from fire, heat and oxidized substance.

- Cap the container tightly, and keep it in a cool, dark place with good ventilation.
Content 20 kg (44 Ib), 5 kg (11 Ib)
External 1-piece set 10.4 in. (width) x 14.3 in. (depth) x 15.7 in. (height) (265 mm (width) x 365 mm
dimensions in (depth) x 400 mm (height)), (20 kg (44 Ib))
transport 4-piece set 17.9in. (width) x 12.6 in. (depth) x 12.5 in. (height) (456 mm (width) x 320 mm
condition (depth) x 318 mm (height)), (5 kg (11 b))
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10-4. About consumable supplies, optional items and replacement parts

About consumable supplies, optional items and replacement parts

e  Consumable supplies: Components required for the printing operation

e  Optional items: Available items through purchase order according to customers' usage status

e Replacement parts: Components for which periodic maintenance needs to be performed for you to optimize the

printer's operation

Consumable supplies Code No. Optional items Code No.
Black ink pouch 350 ml | GCX-4K35-1 Over size platen X SB6992
500 ml | GCX-4K50-1 (16"x21" / 406 x 533mm)
700 ml | GCX-4K70-1 Platen sheet 16X21 SB7242
Magenta ink pouch 350 ml | GCX-4M35-1 Large platen X SB6994
500 ml | GCX-4M50-1 (16"x18" / 406 x 457mm)
700 ml | GCX-4M70-1 Platen sheet 16X18 SB6995
Cyan ink pouch 350 ml | GCX-4C35-1 Adult platen X SB6996
500 ml | GCX-4C50-1 (14"x16" / 356 x 406mm)
700 ml | GCX-4C70-1 Platen sheet 14X16 SB6667
Yellow ink pouch 350 ml | GCX-4Y35-1 Youth platen X SB699S
500 ml | GCX-4Y50-1 (10"x12" / 254 x 305mm)
700 ml | GCX-4Y70-1 Platen sheet 10X12 SB6999
White ink pouch 500 ml | GCX-4W50 Baby platen X SB7001
700 ml | GCX-4W70 (7"x8" / 178 x 203mm)
Cleaning solution 1.9kg(4.21b) | GCX-4E02 Platen sheet 7X8 SB7002
Pretreatment 5kg (111b) | GCX-4P05 Pretreatment roller SB1290
20kg (44 1b) | GCX-4P20 Bottle ASSY (waste ink tank) SB2582
Maintenance solution 200ml | GCX4ST70 Capping pouch SB5696
pouch Replacement parts Code No.
Full maintenance kit Print head SC0764
<Printer-supplied items> Filter SB7093
Clean st?ck R 16 pcs. SB7004 Wiper SB7870
Clean stick T 16 pcs. Grease SB3229
Flushing foam 2 pcs. Cartridge (for white ink) SB5495
Fan filter 4 pcs. Cartridge C (for colored ink) SB6875
Wiper cleaner 2-piece set SB6673 Cleaning cup SB6925
Flushing foam 2-piece set SB7006 Tweezers 117466100
Fan filter 2-piece set SB7007
Clean stick R 50-piece set SB7008
Clean stick T 50-piece set SC0032
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*Please note that the contents of this manual may differ slightly from the actual product purchased as a result of product
improvements.
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